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Section

1

Installation
This section includes the following chapters which describe the procedures used
to install Veritas Storage Foundation for Windows 5.1 and Veritas Storage
Foundation High Availability for Windows 5.1:
■

Chapter 1, “SFW and SFW HA preinstallation and planning” on page 13

■

Chapter 2, “Installing SFW or SFW HA” on page 35

12 Installation

Chapter

SFW and SFW HA
preinstallation and
planning
This chapter contains:
■

Prerequisites

■

Requirements

■

Licensing

■

SFW and SFW HA license packages

■

SFW Basic

■

Using the Configuration Checker

■

Planning an SFW HA installation

■

Planning an SFW installation with a Microsoft cluster

■

Planning a VVR installation

Prerequisites
Please review the following prerequisites.
■

Review the release notes for your products.

■

Review the requirements.
See “Requirements” on page 14.

■

Exit all running applications.
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Requirements
Review these product installation requirements for your systems before
installation. Minimum requirements and Symantec recommended requirements
may vary.
For the latest information on requirements for this release, see the following
Symantec Technical Support TechNote:
http://entsupport.symantec.com/docs/303042

Disk space requirements
For normal operation, all installations require an additional 50 MB of disk space.
Table 1-1 summarizes approximate disk space requirements for SFW and SFW
HA.
Table 1-1

Disk space requirements

Installation options

Install directory or drive
32-bit/64-bit

SFW + all options
+ client components

1200 MB/1500 MB

SFW + all options

940 MB/1240

Client components

360 MB/380 MB

SFW HA + all options
+ client components

1770 MB/2160 MB

SFW HA + all options

1390 MB/2020 MB

Client components

530 MB/560 MB

Operating system requirements
SFW and SFW HA have client and server components that run on specific
Windows operating systems.

SFW and SFW HA software for servers
Your server must run one of the following operating systems to install the SFW
or SFW HA server software:
■

Windows Server 2003 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition (SP2 required for all editions)

SFW and SFW HA preinstallation and planning
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■

Windows Server 2003 R2 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition (SP2 required for all editions)

■

Windows Server 2003 (32-bit): Web Edition: fully supports SFW and
supports only file share for SFW HA (SP2 required for all editions)

■

Windows Server 2003 for 64-bit Itanium (IA64): Enterprise Edition or
Datacenter Edition (SP2 required for all editions)

■

Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard
x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required
for all editions)

■

Windows Server 2003 x64 R2 Editions (for AMD64 or Intel EM64T):
Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2
Edition (SP2 required for all editions)

■

Windows Server 2008 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition

■

Windows Server 2008 for 64-bit Itanium (IA64): Server Edition

■

Windows Server 2008 x64 Editions (for AMD64 or Intel EM64T): Standard
x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition

SFW and SFW HA software for clients
Your client must run one of the following operating systems to install the SFW
or SFW HA client software:
■

Windows Server 2003 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition (SP2 required for all editions)

■

Windows Server 2003 R2 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition (SP2 required for all editions)

■

Windows Server 2003 for 64-bit Itanium (IA64): Enterprise Edition or
Datacenter Edition (SP2 required for all editions)

■

Windows Server 2003 for Intel Xeon (EM64T) or AMD Opteron: Standard
x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition (SP2 required
for all editions)

■

Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T): Standard
x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64 R2 Edition
(SP2 required for all editions)

■

Windows Server 2008 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition

■

Windows Server 2008 for 64-bit Itanium (IA64): Server Edition
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■

Windows Server 2008 x64 Editions (for AMD64 or Intel EM64T): Standard
x64 Edition, Enterprise x64 Edition, or Datacenter x64 Edition

■

Windows XP Professional (SP2 or higher required)

■

Windows Vista (32-bit) (SP1 supported): Business, Enterprise, and Ultimate
editions

■

Windows Vista (64-bit) (SP1 supported): Business, Enterprise, and Ultimate
editions

General requirements
Before you install the SFW or SFW HA software, verify that your configuration
meets the following criteria and that you have reviewed the SFW 5.1 Hardware
Compatibility List to confirm supported hardware:
http://www.symantec.com/business/support/index.jsp

Memory
1 GB of RAM required

System processor
Processor requirements are as follows:
32-bit
■

800-megahertz (MHz) Pentium III-compatible or faster processor

■

1GHz or faster processor recommended

x64
■

1GHz AMD Opteron, AMD Athlon 64, Intel Xeon with Intel EM64T support,
Intel Pentium IV with EM64T support processor or faster

IA64
■

1GHz Itanium or faster processor

■

1GHz Dual-Core Intel Itanium 2 or faster processor

Display
Display requirements are as follows:
■

Minimum resolution: 1024 x 768 pixels or higher

SFW and SFW HA preinstallation and planning
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■

VCS Cluster Manager (Java and Web Console) requires an 8-bit (256 colors)
display and a graphics card that can render 2D images

Storage device compatibility
If you are not using Veritas Dynamic Multi-pathing or clustering (SFW HA or
Microsoft clustering), SFW supports any device in the Microsoft Windows
Server Catalog.
For Veritas Dynamic Multi-pathing and clustering configurations, refer to the
Hardware Compatibility List to determine the approved hardware for SFW:
http://www.symantec.com/business/support/index.jsp
Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3
Persistent Group Reservations (PGR), you must enable SCSI-3 support using the
Veritas Enterprise Administrator (VEA). See the Veritas Storage Foundation
Administrator’s Guide for more information.

Remote systems
You must have network access and appropriate administrative privileges to each
remote computer. SFW HA and SFW with the VVR option do not support DHCP;
they only support static IP addresses.

Veritas Volume Replicator static IP address
VVR requires a static IP for replication. Make sure the system has at least one IP
Address configured that is not assigned by Dynamic Host Configuration
Protocol (DHCP).

Single instance of SFW
Only one instance of Veritas Storage Foundation 5.1 for Windows should be
running on a system.

Driver signing options
When installing on systems running Windows Server 2003, you must set the
Windows driver signing option to ignore software authentication warning
messages.

Veritas Cluster Server Management Console
Veritas Cluster Server Management Console is supported on the following
browsers:
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■

Microsoft Internet Explorer 6.0.x, 7.0, or newer

■

Firefox 1.5 , 2.0, or newer

Veritas Cluster Server Management Console requires the Macromedia Flash
Plugin v8.0 or 9.0.

Firewall and anti-spyware
Disable spyware monitoring and removal software before installing SFW or SFW
HA. Ensure that your firewall settings allow access to ports used by SFW HA
wizards and services. For a detailed list of services and ports used by SFW HA,
refer to the appendix in this guide (Veritas Storage Foundation and High
Availability Solutions for Windows Installation and Upgrade Guide).

Requirements for Veritas Storage Foundation for Windows (SFW)
Supported software requirement
Veritas Storage Foundation 5.1 for Windows (SFW)

System requirements
System requirements for SFW are as follows:
■

SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator
supported NICs to access shared storage

■

1 GB of RAM for each system

Permission requirements
You must be a member of the Local Administrators group for all nodes where
you are installing.

Additional requirements
The following requirements must also be met.
■

Installation media for all products and third-party applications

■

Licenses for all products and third-party applications

SFW and SFW HA preinstallation and planning
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Requirements for Veritas Storage Foundation High Availability for
Windows (SFW HA)
Before you install SFW HA, verify that your configuration meets the following
criteria and that you have reviewed the SFW 5.1 Hardware Compatibility List to
confirm supported hardware:
http://www.symantec.com/business/support/index.jsp

Supported software
This section lists the supported software for Veritas Storage Foundation HA 5.1
for Windows (SFW HA).

System requirements
Systems must meet the following requirements:
■

Memory: minimum 1 GB of RAM per server for SFW HA.

■

Shared disks to support applications that migrate between nodes in the
cluster. Campus clusters require more than one array for mirroring. Disaster
recovery configurations require one array for each site. Replicated data
clusters with no shared storage are also supported.
Note: If your storage devices are SCSI-3 compliant, and you wish to use
SCSI-3 Persistent Group Reservations (PGR), you must enable SCSI-3
support using the Veritas Enterprise Administrator (VEA). See the Veritas
Storage Foundation Administrator’s Guide for more information.

■

SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator
supported NICs to access shared storage.

■

Two NICs: one shared public and private, and one exclusively for the private
network. Symantec recommends three NICs.
See “Best practices” on page 21.

■

All servers must run the same operating system, service pack level, and
system architecture.

Network requirements
This section lists the following network requirements:
■

Install SFW HA on servers in a Windows Server 2003 or Windows Server
2008 domain.

■

Ensure that your firewall settings allow access to ports used by SFW HA
wizards and services. For a detailed list of services and ports used by SFW
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HA, refer to the appendix in this guide (Veritas Storage Foundation and High
Availability Solutions for Windows Installation and Upgrade Guide).
■

Static IP addresses for the following purposes:
■

One static IP address available per site for each application virtual
server.

■

A minimum of one static IP address for each physical node in the
cluster.

■

One static IP address per cluster used when configuring the following
options: Notification, Cluster Management Console (web console), or
Global Cluster Option. The same IP address may be used for all options.

■

For VVR only, a minimum of one static IP address per site for each
application instance running in the cluster.

■

Configure name resolution for each node.

■

Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or
higher are supported.
Make sure a reverse lookup zone exists in the DNS. Refer to the application
documentation for instructions on creating a reverse lookup zone.

■

DNS scavenging affects virtual servers configured in VCS because the
Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP
addresses. If you use scavenging, then you must set the DNSRefreshInterval
attribute for the Lanman agent. This enables the Lanman agent to refresh
the resource records on the DNS servers.
See the Veritas Cluster Server Bundled Agents Reference Guide.

Permission requirements
This section lists the following permission requirements:
■

You must be a domain user.

■

You must be a member of the Local Administrators group for all nodes
where you are installing.

■

You must have write permissions for the Active Directory objects
corresponding to all the nodes.

■

If you plan to create a new user account for the VCS Helper service, you must
have Domain Administrator privileges or belong to the Account Operators
group. If you plan to use an existing user account context for the VCS Helper
service, you must know the password for the user account.

SFW and SFW HA preinstallation and planning
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Additional requirements
Please review the following additional requirements:
■

Installation media for all products and third-party applications

■

Licenses for all products and third-party applications

■

You must install the operating system in the same path on all systems. For
example, if you install Windows Server 2003 on C:\WINDOWS of one node,
installations on all other nodes must be on C:\WINDOWS. Make sure that
the same drive letter is available on all nodes and that the system drive has
adequate space for the installation.

Best practices
Symantec recommends that you perform the following tasks:
■

Verify that you have three network adapters (two NICs exclusively for the
private network and one for the public network).
When using only two NICs, lower the priority of one NIC and use the lowpriority NIC for public and private communication.

■

Route each private NIC through a separate hub or switch to avoid single
points of failure.

■

NIC teaming is not supported for the private network.

■

Verify that you have set the Dynamic Update option for the DNS server to
Secure Only.

Licensing
The SFW and SFW HA licensing is based on the Microsoft Windows Server 2003
or Windows Server 2008operating systems in use on a specific server. For each
system that runs any of the Symantec products, you need a license.
Note: License keys for releases earlier than 4.3 of SFW and SFW HA are not
supported in release 5.1 of SFW and SFW HA.

Evaluation license key
An evaluation license key is embedded in the product. To use this key, click Next
at the license key entry screen of the product installer. This license key is valid
for a limited evaluation period only.
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Storage Foundation for Windows Basic (SFW Basic)
Storage Foundation Basic for Windows (SFW Basic) is a free technology
specifically designed for edge-tier workloads. It is a zero cost SFW license and
includes the Dynamic Multi-pathing option. An SFW Basic license is required for
each physical server and certain limitations apply.
See “SFW Basic” on page 27.

Virtual Server license policy
Each copy of the Veritas Storage Foundation and High Availability Solutions
including all options and agents, whether used on a physical server or within a
virtual machine must be separately licensed. Each Licensed Software license
specifies the number of instances of the Licensed Software you may run on a
particular server at one time.
Table 1-2 lists Storage Foundation for Windows (SFW) editions and the
additional licensing terms that apply:
Table 1-2

SFW licensing terms

Microsoft Operating
System Edition
■

Server Edition

■

Standard Edition

■

Web Edition

■

Advanced Edition

■

Enterprise Edition

SFW licensing terms

Datacenter Edition

A separate license for the licensed software is required
for each virtual or physical server, where the software
is installed.
For each license, you may run one instance of the
licensed software on one physical server and up to
four simultaneous instances of the licensed software
on virtual servers located on the physical server.
For each license, you may run one instance of the
licensed software on one physical server and an
unlimited number of virtual servers located on the
physical server.

Client licensing
You do not need a license if you install the SFW and SFW HA client components.

License management
The product installer allows you to add and remove specific licenses. Adding a
license for an option does not install the option. Use the Add/Remove function
to install an option. License keys support installation on multiple systems.

SFW and SFW HA preinstallation and planning
Requirements

Note: License keys for releases earlier than 4.3 of SFW and SFW HA are not
supported in release 5.1 of SFW and SFW HA. A default evaluation license key is
supplied for your use. This license key is valid for a limited evaluation period
only. You must purchase the product to obtain a permanent license key.

Vxlicrep
Vxlicrep is a command line tool that generates a report of the licenses in use on
your system.
To use Vxlicrep to display a license report:
Open the command prompt.
Enter vxlicrep without any options to generate a default report.
Optionally, use one of the following options to produce the type of report
needed:
-g

default report

-s

short report

-e

enhanced/detailed report

-h

display this help

Below is an output of using vxlicrep with the -e option for a detailed report.
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SFW and SFW HA preinstallation and planning
SFW and SFW HA license packages

SFW and SFW HA license packages
These license packages are available with SFW or SFW HA. Licenses for some
options listed must be purchased separately. Table 1-3 lists the agents and
options available with SFW and SFW HA.
Table 1-3

SFW and SFW HA option and agent packages

Product license

Included options and agents

SFW 5.1

SFW Enterprise 5.1

SFW HA 5.1

Separately available
options and agents
Options:

■

FlashSnap Option.

■

Dynamic Multi-Pathing
Option.

■

Cluster Option for MSCS.

■

Application Agent:
Veritas Cluster Server
Application Agent for
Microsoft Exchange

■

FlashSnap Option

■

Dynamic Multi-Pathing
Option

■

Cluster Option for MSCS

■

Volume Replicator Option

■

Volume Replicator Option

■

FlashSnap Option

■

Dynamic Multi-Pathing
Option

■

Volume Replicator Option

■

Volume Replicator Option

Database Agents:

SFW Enterprise HA
5.1

■

Veritas Cluster Server
Database Agent for
Microsoft SQL

■

Veritas Cluster Server
Database Agent for Oracle

Options:
■

FlashSnap Option

■

Dynamic Multi-Pathing
Option

Agents (See SFW HA 5.1 for the
agent’s full name):
■

Application Agent

■

Database Agents
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Table 1-3

SFW and SFW HA option and agent packages (continued)

Product license

Included options and agents

Separately available
options and agents

SFW HA/DR 5.1

Option:

■

FlashSnap Option

■

Dynamic Multi-Pathing
Option

■

Volume Replicator Option

■

Volume Replicator Option

■

Global Clustering Option

Agents (See SFW HA 5.1 for the
agent’s full name):
■

Application Agent

■

Database Agents

Hardware Replication Agents:
■

Veritas Cluster Server
Hardware Replication Agent
for EMC Symmetrix Remote
Data Facility (SRDF).

■

Veritas Cluster Server
Hardware Replication Agent
for EMC SRDF Star.

■

Veritas Cluster Server
Hardware Replication Agent
for Hitachi TrueCopy.

■

Veritas Cluster Server
Hardware Replication Agent
for EMC Mirrorview.

■

Veritas Cluster Server
Hardware Replication Agent
for IBM Metro Mirror

SFW Enterprise HA/ Option:
DR 5.1
■
Global Clustering Option
■

FlashSnap Option

■

Dynamic Multi-Pathing
Option

Agents (See SFW HA 5.1 for the
agent’s full name):
■

Application Agent

■

Database Agents

■

Hardware Replication
Agents (See SFW HA/DR 5.1
for the agent’s list)
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SFW Basic
This release is also available as SFW Basic. SFW Basic has the same features of
SFW and includes the Veritas Dynamic Multi-pathing (DMP) option. However,
SFW Basic is limited to a maximum of:
■

Four dynamic volumes and/or four file systems which must be located on
the same physical server. The aggregate total of volumes and file systems for
all virtual servers located on one physical server may not exceed four
volumes and/or four file systems.

■

Two physical processors
■

One physical CPU is counted as one processor

■

A processor with “n” cores is counted as one processor

SFW Basic can be upgraded to SFW 5.1 or SFW HA 5.1.
SFW Basic is available with the use of a specific license key.

Using the Configuration Checker
The Configuration Checker wizard is a tool that enables you to verify your
configuration before you install SFW HA or before you perform disaster
recovery in a Microsoft Exchange or SQL Server environment. The wizard can be
accessed by any of the following ways:
■

Symantec Product Installer CD-ROM

■

Solutions Configuration Center

Run the Configuration Checker wizard to:
■

Confirm your configuration before installing Veritas Storage Foundations
and High Availability Solutions software (SFW or SFW HA) to ensure that
the existing configuration(s) meet all pertinent software and hardware
requirements.

■

Confirm your configuration when you have a high availability (HA)
environment, after the SFW HA software has been installed, but before you
configure disaster recovery.

Once the wizard has completed the check, you can save a summary report as an
HTML file in the following location:
<ConfigChecker Installation
directory>\Reports\<TimeStamp>\report.htm
To save a report, click the Save button on the summary page.
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The report contains the number of Passed or Failed checks out of the total
number of checks done on the selected systems, and gives a consolidated report
of every check performed on the systems. Note that you can select multiple
systems when running a pre-install check but can select only one system when
configuring for disaster recovery.

Pre-install check
When running the Configuration Checker wizard before installing SFW HA, the
wizard performs the following checks:
■

Presence of SFW or SFW HA

■

Software and hardware compatibility

■

Operating system versions, service packs, and hotfixes

■

Available disk space

■

Total physical memory

■

Availability of network ports used by Symantec products

■

Active Directory

■

Network configuration

Running the Configuration Checker wizard
1

Launch the Configuration Checker wizard in one of the following ways:
■

In the Product Selection screen of the Symantec Product Installer, click
Run Configuration Checker.

■

From the installation media, select Tools > vpi and double click
LaunchConfigChecker.bat.

■

Launch the Solutions Configuration Center by clicking Start > All
Programs > Symantec > Veritas Cluster Server | Veritas Storage
Foundation > Solutions Configuration Center.

2

Read the information on the Welcome screen and click Next.

3

In the Computer Selection screen, either type in the name or names –
separated by commas – of the nodes that you want to check, or click Browse.
When you click Browse, a list of available nodes appears in a pop-up
window. Select one or more nodes and click OK.

4

Once you select a node, click Add. A description of the node appears on the
right side of the screen, with the computer name, operating system, and a
list of Symantec installed products.

5

Click Next when you are done.
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6

In the Option Selection screen, select either SFW Pre-Install Check or SFW
HA Pre-Install Check. By default, all of the options under the SFW PreInstall Check are selected; however, they are not selected for the SFW HA
Pre-Install Check. When you are done selecting your options, click Next.

7

The Validation screen appears, and the Configuration Checker proceeds with
the check. When status is complete, click Next.

8

The Summary screen lists the completed checks. An option with a green
check means that the check completed successfully. However, an option with
a red X means that the check failed.
For example, if the option Available Disk Space failed, click the option to
select it and the Description pane will specify the reason for the failure.

9

Click Save to save the summary as an HTML file, or click Print to print it.

10 Click Finish to close the wizard. If some or all of the option checks failed, you
can modify your configuration (increase memory or disk space, update
drivers, and so forth) and run the wizard again.

Post-install check
When running the Configuration Checker wizard after installing SFW or SFW
HA, the wizard can perform the following checks:
■

Generic check
Provides a system check for compatible software and hardware, total
physical memory; available memory; OS version; driver signing policy
settings; presence of Active Directory; availability of DNS, Domain
Controller, and Global Category; status of VM volumes; and port
availability.

■

SFW HA check
Checks for drive letter in use; available NIC cards; presence of Active
Directory; consistency of Windows Services across clusters; consistency of
system environment variables across clusters; consistency of license files;
consistency between VCS service groups across clusters; and consistency
between VCS resource types across clusters.

■

Exchange Disaster Recovery Check
When SFW HA is configured in a Microsoft Exchange environment, the
Configuration Checker checks for compatible version of Exchange and
service pack, and for consistency of Exchange Service group across clusters.

■

SQL Server Disaster Recovery Check
When SFW HA is configured in a Microsoft SQL Server environment, the
Configuration Checker checks for compatible version of SQL Server and
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service pack, and for consistency of SQL Server Service group across
clusters.
Running the Configuration Checker wizard
1

Launch the Configuration Checker wizard in one of the following ways:
■

In the Product Selection screen of the Symantec Product Installer, click
Run Configuration Checker.

■

From the installation media, select Tools > vpi and double click
LaunchConfigChecker.bat.

■

Launch the Solutions Configuration Center by clicking Start > All
Programs > Symantec > Veritas Cluster Server | Veritas Storage
Foundation > Solutions Configuration Center.

2

Read the information on the Welcome screen and click Next.

3

In the Computer Selection screen, either type in the name or names –
separated by commas – of the nodes that you want to check, or click Browse.
When you click Browse, a list of available nodes appears in a pop-up
window. Select one or more nodes and click OK.

4

Once you select a node, click Add. A description of the node appears on the
right side of the screen, with the computer name, operating system, and a
list of Symantec installed products.

5

Click Next when you are done.

6

In the Account Information dialog box, type the Username and Password for
the selected computer and click OK.
If you select a node in a secure cluster, log in with your Windows domain
account information. Make sure you type “<domain name>\” before your
username.

7

In the Option Selection screen, select one or more of the checks that you
want to run. When you are done selecting your options, click Next.

8

The Validation screen appears, and the Configuration Checker proceeds with
the check. When status is complete, click Next.

9

The Summary screen lists the completed checks. An option with a green
check means that the check completed successfully. However, an option with
a red X means that the check failed.
For example, if the option Available Memory failed, click the option to select
it and the Description pane will specify the reason for the failure.

10 Click Save to save the summary as an HTML file, or click Print to print it.
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11 Click Finish to close the wizard. If some or all of the option checks failed, you
can modify your configuration (increase memory or disk space, update
drivers, and so forth) and run the wizard again.

Planning an SFW HA installation
During an SFW HA installation, the product installer automatically installs
Veritas Storage Foundation for Windows and Veritas Cluster Server. You may
select other applicable options during the installation. You may also choose to
install simultaneously on more than one system during the installation process.
After the initial installation, run the VCS Configuration Wizard to complete the
VCS cluster configuration. The VCS Configuration Wizard presents the
opportunity to configure optional VCS features including security options,
Cluster Management Console, notification, and the global cluster wide-area
connection resource.
Depending on your environment you may choose to configure the Symantec
Product Authentication Service and the Cluster Management Console on
systems outside the cluster.
Review the following information and decide how you want to configure your
environment:
■

About Symantec Product Authentication Service

■

About Veritas Cluster Server Management Console

■

About notification

■

About global clusters

31

32 SFW and SFW HA preinstallation and planning
Planning an SFW HA installation

About Symantec Product Authentication Service
Symantec Product Authentication Service allows the security administrator to
configure authentication to provide a single sign-on service for Symantec
applications. In this case, users need log-on only once to a single Symantec
application, and other applications can then use the credentials acquired
through the first logon.
Symantec Product Authentication Service provides the ability to configure a
cluster in secure mode. Symantec Product Authentication Service secures
communication between cluster nodes and clients, including the Java console,
by using digital certificates for authentication and SSL to encrypt
communication over the public network.
To configure the cluster in secure mode, SFW HA requires you to specify and
configure a system in your environment as a root broker and all nodes in the
cluster as authentication brokers.
■

Root broker
A root broker serves as the main registration and certification authority; it
has a self-signed certificate and can authenticate other brokers.

■

Authentication brokers
Authentication brokers serve as intermediate registration and certification
authorities. Authentication brokers have certificates that are signed by the
root. Each node in the cluster serves as an authentication broker.

The Symantec Product Authentication Service Quick Start Guide describes the
best practices and options for configuring the root broker in your environment.

About Veritas Cluster Server Management Console
Veritas Cluster Server Management Console is a high availability management
solution that enables monitoring and administering clusters from a single web
console.
You can configure Cluster Management Console to manage a single cluster,
multiple clusters, or both.
■

If you want to use the Cluster Management Console to manage multiple
clusters, you must set up a standalone management server.

■

If you want to use the Cluster Management Console to manage a single
cluster, choose the option to configure the Cluster Management Console,
also known as the Web console from the VCS Configuration Wizard.
Configuring the Cluster Management Console may be done during initial
cluster configuration or at a later time.

For more information, see the Veritas Cluster Server Management Console
Implementation Guide.
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About notification
You can configure SFW HA to send event notification either through SMTP
email notification or SNMP traps.
Configuring the notifier process may be done during initial cluster configuration
or at a later time using the VCS Configuration Wizard.
See the Veritas Cluster Server Administrator’s Guide.

About global clusters
A global cluster consists of two or more local clusters linked together. Global
clusters provide the ability to fail over applications between geographically
distributed clusters when disaster occurs.
Global clusters may be configured either through the Disaster Recovery
Configuration Wizard available from the Solutions Configuration Center or
through the Global Group Configuration Wizard. Both processes require a widearea connector resource for inter-cluster communication. This resource is
configured automatically as part of the Disaster Recovery Configuration Wizard
or may optionally be configured using the VCS Configuration Wizard.
The Disaster Recovery Configuration Wizard is described in the Solutions
Guides.
See the following:
■

Veritas Storage Foundation and High Availability Solutions HA and Disaster
Recovery Solutions Guide for Microsoft Exchange

■

Veritas Storage Foundation and High Availability Solutions HA and Disaster
Recovery Solutions Guide for Microsoft SQL

■

Veritas Storage Foundation and High Availability Solutions, Solutions Guide

The Global Group Configuration Wizard and VCS Configuration Wizard are
described in the Veritas Cluster Server Administrator’s Guide.
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Planning an SFW installation with a Microsoft
cluster
If you plan to set up a Microsoft cluster (MSCS or Microsoft failover cluster) with
SFW, please review the following recommendations:
■

Microsoft clustering should already be configured. This enables SFW to
install Microsoft cluster resources such as Volume Manager disk groups and
various other shared resources.

■

Symantec does not recommend a push installation on systems in a
Microsoft cluster because the Microsoft cluster must be active and running
when installing SFW.

■

Because SFW installation requires a reboot, and the reboot causes the active
node of the cluster to fail over, use a rolling installation.

■

Install SFW on the inactive node or nodes of the cluster first, then use the
Move Group command in Microsoft clustering to move the active node.
Install SFW on the cluster’s remaining node.
See the Veritas Storage Foundation Administrator’s Guide.

Planning a VVR installation
Replication between servers running Windows Server 2003 and Windows Server
2008 is supported in the following environments:
■

Storage Foundation for Windows with the VVR option on standalone servers
(no clustering)

■

Storage Foundation for Windows HA with the VVR and Global Cluster (GCO)
Options

■

Storage Foundation for Windows with the VVR and Microsoft Clustering
options

Chapter
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Installing SFW or SFW HA
This chapter contains:
■

Installing using the product installer

■

Installing from the command line

■

Possible next tasks

■

Updating SFW or SFW HA

■

Adding or removing features

■

Repairing the installation

■

License management

■

Uninstalling using the product installer

■

Uninstalling from the command line

■

Installing and uninstalling Veritas Dynamic Multi-pathing

About installing SFW or SFW HA
This chapter covers the installing Veritas Storage Foundation 5.1 for Windows
(SFW) or Veritas Storage Foundation High Availability 5.1 for Windows (SFW
HA). It also covers licensing, adding features, and uninstalling information.
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Installing using the product installer
The product installer enables you to install the software for Veritas Storage
Foundation for Windows or Veritas Storage Foundation HA for Windows. An
SFW HA installation includes Veritas Storage Foundation for Windows and
Veritas Cluster Server. You may select other applicable options during the
installation. The steps in this section are based on a high availability or cluster
server (SFW HA) installation. While the steps for a client-side (SFW) installation
are similar, they are not exactly the same.

Setting Windows driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed by Microsoft.
When installing on systems running Windows Server 2003, you must set the
Windows driver signing options to allow installation.
The following table describes the product installer behavior on local and remote
systems when installing options with unsigned drivers on Windows Server
2003.
Table 2-1

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
Note: Windows Server 2008 does not enable you to change the driver signing
option. Symantec provides an installation option to install a Symantec Trusted
certificate to allow installation of Symantec drivers that are not certified by
Microsoft. For details, see “Installing Symantec Trusted certificate for unsigned
drivers” on page 37.
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To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.

4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.

Installing Symantec Trusted certificate for unsigned drivers
The product installer provides an installation option for Symantec Trusted
Software Publisher Certificate for Veritas Storage Foundation for Windows
drivers that are not certified by Microsoft.
If you select this installation option, a Symantec Trusted certificate is installed
on the systems you select for installation.
Warning: On Windows Server 2008, if this option is not selected, a remote install
will not install any SFW drivers that are not certified by Microsoft. No
notification is given and it will appear that installation was successful, but
issues can arise later because the drivers were not installed.
If installing locally on Windows Server 2008, if this option is not selected, a
driver signing popup will be displayed requiring user interaction.
If you select this option when installing on Windows Server 2003, you do not
need to set the driver signing options to Warn or Ignore.

Installing Storage Foundation HA for Windows
Install Veritas Storage Foundation HA for Windows.
To install the product
1

Allow the autorun feature to start the installation or double-click Setup.exe.
The SFW Select Product screen appears.

2

Click Storage Foundation HA 5.1 for Windows.
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This page also contains the following links:
Product Installation

Click this link to return to this Product
Installation screen.

Documentation

Click this link to see links for the Getting Started
Guide and the Release Notes.

Technical Support

Click this link to see information about
Symantec technical support.

Browse CD

Click this link to see the contents of the CD.

Symantec Home

Click this link to go to:
http://www.symantec.com.

3

Do one of the following:
■

Click Complete/Custom to begin installation.

■

Click the Administrative Console link to install only the client
components.

4

Review the Welcome message and click Next.

5

Read the License Agreement by using the scroll arrows in the view window.
If you agree to the license terms, click the radio button for I accept the
terms of the license agreement, and then click Next.
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6

Enter the product license key before adding license keys for features. Enter
the license key in the top field and click Add.
If you do not have a license key, click Next to use the default evaluation
license key. This license key is valid for a limited evaluation period only.

7

Repeat for additional license keys. Click Next

8

■

To remove a license key, click the key to select it and click Remove.

■

To see the license key’s details, click the key.

Select the appropriate SFW or SFW HA product options and click Next.
Options differ depending on your product and environment. The following
table shows the available product options:

Table 2-2

Available product options

Option

Description

SFW

SFW HA

Volume
Replicatior
(VVR)

Volume Replicator (VVR) replicates
data across multiple sites for disaster
recovery

✔

✔

FlashSnap

FlashSnap allows you to create and
maintain split-mirror, persistent
snapshots of volumes

✔

✔

VxCache

VxCache uses a portion of system
memory to improve I/O performance

✔

✔

MSCS

Cluster option for MSCS/Failover
Cluster
You can select this option even if
Microsoft clustering is not currently
installed.

✔

EMC Symmetrix/DMX DSM

✔

✔

EMC Clariion DSM

✔

✔

Hitachi TagmaStore/HP XP DSM

✔

✔

■

Hitachi 95xx-AMS-WM DSM

✔

✔

■

HP EVA-MSA DSM

✔

✔

■

IBM DS8000/ESS DSM

✔

✔

■

IBM DS6000 DSM

✔

✔

■

IBM DS4000/Sun 6000 DSM

✔

✔

Dynamic
■
Multi-pathing
■
Supported
Storage
■
Arrays
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Table 2-2

Available product options (continued)

Option

Description

SFW

SFW HA

vnetapp

NETAPP DSM (Windows Server 2003
only)

✔

✔

Global Cluster Global Cluster Option (GCO) enables
Option (GCO) you to link clusters to provide widearea failover and disaster recovery.

✔

High
Availability
Application
Agents

■

Database agent for SQL Server

✔

■

Database agent for Oracle

✔

■

Enterprise agent for Exchange

✔

High
Availability
Hardware
Replication
Agents

■

Agent for IBM MetroMirror

✔

■

Agent for EMC SRDF

✔

■

Agent for EMC SRDF/Star

✔

■

Agent for Hitachi TrueCopy

✔

■

Agent for EMC MirrorView

✔

Enterprise
Vault

■

Enterprise Vault (EV) Cluster
Setup Wizard

✔

Symantec
Trusted
Software
Publisher
Certificate

■

Symantec Trusted Software
Publisher Certificate for Veritas
Storage Foundation for Windows
drivers that are not certified by
Microsoft. Not selecting this
option may cause these drivers
not to install correctly for remote
install on Windows Server 2008.

✔

✔
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9

Select the domain and the computers for the installation and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.
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Install Path

Optionally, change the installation path.
■

To change the path, select a computer in the
Selected computers for installation field, type the
new path, and click Change.

■

To restore the default path, select a computer and
click Default.
The default path is:
C:\Program Files\Veritas
For 64-bit installations, the default path is:
C:\Program Files (x86)\Veritas

10 When the domain controller and the computer running the installation
program are on different subnets, the installer may be unable to locate the
target computers. In this situation, after the installer displays an error
message, enter the host names or the IP addresses of the missing computers
manually.
11 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next.
If a computer fails validation, address the issue, and repeat the validation.
Click the computer in the list to display information about the failure. Click
Validate Again to begin the validation process again.
12 If you are using multiple paths and selected a specific DSM, you receive the
Veritas Dynamic Multi-pathing warning. At the Veritas Dynamic Multipathing warning, the time required to install the Veritas Dynamic Multipathing DSMs feature depends on the number of physical paths connected
during the installation. To reduce installation time for this feature, connect
only one physical path during installation. After installation, reconnect
additional physical paths before rebooting the system.
13 Click OK.
14 Review the information and click Install. Click Back to make changes, if
necessary.
15 The Installation Status screen displays status messages and the progress of
the installation.
If an installation fails, click Next to review the report and address the
reason for failure. You may have to either repair the installation or
uninstall and re-install.
16 When the installation completes, review the summary screen and click
Next.
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17 If you are installing on remote nodes, click Reboot. Note that you cannot
reboot the local node now, and that failed nodes are unchecked by default.
Click the check box next to the remote nodes that you want to reboot.
18 When the nodes have finished rebooting successfully, the Reboot Status
shows Online and the Next button is available. Click Next.
19 Review the log files and click Finish.
20 Click Yes to reboot the local node.

Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK.

5

Repeat for each computer.

Installing from the command line
You can perform a silent installation using the command line for the SFW and
SFW HA software at the command prompt using the Setup.exe command.
With a silent installation, you can only install on one computer at a time.
Note: For Windows Server 2008, all CLI commands must run in the command
window in the “run as administrator” mode.
Presented at the end of this section are command examples showing a local
installation of the SFW client and SFW server, as well as a remote installation of
an SFW server.
See “Silent installation example: SFW client” on page 48.
See “Silent installation example: SFW server” on page 48.
See “Silent installation example: remote installation of an SFW server” on
page 48.
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Warning: Symantec provides an installation option to install a Symantec Trusted
certificate to allow installation of Symantec drivers that are not certified by
Microsoft. On Windows Server 2008, if this option is not specified, a remote
install will not install any SFW drivers that are not certified by Microsoft. No
notification is given and it will appear that installation was successful, but
issues can arise later because the drivers were not installed.
To start the installation from the command window
1

Open a command window by clicking Start > Run.

2

Enter cmd in the Open field and click OK.

3

In the command window, navigate to the root directory of the product CD.

4

Use the following command syntax to install SFW:
Setup.exe /s INSTALL_MODE=InstallMode SOLUTIONS="1,2,3,..."
[LICENSEKEY="LicenseKey"] [OPTIONS="a,b,c,..."]
[INSTALLDIR="InstallDirPath"] [NODE=SysA]
[REBOOT=RebootMode]

Where the maximum length of the argument string is 2,048 characters and
the syntax is not case sensitive.

Parameters for setup.exe
Table 2-3 contains information about the possible parameter values.
Table 2-3

Parameters for setup.exe

Parameter

Use

/s

Set for silent mode. If not set, boots the product installer GUI.

INSTALL_MODE

Set to indicate an installation or uninstallation.
1 = To install
5 = To uninstall
Example: INSTALL_MODE=1

SOLUTIONS

Set to the type of installation.
1 = SFW Server
2 = SFW HA Server
3 = SFW Client
4 = SFW HA Client
Example: SOLUTIONS=1
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Table 2-3

Parameters for setup.exe (continued)

Parameter

Use

LICENSEKEY

Set the license key for the installation. Enter multiple keys by
separating them with a comma—do not put spaces around the
comma.
The license key must start and end with a quotation mark (").
LicenseKey has no default setting.
Example: LICENSEKEY="123-234-123-234-345,321-543-765789-321"

OPTIONS

Set the desired options, if any, for the type of installation. The list of
options must start and end with a quotation mark (").
Example: OPTIONS="MSCS,VVR"
Caution: On Windows Server 2008, if the SYMCCERT option is not
selected, a remote install on Windows 2008 will not install any SFW
drivers that are not certified by Microsoft. No notification is given
and it will appear that installation was successful, but issues can
arise later because the drivers were not installed.

INSTALLDIR

Use only to set a non-default path for the installation directory. The
path must start and end with a quotation mark (").
Example: INSTALLDIR="C:\InstallationDirectory"
The default setting, used when you do not specify a path, is
SystemDrive:\Program Files\Veritas
If the path has blank spaces in it, the path should be set off with back
slashes as in the following example:
Example: INSTALLDIR=\"C:\Program Files (x86)\"

NODE

Set the node name. Specify only one node at a time.
The local node is the default setting when the node is unspecified.
Example: Node=SysA

REBOOT

Setting for the automatic reboot of the system at the completion of
the installation.
0 = No reboot
1 = Reboot
The default setting is 0 for no system reboot.
Example: REBOOT=1
Note: Reboot the system at the end of installation to ensure the
correct installation of the SFW drivers for the server component. You
do not have to reboot after installing the client components.
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Options differ depending on your product and environment. Table 2-4 shows the
available options:
Table 2-4

Available options

Option

Description

SFW

SFW HA

vvr

Volume Replicator (VVR) replicates
data across multiple sites for disaster
recovery

✔

✔

flashsnap

FlashSnap allows you to create and
maintain split-mirror, persistent
snapshots of volumes

✔

✔

vxcache

VxCache uses a portion of system
memory to improve I/O performance

✔

✔

mscs

Cluster option for MSCS/Failover
Cluster

✔

EV

Enterprise Vault Cluster Setup Wizard

symccert

Installs Symantec Trusted Software
Publisher Certificate for Veritas
Storage Foundation for Windows
drivers that are not certified by
Microsoft.

✔
✔

✔

Caution: On Windows Server 2008, if
this option is not specified, a remote
install on Windows 2008 will not
install any SFW drivers that are not
certified by Microsoft. No notification
is given and it will appear that
installation was successful, but issues
can arise later.
If installing locally on Windows Server
2008, if this option is not specified, a
driver signing popup will be displayed
requiring user interaction.
If you specify this option when
installing on Windows Server 2003,
you do not need to set the driver
signing options to Warn or Ignore.
sfwdoc

Documentation for SFW solutions

sfwhadoc

Documentation for SFW HA solutions

✔
✔

VCS

✔
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Table 2-4

Available options (continued)

Option

Description

SFW

SFW HA

VCS

vemcsymm

EMC Symmetrix/DMX DSM

✔

✔

vemcclar

EMC Clariion DSM

✔

✔

vhdsaa

Hitachi TagmaStore/HP XP DSM

✔

✔

vhdsap

Hitachi 95xx-AMS-WM DSM

✔

✔

vhpeva

HP EVA-MSA DSM

✔

✔

vibmaads

IBM DS8000/ESS DSM

✔

✔

vibmap

IBM DS6000 DSM

✔

✔

vengap

IBM DS4000/Sun 6000 DSM

✔

✔

vitarget

Windows Storage Server 2003 R2 iSCSI
DSM

✔

✔

v3paraa

3PARDATA DSM

✔

✔

vpillar

VPILLAR DMS

✔

✔

vibmapds

IBM DS AP DSM

✔

✔

vnetapp

NETAPP DSM

✔

✔

gco

Global Cluster Option (GCO) enables
you to link clusters to provide widearea failover and disaster recovery.

✔

✔

sql

Database agent for Microsoft SQL
Server

✔

✔

exchange

Enterprise agent for Microsoft
Exchange

✔

✔

oracle

Database agent for Oracle

✔

✔

srdf

Hardware replication agent for EMC
SRDF

✔

truecopy

Hardware replication agent for Hitachi
TrueCopy

✔

mirrorview

Hardware replication agent for EMC
MirrorView

✔

metromirror

Hardware replication agent for
MetroMirror

✔
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Table 2-4

Available options (continued)

Option

Description

srdfstar

Hardware replication agent for EMC
SRDF/Star

SFW

SFW HA

VCS

✔

Silent installation example: SFW client
This sample command installs the SFW Client, states that the installation path
is C:\InstallationDirectory, and tells the system not to reboot at the end
of the installation.
Setup.exe /s INSTALL_MODE=1 SOLUTION=3
INSTALLDIR="C:\InstallationDirectory" REBOOT=0

Silent installation example: SFW server
This sample command installs the SFW Server with a license key of 123-234123-234-345, along with the MSCS and VVR options and their license keys. It
states that the installation path is C:\InstallationDirectory and tells the
system to reboot at the end of the installation.
Setup.exe /s INSTALL_MODE=1 SOLUTION=1
LICENSEKEY="123-234-123-234-345,321-543-765-789-321,
321-543-765-789-789" OPTIONS="MSCS,VVR"
INSTALLDIR="C:\InstallationDirectory" REBOOT=1

Silent installation example: remote installation of an SFW
server
This sample command installs the SFW Server with a license key of 123-234123-234-345, along with the MSCS and VVR options and their license keys. It
states that the installation path on that computer is
C:\InstallationDirectory, that the node it is installing to is SysA, and
tells the system to reboot at the end of the installation.
Setup.exe /s INSTALL_MODE=1 SOLUTION=1
LICENSEKEY="23-234-123-234-345,321-543-765-789-321,
321-543-765-789-789" OPTIONS="MSCS,VVR,SYMCCERT"
INSTALLDIR="C:\InstallationDirectory" NODE=SysA REBOOT=1
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Possible next tasks
Changing the default password after installing VCS client
When you install and configure the VCS client components (Java GUI), if you do
not choose the secure mode during cluster configuration, the Veritas Cluster
Server Configuration Wizard (VCW) creates a user with default credentials of
user name "admin" and password "password". Make sure that when you
configure the cluster using VCW, you create a unique user name and password
during the configuration process instead of accepting the default values.

Installing Microsoft clustering software after installing SFW
The Cluster Option for Microsoft Cluster Service (MSCS)/Failover Cluster option
can be selected when installing Storage Foundation 5.1 for Windows, whether or
not the machine where the install is taking place is a member of a Microsoft
cluster. If the machine later becomes the first node in a Microsoft cluster, the
Veritas Volume Manager Disk Group resource type must be manually registered
with the Microsoft cluster. This installation kit contains a script for use in this
case.
To register the Veritas Volume Manager Disk Group resource type
1

Open a command window by clicking Start > Run and then typing cmd.

2

Type cd %vmpath%\VM5INF.

3

Once there, type clusReg.cmd. This registers the Volume Manager Disk
Group resource type for use on the cluster.

4

Verify successful registration with the command cluster restype. The
output should include the Volume Manager Disk Group. You will have to
open a new command window for this, because executing the script closes
the command window it runs in.

The following is example output of the cluster regtype command.
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Listing all available resource types:
Display Name

Resource Type Name

IP Address

IP Address

Network Name

Network Name

Physical Disk

Physical Disk

DHCP Service

DHCP Service

Distributed Transaction Coordinator

Distributed Transaction Coordinator

File Share

File Share

Generic Application

Generic Application

Generic Script

Generic Script

Generic Service

Generic Service

Local Quorum

Local Quorum

Majority Node Set

Majority Node Set

Message Queuing

MSMQ

Print Spooler

Print Spooler

Volume Shadow Copy Service Task

Volume Shadow Copy Service Task

WINS Service

WINS Service

Volume Manager Disk Group

Volume Manager Disk Group

It is not necessary to run the script on a machine where Storage Foundation for
Windows 5.1 is installed with Cluster Option for Microsoft Cluster Service
(MSCS)/Failover Cluster selected, and the machine is then joined to an existing
MSCS cluster with the "Veritas Volume Manager Disk Group" resource type
already registered.

Installing Sun’s Java Access Bridge
JAWS (Job Access for Windows and Speech) is a screen reader program that
allows people who are blind to gain access to information on their computers. In
order to use JAWS with the Java GUI, you need to install Sun Microsystem’s Java
Access Bridge. This provides access to all Java applications.
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To install Java Access Bridge
1

Open a Web browser and go to the Java Access Bridge download page at
http://java.sun.com/javase/technologies/accessibility/accessbridge/
index.jsp.

2

Click the link Download Java Access Bridge, and then select the Access
Bridge executable. There is also a manual download option but automatic
installation is preferable.

3

Run the installer to install the required dll and jar files in the java
installations of the system.

4

Restart your system.

5

Run JAWS and the Java GUI.

Configuring an SFW HA cluster
After installing SFW HA, run the VCS Configuration Wizard to complete the
VCS cluster configuration. See “Planning an SFW HA installation” on page 30
for more information.
Information on cluster configuration and optional VCS features can be found in
the following guides:
■

Veritas Cluster Server Administrator’s Guide

■

Veritas Storage Foundation and High Availability Solutions HA and Disaster
Recovery Solutions Guide for Microsoft Exchange

■

Veritas Storage Foundation and High Availability Solutions HA and Disaster
Recovery Solutions Guide for Microsoft SQL

■

Veritas Storage Foundation and High Availability Solutions, Solutions Guide

Configuring an iSCSI SAN with SFW
On an iSCSI initiator node, SFW enables you to define iSCSI target portals, log
into and out of iSCSI targets, and view the target portal group configuration.
With SFW, you can also connect to and manage iSNS objects on a Microsoft iSNS
server. If your server's iSCSI initiator is connected to a Microsoft iSCSI Software
Target, you can view the set of LUNs that are accessible to your initiator.

Prerequisites
When configuring an iSCSI SAN with SFW, you should consider the following
prerequisites and the requirements for each as described in the documentation
that accompanies them:
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■

iSCSI HBA or dedicated NIC card
(Using the Veritas DG Delayed Import Service (VxDgDI) is required for a
dedicated NIC card.)

■

For Windows Server 2003:
■

■

VDS 1.1 Update

For Windows Server 2003 SP2 or Windows Server 2008:
■

VDS 1.1 is included with these versions

■

Microsoft VDS iSCSI Hardware Provider
(optional; available as part of Windows Storage Server)

■

Microsoft iSCSI initiator 2.06 or above

Setting up an iSCSI SAN
Setting up an iSCSI SAN requires configuring target portals, setting up the iSCSI
targets and iSCSI initiators, configuring the storage, assigning access rights,
and registering with an iSNS server.
Setting up the iSCSI targets and configuring the storage should be done
according to the instructions of the manufacturer of the storage device.
Setting up the iSCSI initiators requires that iSCSI initiator software be installed
on each server to enable them to connect to the iSCSI targets. Optionally, the
iSNS server software needs to be installed on a server to allow automatic
discovery of the iSCSI targets on the network.
To assign access rights
1

In the tree view of the VEA GUI, click the iSCSI node. Since the iSNS server
automatically discovers the initiators and targets, expanding the iSCSI node
displays all the available initiators and targets in the network.

2

Login to the desired targets to make them available to the initiator.
■

Select a target and select Login from its context menu.

■

Check any desired optional login settings. The available login settings
are to allow persistent restore of the login or to enable multi-path login.

■

To set any security settings, such as CHAP or IPsec, check Advanced
Settings to access the security settings dialog.

Make sure that the security settings are compatible with the settings that were
set up for the storage device.
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Using SFW iSCSI late start
SFW and SFW HA normally import dynamic (non-cluster) disk groups during
system start up. At start up, however, the products can neither discover nor
import Microsoft iSCSI Software Initiator managed storage devices. To allow
SFW and SFW HA the time to discover and import this managed storage, you
must configure the Veritas DG Delayed Import Service (VxDgDI) and use the
vxdg latestart command.
Note: Using SFW iSCSI late start only applies if you are using a NIC card and not
iSCSI HBA.

vxdg latestart
The vxdg latestart command is entered at the command line using the
following form:

vxdg -gDynamicDiskGroupName latestart on|off
where DynamicDiskGroupName is the name of the Microsoft iSCSI Software
Initiator managed dynamic disk group.
Specifying on in the vxdg latestart command enables the dynamic disk
group that is referenced in -gDynamicDiskGroupName to be imported after
system start up by the Veritas DG Delayed Import Service (VxDgDI). The
VxDgDI can import the dynamic disk group after it is made dependent on the
service that controls the storage. This allows the required time for the storage to
become available. Applications that rely on storage imported by the VxDgDi
service may also need to be made dependent on VxDgDI so that they may
proceed when their storage is available.
For example, iSCSI storage needs to be imported after system start up because it
is not available at system start up time. When VxDgDI is made dependent on the
iSCSI service, the import of the dynamic disk group occurs after system start up
when the iSCSI service is ready. Applications that rely on the iSCSI storage and
have been made dependent on the VxDgDI service may then proceed.
As long as the dynamic disk group remains on the same host, the vxdg
latestart is enabled, even through reboots. If the dynamic disk group is
deported and imported on another host, the vxdg latestart is disabled and
must be re-enabled on the new host. In a clustered environment, the cluster
application imports disk groups and does not need to have vxdg latestart
enabled.
To use vxdg latestart
1

In the Windows Services dialog, change the Veritas DG Delayed Import
Service startup type from Manual to Automatic.
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2

3

Edit the Windows registry to make VxDgDI dependent on the service that
controls the storage. (For Windows 2003, use regedit to configure the
service.)
The following procedure to make the VxDgDI dependent on the Microsoft
iSCSI Initiator service (MSiSCSI) on Windows 2003 is given as an example.
■

Open the Registry Editor (regedit) to edit the Windows registry.

■

Select the registry key:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
\VxDgDI

■

Right-click the DependOnService value and select Modify. If the
DependOnService value does not exist, right-click empty space in the
right pane of the Registry Editor to bring up a context menu to create
the value. Select New > Multi-String Value and name the new value
DependOnService. Right-click the DependOnService value and select
Modify.

■

In the Edit String dialog that appears, enter MSiSCSI on a new line
below the other entries that appear in the Value Data pane.

■

Click OK and close the Registry Editor.

■

Reboot the system to apply the changes.

■

Do not reboot your system at this point if you also need to edit the
registry as indicated in step 4 below.

■

Reboot your system now if you do not need to make any additional
changes to the registry.

Enter the vxdg latestart command at the command line.
For example:

vxdg -gDynDskGrp2 latestart on
Enables the dynamic disk group DynDskGrp2 to be imported after system
startup.
4

Applications that rely on storage which is imported by the VxDgDI service
have their storage available after the Veritas DG Delayed Import Service
completes its startup process. However you need to make applications that
start as a Windows service, such as Microsoft Exchange, dependent on the
Veritas DG Delayed Import Service by editing the Windows Registry Editor
before their storage is available. (For Windows 2003, use regedit to configure
the service.)
The following example makes the service for Microsoft Exchange (Microsoft
Exchange Information Store service) dependent on VxDgDI on Windows
2003:
■

Open the Registry Editor (regedit) to edit the Windows registry.

Installing SFW or SFW HA
Updating SFW or SFW HA

■

Select the registry key

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\
Services \MSExchangeIS
■

Right-click the DependOnService value and select Modify. If the
DependOnService value does not exist, right-click empty space in the
right pane of the Registry Editor to bring up a context menu to create
the value. Select New > Multi-String Value and name the new value
DependOnService. Right-click the DependOnService value and select
Modify.

■

In the Edit String dialog that appears, enter VxDgDI on a new line
below the other entries that appear in the Value Data pane.

■

Click OK and close the Registry Editor.

■

Reboot the system to apply the changes.

Updating SFW or SFW HA
The product installer allows you to update the SFW and SFW HA client and
server components you have installed.
To update SFW and SFW HA
1

Open the Windows Control Panel and click Add or Remove Programs.

2

Select Veritas Storage Foundation with High Availability 5.1 for Windows
(Server) Components and click Change.

3

The Symantec Product Installer screen appears. Select LiveUpdate. Click
Next.

4

The LiveUpdate screen appears. Choose to check if updates are available
automatically by selecting On (automatically check for updates) or choose
to check if updates are available manually by selecting Off (manually check
for updates).

5

Choose a LiveUpdate mode. If On (automatically check for updates) is
selected, you have a choice to select Express to have updates automatically
downloaded and installed, or select Interactive to view a list of available
updates and choose which to download and install on your computer.

6

Select Check for latest update after “Finish” is clicked. Click Finish.
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Adding or removing features
The product installer allows you to add or remove features. You can only add or
remove features on the local system.
To add or remove features
1

Open the Windows Control Panel and click Add or Remove Programs.

2

Select Veritas Storage Foundation with High Availability 5.1 for Windows
(Server) Components and click Change.

3

The Symantec Product Installer screen appears. Select Add or Remove. Click
Next.

4

The Server Components screen appears. Select or clear the option check
boxes in the tree navigation structure to add or remove a component
respectively.

To add a license key for an option:
1

Right-click on the option and select Add License.

2

In the pop-up window that appears, enter the license key for the option and
click OK.
Select the check box to add the option.

3

Click Next.

Validation and Summary
1

The Validation screen appears. The installer checks the prerequisites for the
selected options and displays the results. Review the information and click
Next.
If a system fails validation, click the system in the systems list to display
information about the failure. Address the problem and click Validate Again
to repeat the validation process.

2

The Summary screen appears. Review the information and click Update to
begin the product update.

3

The Update Status screen appears and displays status messages and the
update progress.

4

When complete, review the summary and click Next.

5

On the Thank You screen, click Finish.

6

In the message box, click Yes to reboot your system.
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Repairing the installation
The product installer can repair an existing installation of SFW and SFW HA
client and server components. This installer can only repair the local system.
To repair the installation
1

Open the Windows Control Panel and click Add or Remove Programs.

2

Select Veritas Storage Foundation with High Availability 5.1 for Windows
(Server) Components and click Change.

3

The Symantec Product Installer screen appears. Select Repair. Click Next.

4

The Validation screen appears. The installer checks the prerequisites for the
systems and displays the results. Review the information and click Next.
If a system fails validation, click the system in the systems list to display
information about the failure. Address the problem and click Validate Again
to repeat the validation process.

5

The Summary screen appears. Review the information and click Repair to
begin the repair process.

6

The Repair Status screen appears. Status messages and the progress of the
repair are displayed.
If a repair fails, click Next to review the report and address the reason for
failure. You may have to uninstall and re-install the software.

7

When complete, review the summary and click Next.

8

On the Thank You screen, click Finish.

9

In the message box, click Yes to reboot your system.

License management
The product installer allows you to add or remove license keys for options in
your installation of SFW and SFW HA client and server components.
To add or remove license keys
1

Open the Windows Control Panel and click Add or Remove Programs.

2

Select Veritas Storage Foundation with High Availability 5.1 for Windows
(Server) Components and click Change.

3

The Symantec Product Installer screen appears. Select License
Management. Click Next.
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4

The license key screen appears. Enter the license key you want to add and
click Update. If you want to remove a license key, select the license key in the
Licenses field and click Remove.

Uninstalling using the product installer
In order to uninstall the software from remote computers, the local computer
where you uninstall must have SFW or SFW HA installed on it.
The steps in the following procedure apply to a SFW uninstallation of the server
and client components from a Windows 2003 system. The steps for uninstalling
the client components and high availability server are similar.
Note: For SFW HA uninstallations, you must unconfigure the cluster before
uninstalling. Use the Veritas Cluster Wizard (VCW) to unconfigure the cluster.
See the Veritas Cluster Server Administrator’s Guide for more information.
To uninstall using the product installer
1

In the Windows Control Panel, select Add or Remove Programs.

2

Click Veritas Storage Foundation 5.1 for Windows (Server Components).

3

Click Remove.

4

Click Next.

5

On the Client Components screen, uninstall client components in addition
to the server components by selecting the check box. Click Next.

6

Select the systems that you want to uninstall from the Domain and
Computer drop-down menus and click Add. Optionally, type the computer’s
name in the Computer field. Repeat to uninstall from other systems.
To remove a system from the Selected computers list, click the system and
click Remove.

7

Click Next.

8

On the Validation screen, the installer checks the prerequisites for the
selected systems and displays the results. Review the information and click
Next.
If a system fails validation, click the system in the systems list to display
information about the failure. Address the problem and click Validate Again
to repeat the validation process.

9

The Summary screen appears and displays the settings and systems selected
for uninstallation. Click Uninstall.
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10 The Uninstall Status screen displays status messages and the progress of
the installation.
If an uninstallation fails, the status screen shows a failed uninstallation.
Click Next to review the report, address the reason for failure, and retry this
step on that computer.
11 When complete, review the summary and click Next.
12 Reboot the remote nodes.Note that you cannot reboot the local node now.
■

Click the check box next to the remote nodes that you want to reboot.

■

Click Reboot.

■

When the remote nodes have finished rebooting successfully, the
Reboot Status shows Online and the Next button is available. Click
Next.

■

Once the remote nodes have rebooted, click Next.

13 On the Thank You screen, review the log file and click Finish.
14 Click Yes to reboot the local system.

Uninstalling from the command line
You can silently uninstall the SFW software from the command prompt using
the setup.exe command.
At the end of this section, two command examples show how to uninstall the
client components.
See “Setup.exe example: Uninstalling the SFW client components” on page 61.
See “Setup.exe example: Uninstalling the SFW server components” on page 61.
To start the uninstallation from the command prompt
1

Open a command window by clicking Start > Run.

2

Enter cmd in the Open field and click OK.

3

In the command window, navigate to the root directory of the product CD.

4

Use the following command syntax to silently uninstall SFW:
Setup.exe /s INSTALL_MODE=InstallMode SOLUTIONS="1,2,3,..."
[REBOOT=RebootMode] [NODE=SysA]
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Information about the possible parameter values follows:
Table 2-5

Parameters for uninstalling the product

Parameter

Use

/s

Set for silent mode.

INSTALL_MODE

Set to indicate an install or uninstall.
1 = To install
5 = To uninstall
The default setting is 1 to install. Set this parameter to 5 for
uninstall.
Example: INSTALL_MODE=5

SOLUTIONS

Set to the type of uninstallation.
1 = SFW Server
2 = SFW HA Server
3 = SFW Client
4 = SFW HA Client
The default setting is 1 for SFW Server.
Example: SOLUTIONS=1

REBOOT

Setting for the automatic reboot of the system at the completion
of the installation.
0 = No reboot
1 = Reboot
The default setting is 0 for no system reboot.
Example: REBOOT=1

NODE

Set the node name. Specify only one node at a time.
The local node is the default setting when the node is
unspecified.
Example: Node=SysA
Note: Reboot the system at the end of uninstallation to ensure
that the SFW drivers for the server component are installed
correctly. You do not have to reboot after uninstalling the client.
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Setup.exe example: Uninstalling the SFW client components
This sample command completely uninstalls the SFW client components, and
tells the system to reboot at the end of the uninstallation.
Setup.exe /s INSTALL_MODE=5 SOLUTIONS=3 REBOOT=1

Setup.exe example: Uninstalling the SFW server components
This sample command completely uninstalls the SFW server components, and
tells the system to reboot at the end of the uninstallation.
Setup.exe /s INSTALL_MODE=5 SOLUTIONS=1 REBOOT=1

Installing and uninstalling Veritas Dynamic Multipathing
This section contains the following topics:
■

“Introduction to DMP Device Specific Modules (DSMs)” on page 61

■

“Prerequisites” on page 62

■

“Installing and uninstalling DMP Device Specific Modules (DSMs)” on
page 62

For more detailed instructions on DMP DSMs, see the Veritas Storage
Foundation Administrator’s Guide.

Introduction to DMP Device Specific Modules (DSMs)
The Veritas Dynamic Multi-pathing option adds fault tolerance by supporting
multiple paths between a server and a storage array. Veritas Dynamic Multipathing (DMP) is implemented through Dynamic Multi-pathing Device Specific
Modules (DSMs).
DMP DSMs are the dynamic multi-pathing method that work with the Microsoft
Windows Server 2003 Multipath Input/Output solution. DMP DSMs support the
following:
■

Windows Server 2003 and 2008

■

Windows Storport driver

■

Microsoft iSCSI Initiator

■

Dynamic Least Queue Depth load balancing

■

Active/Active dynamic multi-pathing with clustering
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Prerequisites
Please review the following prerequisites for installing DMP DSMs:
■

Make sure that your host has an HBA port for each path to the SAN switch.

■

Check that your host has one SCSI or fiber cable per host bus adapter port.

■

For iSCSI, assign each host bus adapter port a unique SCSI ID.

■

Connect no more than one path to shorten installation time.

■

Ensure that the Windows Storport driver is installed.

Symantec maintains a Hardware Compliance List (HCL) for Veritas Storage
Foundation and High Availability Solutions 5.1 for Windows. The HCL gives
information on HBAs, firmware, and switches that have been tested with each
supported array. Check the HCL for details about your hardware before
installing or using DMP DSMs. The HCL is located at:
http://www.symantec.com/business/support/index.jsp
Warning: Do not change the cable connection order after installing SFW. For
example, if host bus adapter A is connected to port A on the array and host bus
adapter B is connected to port B on the array, do not swap the connections
between ports on the array (A to B and B to A).

Installing and uninstalling DMP Device Specific Modules (DSMs)
This section includes the following topics:
■

“Setting up DMP Device Specific Modules (DSMs)” on page 63

■

“Installing DMP Device Specific Modules (DSMs) on a new standalone
server” on page 63

■

“Installing SFW HA and DMP Device Specific Modules (DSMs) on a cluster
for the first time” on page 63

■

“Installing SFW, Microsoft clustering, and DMP Device Specific Modules
(DSMs) on a cluster for the first time” on page 64

■

“Adding DMP Device Specific Modules (DSMs) to an existing standalone
server” on page 65

■

“Adding DMP DSMs to an existing SFW HA or MSCS cluster” on page 66

■

“Uninstalling DMP DSMs” on page 66
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Setting up DMP Device Specific Modules (DSMs)
In general, the steps for adding DMP DSMs to any configuration are as follows:
■

Install the new host adapter hardware.

■

To shorten installation time, make sure no more than a single path is
connected to the array storage before installation.

■

Install the software by selecting DMP DSMs as part of the SFW or SFW HA
installation process.

It is very important to install the correct hardware drivers for DMP DSMs. Refer
to your hardware documentation for detailed information about hardware
drivers.

Installing DMP Device Specific Modules (DSMs) on a new
standalone server
Follow these steps to install DMP DSMs on a new standalone server.
To install DMP DSMs on a new standalone server
1

Install the necessary hardware and the appropriate drivers.

2

Connect no more than one path from the array to the computer.

3

During installation, on the Option Selection screen, select DMP Device
Specific Modules (DSMs). Optionally, you can expand the option to select
only the appropriate DSMs for your environment.

4

Complete the wizard, rebooting where instructed.

5

Physically reconnect the additional path.

Installing SFW HA and DMP Device Specific Modules (DSMs)
on a cluster for the first time
For DMP DSMs in a cluster environment, either Active/Active or Active/Passive
load balance settings can be used. DMP DSMs automatically set the load
balancing to Active/Passive for disks under SCSI-2 reservation. For Active/
Active load balancing in a cluster environment, the array must be enabled for
SCSI-3 Persistent Group Reservations (SCSI-3 PGR).
For more information on DMP DSMs load balance settings and enabling or
disabling SCSI-3 PGR, see the Veritas Storage Foundation Administrator’s Guide.
Warning: Failure to adhere to the following instructions results in disk signature
discrepancies causing SFW HA or other applications to fail.
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To install SFW HA and DMP DSMs on a cluster for the first time
1

Before running the installation, connect no more than one path from the
array to the computer.

2

Install SFW HA and DMP DSMs at the same time on all nodes in the cluster.
During installation select the appropriate features. On the Option Selection
screen, select DMP Device Specific Modules (DSMs). Optionally, you can
expand the option to select only the appropriate DSMs for your environment

3

Reboot after installation.

4

Physically reconnect the additional path.

5

After rebooting, run the various VCS wizards to complete the VCS cluster
configuration. For more information on creating and configuring the VCS
cluster, see the Veritas Cluster Server Administrator’s Guide.

Installing SFW, Microsoft clustering, and DMP Device Specific
Modules (DSMs) on a cluster for the first time
For DMP DSMs in a cluster environment, either Active/Active or Active/Passive
load balance settings can be used. DMP DSMs automatically set the load
balancing to Active/Passive for disks under SCSI-2 reservation. For Active/
Active load balancing in a cluster environment, the array must be enabled for
SCSI-3 Persistent Group Reservations (SCSI-3 PGR).
For more information on DMP DSMs load balance settings and enabling or
disabling SCSI-3 PGR, see the Veritas Storage Foundation Administrator’s Guide.
To support Microsoft clustering and DMP Device Specific Modules (DSMs)
simultaneously on a cluster, perform the following procedures.
Warning: Failure to adhere to the following instructions results in disk signature
discrepancies causing MSCS, Windows Failover Cluster, or other applications to
fail.
To install Microsoft clustering and DMP DSMs for the first time on a cluster
1

Create the Microsoft cluster.

2

Before running the installation, connect no more than one path from the
array to the computer.

3

Install SFW and DMP DSMs at the same time. During installation select the
appropriate features. On the Option Selection screen, select DMP Device
Specific Modules (DSMs). Optionally, you can expand the option to select
only the appropriate DSMs for your environment.
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4

Reboot after installation.

5

Physically reconnect the additional path.

6

Set up and configure the Microsoft (MSCS or Windows Failover Cluster)
cluster.

Adding DMP Device Specific Modules (DSMs) to an existing
standalone server
Follow these steps to add DMP DSMs to an existing server.
To add DMP DSMs to an existing server
1

Install additional hardware and its appropriate drivers.

2

Connect no more than one path from the array to the computer.

3

Open the Windows Control Panel and select Add or Remove Programs.

4

Select Change or Remove Programs.

5

Select the SFW Server Components entry and click Change.

6

The installer screen appears. Select Add or Remove. Click Next.

7

The Option Selection screen appears. Select DMP Device Specific Modules
(DSMs). Optionally you can expand the option to select only the appropriate
DSMs for your environment.

8

9

To add a license key for an option:
■

Click the Add License link located at the far right of the screen

■

The Add License link appears only for unlicensed options.

■

In the pop-up window that appears, enter the license key for the option
and click OK.

■

Select the check box to add the option and click Next.

Reboot the system.

10 Reconnect the additional physical path.
11 Verify that the additional path exists.
■

Open the Veritas Enterprise Administrator console.

■

In the System field, expand the Disks tree.

■

Click any external hard disk.

■

Above the console, click the DMP tab.

■

Verify that the path exists.
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Adding DMP DSMs to an existing SFW HA or MSCS cluster
Symantec recommends that you perform a rolling upgrade and install SFW or
SFW HA and DMP DSMs on each node separately.
To add DMP DSMs to an existing SFW HA or MSCS cluster
1

Move resources to another node or take the resources offline.

2

Install additional hardware and its appropriate drivers.

3

Connect no more than one path from the array to the computer.

4

Open the Windows Control Panel and select Add or Remove Programs.

5

Select Change or Remove Programs.

6

Select the SFW HA Server Components entry and click Change.

7

The installer screen appears. Select Add or Remove. Click Next.

8

The Option Selection screen appears. Select DMP Device Specific Modules
(DSMs). Optionally, you can expand the option to select only the appropriate
DSMs for your environment.
To add a license key for an option:
■

Click the Add License link located at the far right of the screen.

■

The Add License link appears only for unlicensed options.

■

In the pop-up window that appears, enter the license key for the option
and click OK.

Select the check box to add the option.
Click Next.
■

9

Reconnect the additional physical path.

10 Reboot the system.
11 Verify that the additional path exists.
■

Open the Veritas Enterprise Administrator console.

■

In the System field, expand the Disks tree.

■

Click any external hard disk.

■

Above the console, click the DMP tab.

■

Verify that the path exists.

Uninstalling DMP DSMs
To uninstall DMP DSMs, use Add or Remove through the installer.
See“Adding or removing features” on page 56.
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Upgrading
This section includes the following chapters which describe the procedures used
to upgrade to Veritas Storage Foundation for Windows 5.1 or Veritas Storage
Foundation High Availability for Windows 5.1:
■

Chapter 3, “Upgrading to SFW 5.1” on page 69

■

Chapter 4, “Upgrading to SFW HA 5.1” on page 107

■

Chapter 5, “Upgrading an Exchange Server cluster” on page 135

■

Chapter 6, “Upgrading a SQL Server cluster” on page 167

■

Chapter 7, “Microsoft Service Pack upgrades” on page 199

■

Chapter 8, “Upgrading an Oracle cluster” on page 209
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Upgrading to SFW 5.1
This chapter covers upgrading to Veritas Storage Foundation 5.1 for Windows
(SFW 5.1). This chapter contains:
■

Before upgrading to SFW 5.1

■

Upgrading 4.3.x or 5.0.x versions to SFW 5.1

■

Upgrading in a Microsoft cluster environment

Before upgrading to SFW 5.1
Before upgrading, you need to make sure that your systems meet the minimum
product versions. You must also do some preparation for the upgrade.
Warning: Rules created using the SFW 4.x Rule Manager will not automatically
be upgraded and will not work in SFW 5.x. See http://entsupport.symantec.com/
docs/303042 for more information.

Checking the supported minimum product versions
To upgrade to SFW 5.1, your system must have version 4.3 or higher of SFW
already installed. The previously installed version of SFW must meet the
minimum product version, which the product installer checks before it
upgrades.
If your current installation does not meet the minimum level required by the
installer, you must manually apply the appropriate product upgrades to meet
the minimum product level required before proceeding with the installer. You
can get intermediate versions of the products on the Symantec Support site:
http://www.symantec.com/business/support/index.jsp. For license keys,
contact Symantec Sales. You can also uninstall the older versions of the product
and install the new product.
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Preparing for the upgrade
Upgrading the product requires the following steps:
■

Back up all your data in a safe location.

■

Back up the system state.

■

Check the hardware requirements for the software upgrade.

■

Check to see if you need to update the Microsoft Active Directory to support
the upgraded software.

■

Test the system after each upgrade, especially after applying product
upgrades to meet the minimum version required. An incremental upgrade
eases the troubleshooting process.

Additional upgrade information
This section includes the following information for upgrades with SFW and
Microsoft clustering.
■

During an upgrade, you might encounter messages while the installer
validates the selected systems. These informational messages do not
indicate an error. If an error occurs, the system’s status confirms the
problem.

■

To perform this upgrade, use a rolling upgrade procedure that involves
installing SFW 5.1 on inactive nodes of the cluster. You then use the Move
Group command in MSCS or Microsoft failover clustering to move the active
node and install SFW on the cluster’s remaining nodes.
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Upgrading 4.3.x or 5.0.x versions to SFW 5.1
You can upgrade to SFW 5.1 from the following SFW versions: SFW 4.3, 4.3 MP1,
4.3 MP2, 5.0, or 5.0 RP1.
If you have already installed and configured Veritas Volume Replicator (VVR) or
DMP, the upgrade process includes required procedures before and after the
upgrade to SFW 5.1. Use the sequence as follows:
■

“Preparing a VVR environment for upgrading” on page 71

■

“Preparing to add DMP DSMs to the upgraded environment” on page 82 or
“Preparing an existing DMP environment for upgrading” on page 82

■

“Upgrading to SFW 5.1” on page 84
If you are upgrading in a Microsoft cluster environment, see the following
section before beginning the upgrade:
“Upgrading in a Microsoft cluster environment” on page 99

■

“Re-enabling VVR after the upgrade” on page 91

■

“Reconnecting DMP DSM paths after the upgrade” on page 98

■

“Upgrading dynamic disk groups” on page 98

Preparing a VVR environment for upgrading
Depending on what your original environment is, you will need to follow one of
the following procedures to prepare your VVR environment for upgrading to
SFW 5.1.
■

“Preparing a non-clustered VVR environment for upgrade from SFW 4.3.x”
on page 71

■

“Preparing a non-clustered VVR environment for upgrade from SFW 5.0.x”
on page 74

■

“Preparing a Microsoft clustered VVR environment for upgrade from SFW
4.3.x” on page 76

■

“Preparing a Microsoft clustered VVR environment for upgrade from SFW
5.0.x” on page 79

Preparing a non-clustered VVR environment for upgrade
from SFW 4.3.x
If you use VVR to replicate data from a primary site to a secondary site, use the
following procedures to stop the replicated volume group (RVG) and detach the
replication links (RLINKs). For VVR related details, refer Veritas Storage
Foundation Volume Replicator, Administrator’s Guide.
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Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
To prepare the primary site
1

Stop the application that uses VVR to replicate data between the sites.

2

Open a command window by clicking Start > Run. In the Open field, enter
cmd, and click OK.

3

To get the list of RLINK and RVG records, run the following command on the
primary site:
vxprint -lVP [-g <diskgroup_name>]

4

Stop the RVG to prevent the application from accessing or modifying the
volumes during the upgrade.
■

From the Veritas Enterprise Administrator (VEA) console, right-click
the RVG and select the Disable Data Access option.
The Disable Data Access operation prevents the user or application
from writing any data to the data volumes.
Or

■

From the command line, type
vxrvg stop [-g <diskgroup_name>] <rvg_name>

This command disables Input/Output access to the associated data
volumes.
5

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary site:
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK. This command can be run only on the primary site.
Verify that the data volumes on the secondary are consistent and up-todate with the primary before proceeding to the next step.
6

Detach the RLINK to prevent VVR from replicating data to the secondary
site.
■

From the VEA console, right-click the secondary RVG and select the
Stop Replication option.
The Stop Replication option is available only when selecting the
secondary RVG. When this operation is performed the connection
between the primary and secondary RVG is broken.
Or

■

From the command line, type
vxrlink [-g < diskgroup_name>] det <rlink_name>
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This command detaches the RLINK from the RVG.
7

Disassociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log and select the
Dissociate Replicator Log option.
Or

■

From the command line, type
vxrvg [-f] [-g <diskgroup>] [-r <rvg_name>] dis<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
To prepare the secondary site
1

Open a command window by clicking Start > Run in the task bar. In the Open
field, enter cmd, and click OK.

2

To get a list of RLINK and RVG records, run the following command:
vxprint -lVP [-g <diskgroup_name>]

3

Stop the RVG to prevent the application from accessing or modifying the
volumes during the upgrade.
■

From the VEA console, right-click the RVG and select the Disable Data
Access option.
The Disable Data Access operation prevents the user or application
from writing any data to the data volumes.
Or

■

From the command line, type
vxrvg [-g<diskgroup_name>] stop <rvg_name>

This command disables Input/Output access to the associated data
volumes.
4

If you used VEA to stop replication on the primary site, then you do not need
to perform this step on the secondary site. However, if you used the
command line to detach RLINK while preparing the primary site, then you
should perform this action on the secondary site as well.
From the command line, type
vxrlink [-g<diskgroup>] det<rlink_name>

This command detaches an RLINK from the secondary RVG.
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5

Disassociate the Replicator Log from the RVG.
■

From the VEA console, right-click the Replicator Log and select the
Dissociate Replicator Log option.
This option is available for selection only if the Replicator Log is
associated with an RVG.
Or

■

From the command line, type

vxrvg [-f] [-g<diskgroup>] [-r<rvg_name>]dis<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.

Preparing a non-clustered VVR environment for upgrade
from SFW 5.0.x
VVR 5.0.x and VVR 5.1 are interoperable; hence an upgrade can be performed on
the secondary site while applications are kept running on the primary site.
The overall sequence is as follows:
■

Upgrade the existing secondary site to SFW 5.1. No preparation is needed on
the secondary site for a non-clustered VVR environment before performing
the upgrade.
See “Upgrading to SFW 5.1” on page 84.

■

Prepare the existing primary site for the upgrade using the procedure in this
section. The preparation includes migrating the primary role so that the
existing primary site becomes the secondary site.

■

Upgrade the old primary (now in the secondary role) to SFW 5.1

■

If desired, migrate the primary role back to the original primary site.
See “Post-upgrade task for a non-clustered VVR environment after
upgrading from 5.0.x” on page 93.

The following procedure assumes you have upgraded the secondary site to SFW
5.1. Now you must prepare the primary site for the upgrade.
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To prepare the primary site
1

On the primary site, stop the application that uses VVR to replicate data
between the sites.

2

From the command line, type:
vxprint -lVP [-g <diskgroup_name>]

This command lists the RLINK and RVG records.
3

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary site:
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary site
represented by the specified RLINK.
Verify that the data volumes on the secondary site are consistent and up-todate with the primary site before proceeding to the next step.
4

Migrate the primary RVG.
■

From the Veritas Enterprise Administrator (VEA) console, right-click
the primary RVG and select the Migrate option. Select the required
secondary host from the Secondary Name option list.
Click OK to migrate the primary role to the secondary. The primary and
secondary roles will be interchanged.
Or

■

From the command line, type
vxrds [-g <diskgroup_name>] migrate <local_rvg>
<new_primary_hostname>
where the secondary host is specified by the <new_primary_hostname>

parameter.
5

Perform any necessary steps to start the applications on the new primary
(old secondary).

6

If the existing replication settings are configured to use TCP, change the
settings to use UDP. After both the primary and DR sites are upgraded to 5.1,
you can switch the replication settings back to TCP.
You can now upgrade the nodes on the old primary site (now the secondary
site) to SFW 5.1.
See “Upgrading to SFW 5.1” on page 84.
After the upgrade you can switch the primary role back to the original
primary site.
See “Post-upgrade task for a non-clustered VVR environment after
upgrading from 5.0.x” on page 93
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Preparing a Microsoft clustered VVR environment for
upgrade from SFW 4.3.x
Use the following procedures to prepare VVR in an MSCS environment on
Windows Server 2003 before upgrading from SFW 4.3.x to SFW 5.1. Follow the
procedures in the given order while upgrading.
Refer to the Veritas Storage Foundation Volume Replicator, Administrator’s
Guide for details on VVR.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
To prepare the primary site in an MSCS environment
1

Offline the Application resource on the primary site.
■

From the Cluster Administrator console, right-click the Application
resource and select the Offline option.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

2

Take the RVG resource offline.
■

From the Cluster Administrator console, right-click the RVG resource
and select the Offline option.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

3

From the command prompt, type
vxprint -lVP [-g <diskgroup_name>]

This command lists the RLINK and RVG records.
4

Verify that the data in the Replicator Log is written to the secondary site by
running the following command on the primary:
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK. Verify that the data volumes on the secondary site
are consistent and up-to-date with the primary before proceeding to the
next step.
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5

Detach the RLINK to prevent VVR from replicating data to the secondary
site.
■

From the Veritas Enterprise Administrator (VEA) console, right-click
the secondary RVG and select the Stop Replication option to stop VVR
from replicating to the secondary site.
The Stop Replication option is available only on selecting the
secondary RVG. When this operation is performed the connection
between the primary and secondary RVG is broken.
Or

■

From the command prompt, type
vxrlink [-g <diskgroup>] det <rlink_name>

This command detaches the RLINK from the RVG.
6

Dissociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option.
Or

■

From the command prompt, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG.
If the -f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
7

Take the Disk Group resource offline on the primary site.
■

From the Cluster Administrator console, right-click the Disk Group
resource and select the Offline option.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

Repeat the above step to offline the IP resource and then the Network
Name resource.
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To prepare the secondary site in an MSCS environment
1

Take the RVG resource offline.
■

From the Cluster Administrator console, right-click the RVG resource
and select the Offline option.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

2

To get the list of RVG and RLINK records from the command prompt, type

3

If you used VEA to stop replication on the primary site, then you do not need
to perform this step on the secondary site. However, if you used the
command line to detach RLINK while preparing the primary site, then you
should perform this action on the secondary site as well.
To do so from the command prompt, type

vxprint -lVP [-g<diskgroup_name>]

vxrlink {-g <diskgroup>] det <rlink_name>

4

Dissociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu that appears.
Or

■

From the command prompt, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG.
If the -f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
5

Offline the Disk Group, IP, and Network Name resources on the secondary
site.
■

From the Cluster Administrator console, right-click the Disk Group
resource and select the Offline option from the context-menu that
appears.
Or

■

From the command prompt, type
[cluster resourename] /Offline [:node name] [/Wait[:timeout
in seconds]]

Repeat the above step to offline the IP resource and then the Network Name
resource.
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Preparing a Microsoft clustered VVR environment for
upgrade from SFW 5.0.x
Since VVR 5.0.x and VVR 5.1 versions are interoperable, upgrade can be
performed on the DR (secondary) site while applications are kept running on the
primary site.
Use the following overall sequence:
■

Prepare the nodes on the secondary (DR) site to upgrade from SFW 5.0.x to
5.1.
See “Preparing the secondary (DR) site for the upgrade from SFW 5.0.x” on
page 79.

■

Upgrade the cluster nodes on the secondary site to SFW 5.1.
See “Upgrading to SFW 5.1” on page 84.

■

Re-enable VVR on the upgraded secondary site.
See “Re-enabling VVR in a Microsoft clustered environment after upgrade
from 5.0.x” on page 95

■

Prepare the nodes on the primary site for the upgrade. The preparation
includes migrating the primary role so that the existing primary site
becomes the secondary site.
See “Preparing the primary site for the upgrade from SFW 5.0.x” on
page 80.

■

Upgrade the old primary site (now the secondary site) to SFW 5.1.
See “Upgrading to SFW 5.1” on page 84.

■

Re-enable VVR on the upgraded nodes. The procedures include steps for
migrating the primary role back to the original primary site.
“Re-enabling VVR in a Microsoft clustered environment after upgrade from
5.0.x” on page 95

Preparing the secondary (DR) site for the upgrade from SFW 5.0.x
Follow the procedure to prepare the secondary site in an MSCS clustered VVR
environment to upgrade from SFW 5.0.x to SFW 5.1.
To prepare the secondary (DR) site
1

Take the RVG resource offline.
■

From the Cluster Administrator console, right-click the RVG resource
and select the Offline option
Or

■

From the command line, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]
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2

Take the Disk Group resource offline on the secondary site.
■

From the Cluster Administrator console, right-click the Disk Group
resource, and select the Offline option.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

Repeat step 2 to offline the IP resource and then the Network Name
resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
3

If the existing replication settings are configured to use TCP, change the
settings to use UDP. After both the primary and DR sites are upgraded to 5.1,
you can switch the replication settings back to TCP.
You can now upgrade all nodes on the DR site.
See “Upgrading to SFW 5.1” on page 84.
After the upgrade, you can re-enable VVR on the DR site.
See “Re-enabling VVR in a Microsoft clustered environment after upgrade
from 5.0.x” on page 95.
Then continue with the procedure to prepare the primary site for the
upgrade.

Preparing the primary site for the upgrade from SFW 5.0.x
Once the DR site has been upgraded to SFW 5.1, the primary site can be
prepared for upgrade by migrating the primary role to the DR site.
Follow the procedure to prepare the primary site in an MSCS clustered VVR
environment to upgrade from SFW 5.0.x to SFW 5.1.
To prepare the primary site
1

Offline the Application resource on the primary site.
■

From the Cluster Administrator console, right-click the Application
resource and select the Offline option.
Or

■

From the command line, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]
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2

From the command line, type
vxprint -lVP [-g <diskgroup_name>]

This command lists the RLINK and RVG records.
3

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary:
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK.
Verify that the data volumes on the secondary site are consistent and up-todate with the primary before proceeding to the next step.
4

Migrate the primary RVG.
■

From the Veritas Enterprise Administrator (VEA) console, right-click
the primary RVG and select the Migrate option. Select the required
secondary host from the Secondary Name option list.
Click OK to migrate the primary role to the secondary. The primary and
secondary roles will be interchanged.
Or

■

From the command line, type
vxrds [-g <diskgroup_name>] migrate <local_rvg>
<new_primary_hostname>
where the secondary host is specified by the <new_primary_hostname>

parameter.
5

Bring online the Application resource on the new primary.
■

From the Cluster Administrator console, right-click the Application
resource and select the Online option.
Or

■

From the command line, type
[cluster resourcename] /Online [:node name] [/Wait[:timeout
in seconds]]

6

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on the options
available in your environment, these tasks may include mounting the
databases or manually starting the application.

7

On the old primary site, which now has the secondary role, perform the
steps described in “Preparing the secondary (DR) site for the upgrade from
SFW 5.0.x” on page 79.
You can then upgrade the old primary site to SFW 5.1.
See “Upgrading to SFW 5.1” on page 84.
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After the upgrade on the old primary site, you can re-enable VVR on the
site. If desired you can then migrate the primary role back to the old
primary site.
See “Re-enabling VVR in a Microsoft clustered environment after upgrade
from 5.0.x” on page 95.

Preparing to add DMP DSMs to the upgraded environment
If you do not have DMP DSMs in your existing environment, but plan to add this
feature while upgrading to SFW 5.1, add the host adapter hardware before
performing the upgrade.
Refer to the Hardware Compliance List on the Symantec Support web site at
http://www.symantec.com/business/support/index.jsp to determine the
approved hardware for SFW.
For more information on the hardware and software prerequisites for DMP DSM
installation, see the following:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on page 61.

■

Veritas Storage Foundation Administrator’s Guide.

In a Microsoft cluster environment, you prepare the inactive node for the
upgrade. See “Upgrading in a Microsoft cluster environment” on page 99.
Connect no more than one path from the new host adapters to the array storage
before upgrading to SFW and installing DMP DSMs. Select the DMP DSM option
or the appropriate DMP DSMs while running the installer.

Preparing an existing DMP environment for upgrading
Previous DMP environments are either DMP DSM or DMP ASL. The
preparations for upgrade are different for each.
In a Microsoft cluster environment, you prepare DMP on the inactive node for
the upgrade. See “Upgrading in a Microsoft cluster environment” on page 99.

DMP DSM environment
If you are preparing to upgrade an existing DMP DSM environment, it is
recommended to physically disconnect all but one path of the multipath storage
to shorten upgrade time.
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No other DMP preparation is required except as follows.
In upgrading from 4.3.x, in the following cases only, you must uninstall DMP
DSM before the upgrade (and reinstall it during the upgrade):
■

SFW 4.3 with DMP option installed and no SFW 4.3 DDI-x has ever been
applied

■

SFW 4.3 DMP with DDI-1, DDI-3 or DDI-4 installed

Before uninstalling DMP DSM from a node in a cluster environment, the cluster
resources should be moved to another node.
To uninstall the DMP or the DDI package
1

Make sure that only one path is attached for each array managed by DMP
DSM.

2

Open the Windows Add/Remove Programs to uninstall the DDI. Select the
Symantec support for DMP DSM entry and click Remove to begin the
uninstallation.

3

Reboot the system when the uninstall process completes.

DMP ASL environment
DMP ASLs are no longer supported on SFW 5.1. Therefore, you must uninstall
DMP ASLs before the upgrade to 5.1.
It is important that you detach all but the primary path to the array storage
before you uninstall.
Warning: Failure to limit DMP ASLs to a single path before uninstalling can lead
to data corruption.

Warning: Always back up your data before upgrading.
To prepare an existing DMP ASL environment for upgrade
1

Physically remove all but the primary path from each multiple-path array.

2

In the VEA, exclude each multiple-path array from DMP ASLs management.
■

In the tree view under the Disks folder, select a disk from the storage
array that you are excluding.

■

In the right pane, click the Paths tab for the disk.

■

Right-click a path and select Array Settings from the path context
menu that appears.
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■

In the Array Settings screen, check the Exclude check box.

■

Click OK. The array is now excluded from DMP control.

3

Select Actions > Rescan from the VEA menu bar. Veritas Storage Foundation
for Windows rescans the array and updates the display.

4

Uninstall the DMP ASLs using the Add or Remove function through the
installer.
See “Adding or removing features” on page 56.

5

After the uninstall process is complete, reboot the system.

6

If you want to install DMP DSMs during the upgrade, review the following
information for more information on prerequisites for DMP DSMs:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on
page 61.

■

Veritas Storage Foundation Administrator’s Guide.

Upgrading to SFW 5.1
The installer can upgrade SFW 4.3 and SFW 5.0.x versions to SFW 5.1.

Changing driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed. When installing on systems running Windows Server 2003, you
must set the Windows driver signing options to allow installation.
The following table describes the product installer behavior on local and remote
systems when installing options with unsigned drivers.
Table 3-1

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

Upgrading to SFW 5.1
Upgrading 4.3.x or 5.0.x versions to SFW 5.1

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.

4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.

Upgrading the software
Use the product installer to upgrade the software.
To upgrade to SFW 5.1
1

Allow the autorun feature to start the installation or double-click Setup.exe.

2

Choose the default language for your installation and click OK.

3

Click Storage Foundation 5.1 for Windows.

4

Click the Complete/Custom link. The installer starts to copy files.

5

Review the Welcome window and click Next.

6

Read the License Agreement. If you agree to the license terms, click the I
accept the terms of the license agreement radio button, and click Next.

7

Enter license keys for each Symantec product option that you are upgrading
or installing:
■

Enter the license key in the top field.

■

To add a key, click Add. To remove a key, click the key to select it, and
click Remove.

■

Repeat the first two bulleted steps for each Symantec product and
feature that you want to install. Click a key to see its details.

■

Click Next.
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8

Choose the options that you want to install by selecting or clearing the
appropriate check boxes. You must select all currently installed options for
upgrade. Click Next.
Displayed at the bottom of the screen is the total hard disk space required
for the installation. When you add or remove an option, the total space
changes.

9

Select the domain and the computers for the upgrade and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.

Install Path

The install path cannot be changed for the upgrade.
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10 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next. Note that the
Install Type for the nodes is listed as Upgrade. If an error occurs, address the
problem described in the Details box, click Validate Again, and click Next.
11 If applicable, at the Veritas Dynamic Multi-pathing warning, do the
following for DMP DSM installations:
The time required to install the Veritas Dynamic Multi-pathing DSMs
feature depends on the number of physical paths connected during the
installation. To reduce installation time for this feature, connect only
one physical path during installation. After installation, reconnect
additional physical paths before rebooting the system.
Click OK.
■

12 Review the pre-upgrade summary and click Install. Click Back to make
necessary changes.
13 If the installation is successful on all computers, the installer automatically
proceeds to the summary page described in step 14.
If an installation fails, click Next to review the report and address the
reason for failure. You may have to either repair the installation or
uninstall and re-install. If a security alert asks you to accept the Symantec
driver software, click Yes.
14 A report summarizing the upgrade appears. Review it and click Next.
15 Reboot the remote computers. Note that you cannot reboot the local
computer now, and that failed computers are unchecked by default. Perform
the following steps in order.
■

Select the upgraded remote computers.

■

Click Reboot.

■

Click Next.

16 Click Finish.
17 Click Yes to reboot the local computer.
■

If you upgraded or installed the Volume Replicator (VVR) option, you
can launch the wizard for Veritas Volume Replicator Security Service
(VxSAS) after the reboot to configure security services for all
computers. This step is required for VVR if you are upgrading from 4.3
versions. If you are upgrading from 5.0.x and VxSAS was already
configured for 5.0.x, you do not need to configure it again.
See “Configuring the VxSAS service (VVR only)” on page 88.
For details on this required service for VVR, see the Veritas Storage
Foundation Volume Replicator, Administrator’s Guide.
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■

After upgrading, reset the driver signing option to its original setting.
Failure to do this can compromise system security. If you are
performing more upgrades, do not reset the options until you have
completed the upgrade.
See “Resetting the driver signing options” on page 104.

Configuring the VxSAS service (VVR only)
Complete the following procedure to configure the VxSAS service for VVR.
The procedure has these prerequisites:
■

You must be logged on with administrative privileges on the server for the
wizard to be launched.

■

The account you specify must have administrative and log-on as service
privileges on all the specified hosts.

■

Avoid specifying blank passwords. In a Windows Server environment,
accounts with blank passwords are not supported for log-on service
privileges.

■

Make sure that the hosts on which you want to configure the VxSAS service
are accessible from the local host.

Note: The VxSAS wizard will not be launched automatically after installing SFW
or SFW HA. You must launch this wizard manually to complete the VVR security
service configuration. For details on this required service, see Veritas Storage
Foundation Veritas Volume Replicator Administrator’s Guide.
To configure the VxSAS service
1

To launch the wizard, select Start > All Programs > Symantec > Veritas
Storage Foundation > Configuration Wizards > VVR Security Service
Configuration Wizard or run vxsascfg.exe from the command prompt of
the required machine.
Read the information provided on the Welcome page and click Next.

2

Complete the Account Information panel as follows:
Account name
(domain\account)

Enter the administrative account name.

Password

Specify a password.
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If you have already configured the VxSAS service for one host that is
intended to be a part of the RDS, make sure you specify the same username
and password when configuring the VxSAS service on the other hosts.
Click Next.
3

On the Domain Selection panel, select the domain to which the hosts that
you want to configure belong:
Selecting domains

The Available domains pane lists all the domains that are
present in the Windows network neighborhood.
Move the appropriate name from the Available domains list
to the Selected domains list, either by double-clicking it or
using the arrow button.

Adding a domain

Click Next.

If the domain name that you require is not displayed, click
Add domain. This displays a dialog that allows you to
specify the domain name. Click Add to add the name to the
Selected domains list.
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4

On the Host Selection panel, select the required hosts:

Selecting hosts

The Available hosts pane lists the hosts that are present in
the specified domain.
Move the appropriate host from the Available hosts list to
the Selected hosts list, either by double-clicking it or using
the arrow button. Use the Shift key with the up or down
arrow keys to select multiple hosts.

Adding a host

If the host name you require is not displayed, click Add
host. In the Add Host dialog specify the required host name
or IP in the Host Name field. Click Add to add the name to
the Selected hosts list.

After you have selected a host name, the Configure button is enabled. Click
Configure to proceed with configuring the VxSAS service.
5

After the configuration completes, the Configuration Results page displays
whether or not the operation was successful. If the operation was not
successful, the page displays the details on why the account update failed,
along with the possible reasons for failure and recommendations on getting
over the failure.
Click Back to change any information you had provided earlier.

6

Click Finish to exit the wizard.
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Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK.

5

Repeat for each computer.

Re-enabling VVR after the upgrade
After upgrading an environment where VVR replicates data from a primary site
to a secondary site, you must re-enable VVR.
Use one of the following procedures:
■

“Re-enabling a non-clustered VVR environment after upgrading from 4.3.x”
on page 91

■

“Post-upgrade task for a non-clustered VVR environment after upgrading
from 5.0.x” on page 93

■

“Re-enabling VVR in a Microsoft clustered environment after upgrade from
4.3.x” on page 94

■

“Re-enabling VVR in a Microsoft clustered environment after upgrade from
5.0.x” on page 95

Re-enabling a non-clustered VVR environment after
upgrading from 4.3.x
After you have upgraded to SFW 5.1 from a 4.3.x version, you must re-enable
VVR. Follow the procedures in the given order.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
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To enable the updated objects
1

To associate the dissociated Replicator Log again, perform the following
actions:
■

From the VEA console on the primary site, expand the RDS. Right-click
on the RVG and select the Associate Replicator Log option. Select the
correct Replicator Log volume from the dialog box and click OK.
Or

■

From the command line, type

vxrvg [-g <diskgroup_name>] [-f] aslog <rvg_name> <volume_name>

This command associates the specified Replicator Log with the RVG.
Replication is not possible without a Replicator Log.
2

To attach the RLINK, run the following command:
vxrlink -f [-g <diskgroup_name>] att <rlink_name>

This command attaches one or more RLINKs to an RVG. If the -f option is
used, then it forcefully associates the volumes.
The RLINK must already be associated with the RVG before the attach as
shown in step 1. For the attach to succeed, ensure that the data volumes on
the secondary site are of the same name and size as on the primary site.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
3

To enable data access and prepare the volumes to receive the writes from the
application, perform one of the following actions.
■

From the VEA console, select the primary RVG and then select Enable
Data Access option from the right-click menu.
Or

■

From the command line, type
vxrvg [-g <diskgroup_name>] start <rvg_name>

This command enables Input/Output access to the specified data
volumes.
4

Repeat step 1 through step 3 on the secondary site.

5

If needed, perform any necessary tasks to start the replication. Depending
on options available in your environment, these tasks may include
mounting databases or manually starting the application.
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Post-upgrade task for a non-clustered VVR
environment after upgrading from 5.0.x
In the procedure for preparing the primary site for upgrade from SFW 5.0.x to
5.1, you migrated the primary role to the secondary site.
After both the primary and secondary sites have been upgraded to SFW 5.1, you
may want to migrate the role of the primary back to the original primary site. To
do this, you perform a Migrate operation again as described in the following
procedure.
To migrate the applications back to the original primary
1

On the current primary site, stop the application that uses VVR to replicate
data between the sites

2

From the command line, type
vxprint -lVP [-g <diskgroup_name>]

This command lists the RLINK and RVG records.
3

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK.
Verify that the data volumes on the secondary site are consistent and up-todate with the primary before proceeding to the next step.
4

To migrate the primary RVG
■

From the VEA, right-click the primary RVG and select the Migrate
option. Select the required secondary host from the Secondary Name
option list.
Click OK to migrate the primary role to the secondary.
The primary and secondary roles will be interchanged.
Or

■

From the command line, type
vxrds [-g <diskgroup_name>] migrate <local_rvg>
<new_primary_hostname>
where the secondary host is specified by the <new_primary_hostname>

parameter.
5

Perform any necessary steps to start the applications on the new primary
(old secondary).
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Re-enabling VVR in a Microsoft clustered environment
after upgrade from 4.3.x
After performing an upgrade from SFW 4.3.x to SFW 5.1, re-enable VVR in the
Microsoft cluster. Use the following procedures in order when re-enabling VVR
after upgrading from 4.3.x.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.

Note: Refer to the appropriate Microsoft documentation for details on how to
offline and online resources through the command line interface.
To enable the updated objects (Windows Server 2003)
1

Bring online the Disk Group, IP, and Network Name resources in the MSCS
resource group.
■

From the Cluster Administrator console, right-click the Disk Group
resource and select the Online option.
Or

■

From the command line, type
[cluster resourcename] /Online [:node name] [/Wait[:timeout
in seconds]]

Repeat the above step to bring online the IP resource and then the
Network Name resource.
2

Associate the dissociated Replicator Log volume to the RVG again.
■

From the VEA, right-click the Replicator Log volume and select the
Associate Replicator Log option.
Or

■

From the command line, type
vxrvg [-g <diskgroup_name>] [-f] aslog <rvg_name>
<volume_name>

3

To attach the RLINK, run the following command:
vxrlink -f [-g <diskgroup_name>] att <RLINK_name>

This command associates the specified Replicator Log to the RVG.
4

Repeat step 1 through step 3 on both the primary and secondary sites.
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5

Bring online the RVG resource.
■

From the Cluster Administrator console, right-click the RVG resource
and select the Online option on both the primary and secondary.
Or

■

From the command line, type
[cluster resourcename] /Online [:node name] [/Wait[:timeout
in seconds]]

Run this command on both the primary and secondary sites.
6

Bring online the Application resource on the primary.
■

From the Cluster Administrator console, right-click the Application
resource and select the Online option.
Or

■

From the command line, type
[cluster resourcename] /Online [:node name] [/Wait[:timeout
in seconds]]

7

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on options in your
environment, these tasks may include mounting databases or manually
starting the application.

Note: For VVR environments with multiple secondary sites, any operations that
need to be performed on a secondary site must be repeated on all secondary
sites.

Re-enabling VVR in a Microsoft clustered environment
after upgrade from 5.0.x
After performing an upgrade from SFW 5.0.x to SFW 5.1, re-enable VVR in the
Microsoft cluster. Follow the procedures in order when re-enabling VVR after
upgrading from 5.0.x.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.

Note: Refer to the appropriate Microsoft documentation for details on how to
offline and online resources through the command line interface.
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To enable the updated objects on the secondary (DR) site (Windows Server
2003)
1

Bring online the Disk Group, IP, and Network Name resource in the MSCS
resource group.
■

From the Cluster Administrator console, right-click the Disk Group
resource and select the Online option.
Or

■

From the command line type,
[cluster resourcename] /online [:node name] [/wait[:timeout
in seconds]]

Repeat the above step to bring online the IP resource and then the
Network Name resource.
2

Bring online the RVG resource
■

From the Cluster Administrator console, right-click the RVG resource
and select the Online option on the secondary.
Or

■

From the command line, type
[cluster resourcename] /online [:node name] [/wait[:timeout
in seconds]]

Note: For VVR environments with multiple secondary sites, any operations
that need to be performed on a secondary site should be repeated on all
secondary sites.
If you are performing this procedure on the original secondary site, you
now continue with the procedure to prepare the primary site.
See “Preparing the primary site for the upgrade from SFW 5.0.x” on
page 80.
Otherwise, if you completed the upgrades on both primary and secondary
sites, you can now migrate the primary role back to the original primary.
See “Migrating the applications back to the original primary.”

Migrating the applications back to the original primary
After both the primary and secondary sites have been upgraded to SFW 5.1, you
may want to migrate the primary role back to the original primary site.
To do this, you perform a Migrate operation again as described in the following
procedure.
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To migrate the applications back to the original primary
1

Offline the Application resource on the current primary site
■

From the Cluster Administrator console, right-click the Application
resource and click Offline.
Or

■

From the command prompt, type
[cluster resourcename] /Offline [:node name] [/Wait[:timeout
in seconds]]

2

From the command prompt, type
vxprint -lVP [-g <diskgroup_name>]

This command lists the RLINK and RVG records.
3

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary:
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK.
Verify that the data volumes on the secondary site are consistent and up-todate with the primary before proceeding to the next step.
4

To migrate the primary RVG
■

From the VEA, right-click the primary RVG and click Migrate. Select
the required secondary host from the Secondary Name option list.
Click OK to migrate the primary role to the secondary. The primary and
secondary roles will be interchanged.
Or

■

From the command line, type
vxrds [-g <diskgroup_name>] migrate <local_rvg>
<new_primary_hostname>
where the secondary host is specified by the <new_primary_hostname>

parameter.
5

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on the options
available in your environment, these tasks may include mounting databases
or manually starting the application.
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Reconnecting DMP DSM paths after the upgrade
After you complete the upgrade for an existing DMP DSM environment, or if you
have added DMP DSMs during the upgrade:
1

Physically connect any additional paths that were disconnected before the
upgrade.

2

In the VEA, rescan the disks.

Upgrading dynamic disk groups
If your previous installation included Volume Manager 4.x, upgrade the disk
group types to make use of the current program features.
See the Veritas Storage Foundation 5.1 Administrator’s Guide.
Note: If you upgrade a disk group to SFW 5.1, you cannot import it to another
server that is running an earlier version of Volume Manager or Disk
Management. After upgrading a disk group, the group cannot revert to an
earlier version.
To upgrade a dynamic disk group version
1

In the tree view, right-click the disk group you want to upgrade and select
Upgrade Dynamic Disk Group Version.

2

Click Yes to upgrade the dynamic disk group.
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Upgrading in a Microsoft cluster environment
In a Microsoft cluster (MSCS) environment, you can upgrade from SFW 4.3 to
SFW 5.1. This section applies to all of these upgrades.
When you upgrade from SFW 4.3, SFW 4.3 MP1, SFW 4.3 MP2, or SFW 5.0.x with
a Microsoft cluster (MSCS) to SFW 5.1, SFW requires a reboot. Rebooting an
active cluster node causes it to fail over. To avoid this, you upgrade first on an
inactive cluster node, switch the active cluster node to a second node, and then
upgrade the first node.
If DMP is installed and configured in your existing configuration, you have
additional steps to take before and after the upgrade to SFW 5.1.
See “Preparing an existing DMP environment for upgrading” on page 82.
If VVR is installed and configured in your existing configuration, you need to
prepare VVR on the active cluster node first. Then, you can continue with the
upgrade steps on the inactive node.
See “Preparing a VVR environment for upgrading” on page 71.
After the upgrade is complete on all nodes of the cluster, you then re-enable
VVR on the active cluster node.
In the following procedure, the two nodes in the cluster are Node A and Node B.
Initially, Node A is the inactive cluster node and Node B is the active cluster
node. After completing the following upgrade steps, Node A becomes the active
cluster node. You can use the Cluster Administrator (Windows 2003) console to
make Node B the active cluster node after finishing the upgrade.
To upgrade from SFW 4.3.x or SFW 5.0.x to SFW 5.1 in a Microsoft cluster
configuration
1

If VVR is installed and configured, make sure that you have prepared VVR
for the upgrade by following specific procedures on the active cluster node.
See “Preparing a VVR environment for upgrading” on page 71.
Note: The procedures to prepare VVR for the upgrade must be carried out
on the active node of the cluster and are done only once; they are not
repeated when you switch the active cluster node.

2

For Node A (the inactive node), prepare DMP if you have DMP installed.
See “Preparing an existing DMP environment for upgrading on Node A” on
page 101.

3

For Node A, upgrade to SFW 5.1.
See “Upgrading to SFW 5.1 on Node A” on page 101.

4

For Node A, re-enable DMP if you have DMP installed.
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See “Re-enabling DMP after the upgrade on Node A” on page 104.
5

Move the active node.
See “Making Node A the active node” on page 105.

6

For Node B, prepare DMP if you have DMP installed.
See “Preparing an existing DMP environment for upgrading on Node B” on
page 105.

7

For Node B, upgrade to SFW 5.1.
See “Upgrading SFW 5.1 on Node B (Node A active)” on page 105.

8

For Node B, re-enable DMP if you have DMP installed.
See “Re-enabling DMP after the upgrade on Node B” on page 105.

9

Upgrade the dynamic disk groups if necessary.
See “Upgrading dynamic disk groups (Node A active)” on page 105.

10 In a VVR configuration, once the upgrade is complete on all cluster nodes,
re-enable VVR on the active node.
See “Re-enabling VVR after upgrading all nodes” on page 106.

Preparing a VVR environment for the upgrade
If VVR is installed and configured, make sure that you have prepared VVR for
the upgrade by following specific procedures on the active cluster node.
See “Preparing a VVR environment for upgrading” on page 71.
Note: The procedures to prepare VVR for the upgrade must be carried out on the
active node of the cluster and are done only once; they are not repeated when
you switch the active cluster node. You re-enable VVR only after you have
completed the upgrade on all the cluster nodes.
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Preparing an existing DMP environment for upgrading
on Node A
Make sure the active node of the cluster is Node B before starting this process.
See “Preparing an existing DMP environment for upgrading” on page 82.

Upgrading to SFW 5.1 on Node A
Before you begin the upgrade do the following:
■

Make sure the active node of the cluster is Node B.

■

Set the Windows driver signing options to ignore warning messages.

Changing driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed. When installing on systems running Windows Server 2003, you
must set the Windows driver signing options to allow installation.
The following table describes the product installer behavior on local and remote
systems when installing options with unsigned drivers.
Table 3-2

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.
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4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.

Installing the software
Use the product installer to install the software.
To install SFW 5.1 on Node A
1

Navigate to the root directory of the CD and double-click Setup.exe.

2

Click Storage Foundation 5.1 for Windows.

3

Click Complete/Custom to upgrade the server components and optional
client components.

4

On the Welcome page, click Next.

5

If you accept the terms of the license, click Next.

6

Enter a license key and click Add. To delete a key from the license key list,
select it and click Remove.

7

Make sure that you have a Symantec license for each product that you are
upgrading. Select a key in the key list to view details about the specified
license.

8

Click Next.

9

Select the Microsoft clustering (MSCS) option and other appropriate options
(for example, DMP). Click Next.

10 Select the option to install client components and click Next.
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11 Select the domain and the computers for the upgrade and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.

Install Path

The install path cannot be changed for the upgrade.

12 After the installer validates the systems for the installation, click Next.
If an error occurs, address the problem described in the Details box, click
Validate Again, and click Next.
13 Click OK to ensure optimal arbitration time settings for the dynamic
quorum.
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The minimum and maximum time settings define the period that MSCS
allows for quorum arbitration. Quorum arbitration is the process that
occurs when the controlling node of the cluster is no longer active and other
nodes of the cluster attempt to gain control of the quorum resource and the
cluster.
14 Review the summary information and click Install. If necessary, click Back
to make any necessary changes.
15 The progress meter indicates the status of the installation. If a security alert
asks you to accept the Symantec driver software, click Yes.
If the installation is successful on the system, the install report screen
appears.
If an installation is not successful on any one of the systems, the status
screen shows that the installation failed. Click Next to view the install
report.
16 Review the report and click Next.
17 Click Finish.
18 Reboot the local node.
After upgrading, reset the driver signing option to its original setting if you
are running Windows Server 2003. Failure to do this can compromise
system security. If you are performing more upgrades, do not reset the
options until you have completed the upgrade.

Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK.

5

Repeat for each computer.

Re-enabling DMP after the upgrade on Node A
Make sure the active node of the cluster is Node B before starting this task.
See “Reconnecting DMP DSM paths after the upgrade” on page 98.
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Making Node A the active node
Do the following steps to make node A the active node.
To make Node A the active node
1

From the Cluster Administrator (Windows 2003) console, navigate to the
Cluster Group.

2

Right-click the Cluster Group and click Move Group.
This procedure moves the resources and the Resource Owner changes to
Node A.

Preparing an existing DMP environment for upgrading
on Node B
Make sure the active node of the cluster is Node A before starting this task.
See “Preparing an existing DMP environment for upgrading” on page 82.

Upgrading SFW 5.1 on Node B (Node A active)
Make sure the active node of the cluster is Node A before starting this task.
To upgrade SFW 5.1 on Node B, refer to the guidelines for Node A.
See “Upgrading to SFW 5.1 on Node A” on page 101.

Re-enabling DMP after the upgrade on Node B
Make sure the active node of the cluster is Node A before starting this task.
See “Reconnecting DMP DSM paths after the upgrade” on page 98.

Upgrading dynamic disk groups (Node A active)
Make sure the active node of the cluster is Node A before starting this task.
If your previous installation included Volume Manager 4.x or higher, upgrade
the disk group types to make use of the current program features. The steps
must be done on the active node.
See the Veritas Storage Foundation Administrator’s Guide.
Note: If you upgrade a disk group to SFW, you cannot import it to another server
that is running an earlier version of Volume Manager or Disk Management.
After upgrading a disk group, the group cannot revert to an earlier version.
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To upgrade a dynamic disk group version
1

In the tree view of SFW 5.1 of the active node, right-click the disk group you
want to upgrade and select Upgrade Dynamic Disk Group Version.

2

Click Yes to upgrade the dynamic disk group.

Re-enabling VVR after upgrading all nodes
In a VVR environment, once you have completed installing the SFW upgrade on
all cluster nodes, you re-enable VVR on the active cluster node.
See the following procedures, depending on your environment:
■

“Re-enabling VVR in a Microsoft clustered environment after upgrade from
4.3.x” on page 94

■

“Re-enabling VVR in a Microsoft clustered environment after upgrade from
5.0.x” on page 95

Chapter

4

Upgrading to SFW HA 5.1
This chapter covers upgrading previous versions of SFW HA to Veritas Storage
Foundation HA 5.1 for Windows (SFW HA 5.1).
This chapter contains the following topics:
■

Before upgrading to SFW HA 5.1

■

Upgrading from 4.3.x or 5.0.x versions

Before upgrading to SFW HA 5.1
Before upgrading, you need to make sure that your systems meet the supported
minimum product versions. You must also do some preparation for the upgrade.
Warning: Rules created using the SFW 4.x Rule Manager will not automatically
be upgraded and will not work in SFW 5.1. See http://entsupport.symantec.com/
docs/303042 for more information.
Information on upgrading SFW HA in Microsoft Exchange, Microsoft SQL
Server, and Oracle environments is described in the following chapters:
■

Chapter 5, “Upgrading an Exchange Server cluster” on page 135

■

Chapter 6, “Upgrading a SQL Server cluster” on page 167

■

Chapter 8, “Upgrading an Oracle cluster” on page 209
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Checking the supported minimum product versions
To upgrade to SFW HA 5.1, your system must have version 4.3.0 or higher of
SFW or SFW HA already installed. The previously installed products need to
meet minimum supported product versions, which the product installer checks
before it upgrades.
If your current installation does not meet the minimum level required by the
installer, Symantec recommends manually applying the appropriate product
upgrades to meet the minimum product level required before proceeding with
the installer. You can get intermediate versions of the products on the Symantec
Support site. For license keys, contact Symantec Sales. You can also uninstall
the older versions of the product and install the new product.

Preparing for the upgrade
When upgrading the product, perform the following tasks:
■

Back up all your data in a safe location.

■

Back up the system state.

■

Check the hardware requirements for the software upgrade.

■

Back up all PrintShare registry keys before upgrading from SFW HA 4.3.x or
5.0.x to SFW HA 5.1. PrintShare is changed in SFW HA 5.1 in that there no
longer is a REGREP resource.

■

Check to see if you need to update the Microsoft Active Directory to support
the upgraded software. For example, upgrading from Microsoft Exchange
2000 to Exchange 2003 requires updating the Active Directory.

■

Test the system after each upgrade, especially after applying product
upgrades to meet the minimum version required. An incremental upgrade
eases the troubleshooting process.

Additional upgrade information for VCS customers
While upgrading a configuration, the product installer performs the following
tasks:
■

Replaces the attribute types and names in the VCS 4.x configuration with
those compatible with a SFW HA 5.1 configuration. For example, the
Exchange application agent attribute E2kService is upgraded to
ExchService.

■

Maps default attribute values in a VCS 4.x configuration to the default
attribute values in a VCS 5.1 configuration.
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■

Deletes attributes that are no longer required by SFW HA 5.1. For example,
the wizard removes the AgentDebug attribute.

■

Updates user passwords. Using a different encryption mechanism, SFW HA
5.1 decrypts the passwords and re-encrypts them using the VCS 5.1
encryption mechanism.

Upgrading from 4.3.x or 5.0.x versions
This section describes upgrading from SFW or SFW HA 4.3, 4.3 MP1, 4.3 MP2,
5.0, or 5.0 RP1 to SFW HA 5.1.
The required procedures depend on your environment. For example, if you have
installed and configured VVR or DMP, you must take additional steps before and
after the upgrade to SFW 5.1.
See the following procedures:
■

“Preparing VVR in a VCS environment for upgrading” on page 110

■

“Preparing to add DMP DSMs to the upgraded environment” on page 115 or
“Preparing an existing DMP environment for upgrading” on page 116

■

“Preparing to upgrade to SFW HA 5.1” on page 118

■

“Upgrading to SFW HA 5.1” on page 120

■

“Optional tasks after a VCS upgrade” on page 125

■

“Re-enabling VVR after the upgrade” on page 129

■

“Reconnecting DMP DSM paths after the upgrade” on page 132

■

“Bringing the print share service group online after the upgrade” on
page 132

■

“Upgrading dynamic disk groups” on page 133
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Preparing VVR in a VCS environment for upgrading
If you use VVR in a VCS environment to replicate data from a primary site to a
secondary site, follow the procedures below:
■

“Preparing VVR for upgrade from 4.3.x versions to 5.1”

■

“Preparing VVR for upgrade from 5.0.x versions to 5.1” on page 113

Preparing VVR for upgrade from 4.3.x versions to 5.1
Follow the procedures in the given order while upgrading from 4.3.x versions to
5.1.
Warning: A full autosynchronization is required if the procedures listed below
are not performed in the given order.
To prepare the primary site
1

Take the application service group offline on the primary site.
■

From the Cluster Manager (Java Console), right-click the application
service group and select the Offline menu option.

or
■

From the command line, type
hagrp -offline <group_name> -sys <system_name>

2

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

3

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g <diskgroup_name>]

4

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary site.
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK. This command can be run only on the primary site.
Verify that the data volumes on the secondary are consistent and up-todate with the primary before proceeding to the next step.
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5

Detach the RLINK to prevent VVR from replicating data to the secondary
site.
■

From the VEA console, right-click the secondary RVG and select the
Stop Replication option to stop VVR from replicating to the secondary
site.
The Stop Replication option is available only when selecting the
secondary RVG. When this operation is performed the connection
between the primary and secondary RVG is broken.

or
■

From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>

This command detaches the RLINK from the RVG.
6

Dissociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu.

or
■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
7

Bring the Disk Group and IP resources offline in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the menu.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
To prepare the secondary site
1

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>
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2

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g<diskgroup_name>])

3

If you used the VEA console to stop replication on the primary site, then you
need not perform this step on the secondary site. However, if you used the
command line to detach the RLINK while preparing the primary site, then
you must perform this action on the secondary site as well.
From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>]

This command detaches an RLINK from the secondary RVG.
4

Dissociate the Replicator Log volume from the RVG.
From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu that appears.
This option is available for selection only if the Replicator Log is associated
with an RVG.
or
■

■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
5

Offline the Disk Group and IP resources in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the context-menu that appears.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
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Preparing VVR for upgrade from 5.0.x versions to 5.1
Since VVR 5.0.x and VVR 5.1 versions are interoperable, you can keep the
applications running on the primary site while upgrading the secondary site.
The recommended sequence is as follows:
■

Prepare VVR on the secondary (DR) site to upgrade from SFW HA 5.0.x to
5.1.
See the procedure below:
“Preparing VVR on the secondary (DR) site for upgrade.”

■

Prepare the VCS cluster on the secondary site for upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 118.

■

Upgrade the cluster nodes on the secondary site to SFW HA 5.1.
See “Upgrading to SFW HA 5.1” on page 120.

■

Re-enable VVR on the upgraded secondary site.
See “Re-enabling VVR after the upgrade” on page 129.

■

Once the secondary (DR) site has been upgraded, prepare the primary site
for upgrade. The procedure includes migrating the primary role to the DR
site.
See “Preparing the primary site for upgrade” on page 114.

■

Prepare the VCS cluster on the old primary site (now the secondary site) for
upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 118.

■

Upgrade the nodes on the old primary site to SFW HA 5.1.
See “Upgrading to SFW HA 5.1” on page 120.

■

Re-enable VVR on the upgraded site. The topic includes a procedure for
migrating the applications back to the original primary site.
See “Re-enabling VVR after the upgrade” on page 129.

Preparing VVR on the secondary (DR) site for upgrade
When preparing VVR for upgrade from SFW HA 5.0.x to 5.1, you begin by
preparing the secondary site.
To prepare the secondary (DR) site
1

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>
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2

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
3

If the existing replication settings are configured to use TCP, change the
settings to use UDP. After both the primary and DR sites are upgraded to 5.1,
you can switch the replication settings back to TCP.
After you have completed these secondary site preparation steps, continue
with the following procedures in sequence:
■

Preparing the VCS cluster on the secondary site for upgrade.

■

Upgrading the secondary site nodes to SFW HA 5.1

■

Re-enabling VVR on the secondary site

■

Preparing the primary site for upgrade

Preparing the primary site for upgrade
After upgrading the DR site to SFW HA 5.1 and re-enabling VVR on that site, you
prepare the primary site for upgrade. The procedure steps first use the remote
switch operation to migrate the applications to the current secondary site, thus
switching the roles so that the primary site becomes the secondary. You then
prepare VVR for upgrade.
To prepare the primary site
1

In the Service Groups tab of the Cluster Manager, right-click the application
service group that is online at the primary site.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box, click the cluster of the secondary
siteto switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.

5

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on the options
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available in your environment, these tasks may include mounting the
databases or manually starting the application.
Once the applications are online, the sites have now switched roles, so that
the former secondary site is now the primary site, and the old primary has
the role of the secondary.
Therefore, on the old primary (now the secondary) complete the following
steps, which are the same as when preparing the original secondary site for
the upgrade.
6

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

7

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
You can then continue with the following procedures in sequence:
■

Preparing the cluster for upgrade

■

Upgrading the cluster nodes to SFW HA 5.1

■

Re-enabling VVR

■

Migrating the applications back to the original primary site

Preparing to add DMP DSMs to the upgraded environment
If you do not have DMP DSMs in your existing environment, but plan to add this
feature while upgrading to SFW 5.1, add the host adapter hardware before
performing the upgrade.
Refer to the Hardware Compliance List on the Symantec Support web site at
http://www.symantec.com/business/support/index.jsp to determine the
approved hardware for SFW.
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For more information on the hardware and software prerequisites for DMP DSM
installation, see the following:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on page 61.

■

Veritas Storage Foundation Administrator’s Guide.

Connect no more than one path from the new host adapters to the array storage
before upgrading to SFW and installing DMP DSMs. Select the DMP DSM option
or the appropriate DMP DSMs while running the installer.

Preparing an existing DMP environment for upgrading
Previous DMP environments are either DMP DSM or DMP ASL. The
preparations for upgrade are different for each.

DMP DSM environment
If you are preparing to upgrade an existing DMP DSM environment, it is
recommended to physically disconnect all but one path of the multipath storage
to shorten upgrade time.
No other DMP preparation is required except as follows.
In upgrading from 4.3.x, in the following cases only, you must uninstall DMP
DSM before the upgrade (and reinstall it during the upgrade):
■

SFW 4.3 with DMP option installed and no SFW 4.3 DDI-x has ever been
applied

■

SFW 4.3 DMP with DDI-1, DDI-3 or DDI-4 installed

Before uninstalling DMP DSM from a node in a cluster environment, the cluster
resources should be moved to another node.
To uninstall the DMP or the DDI package
1

Make sure that only one path is attached for each array managed by DMP
DSM.

2

Open the Windows Add/Remove Programs to uninstall the DDI. Select the
Symantec support for DMP DSM entry and click Remove to begin the
uninstallation.

3

Reboot the system when the uninstall process completes.
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DMP ASL environment
DMP ASLs are no longer supported on SFW 5.1. Therefore, you must uninstall
DMP ASLs before the upgrade to 5.1.
It is important that you detach all but the primary path to the array storage
before you uninstall.
Warning: Failure to limit DMP ASLs to a single path before uninstalling can lead
to data corruption.

Warning: Always back up your data before upgrading.
To prepare an existing DMP ASL environment for upgrade
1

Physically remove all but the primary path from each multiple-path array.

2

In the VEA, exclude each multiple-path array from DMP ASLs management.
■

In the tree view under the Disks folder, select a disk from the storage
array that you are excluding.

■

In the right pane, click the Paths tab for the disk.

■

Right-click a path and select Array Settings from the path context
menu that appears.

■

In the Array Settings screen, check the Exclude check box.

■

Click OK. The array is now excluded from DMP control.

3

Select Actions > Rescan from the VEA menu bar. Veritas Storage Foundation
for Windows rescans the array and updates the display.

4

Uninstall the DMP ASLs using the Add or Remove function through the
installer.
See “Adding or removing features” on page 56.

5

After the uninstall process is complete, reboot the system.

6

If you want to install DMP DSMs during the upgrade, review the following
information for more information on prerequisites for DMP DSMs:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on
page 61.

■

Veritas Storage Foundation Administrator’s Guide.
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Preparing to upgrade to SFW HA 5.1
Complete the following procedures to prepare the VCS cluster before the
upgrade.

Removing VCS Management Console
If one or more nodes in the cluster have Veritas Cluster Server Management
Console 5.1 installed, you must remove the management console before
upgrading SFW HA. You can reinstall the management console after the
upgrade.
See “Reinstalling VCS Management Console 5.1” on page 125.
To remove VCS Management Console 5.1
1

Stop the VCS Management Console. If the management console is clustered,
take the CMC_MS service group offline.

2

Back up the console’s data directory and datadir.conf files. Typically, the
files are located at the following paths:
■

C:\Program Files\Symantec\VRTScmcm

or
■

3

C:\Program Files (x86)\Symantec\VRTScmcm

Remove VCS Management Console 5.1 from all nodes in the cluster using
Windows Add/Remove Programs.

Saving and closing the cluster configuration
Before starting the upgrade process, use the VCS Java Console to “save and
close” the VCS configuration. This operation involves saving the latest
configuration to disk and changing the configuration state to read-only mode.
You must also stop VCS before attempting the upgrade process. In a VVR
environment, perform these steps on both the VVR primary and secondary
clusters.
To save and close the configuration
■

From the VCS Java Console, click Save and Close Configuration on the
Cluster Explorer toolbar.
or

■

From the command prompt, type:
C:\>haconf -dump -makero
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Taking the service groups offline
Take all service groups offline before the upgrade.
To take the service groups offline
From the command prompt, type:
C:\>hagrp -offline group_name -sys system_name

where group_name is the name of the service group and system_name is the
node on which the group is online.
Repeat this command for all service groups that are online.

Closing SFW HA clients
Exit all instances of the Veritas Enterprise Administrator (VEA), Cluster
Manager (Java Console), and Cluster Management Console (Single Cluster Mode)
before the upgrade.
■

From the VEA, click File > Exit and then click Yes on the confirmation dialog
box.

■

From the Cluster Manager (Java Console), click File > Logout on the Cluster
Explorer window and then click File > Exit on the Cluster Monitor window.

■

For CMC, click Logout on the title bar of the Cluster Management Console.

Stopping VCS services
Stop the VCS services before the upgrade.
To stop VCS services
1

Stop HAD on all the cluster nodes. Type the following on the command
prompt:

C:\>hastop -all -force
2

Stop the Veritas VCSComm Startup service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop vcscomm
3

Stop the Veritas Command Server service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop cmdserver
4

Stop GAB and LLT on all the cluster nodes. Type the following on the
command prompt:

C:\>net stop gab
C:\>net stop llt
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5

Stop the Veritas Enterprise Administrator Service on all the cluster nodes.
Type the following on the command prompt:

C:\>net stop vxob
6

Stop the Windows Indexing Service:

C:\>net stop cisvc
7

If upgrading from SFW HA 5.0.x, stop the Symantec Private Branch
Exchange service, Veritas Storage Agent, Veritas GridNode, and the Veritas
Action Agent services on all the cluster nodes. Type the following
commands on the command prompt:

C:\>net
C:\>net
C:\>net
C:\>net

stop
stop
stop
stop

VRTSpbx
vxvm
vxgn
actionagent

Backing up customized type definitions
The cluster type definitions are reset to their default values after the upgrade. If
you have modified the values of type definitions in the cluster, make a backup
copy of the types.cf file before the upgrade. The types.cf file is typically
located at %VCS_HOME%\conf\config.
The variable %VCS_HOME% is the default installation directory for VCS, typically
C:\Program Files\VERITAS\Cluster Server.
After you complete the upgrade, refer to the backup copy of the types.cf file
and use the Cluster Manager (Java Console) to change the type definition default
values with the values you had originally set in the cluster.
Note: After the upgrade, do not replace the types.cf file with the backup copy.
Use the backup copy only as a reference for the customized type definition
values in the cluster.

Upgrading to SFW HA 5.1
The installer automatically upgrades SFW or SFW HA 4.3; 4.3 MP1, 4.3 MP2, 5.0
or 5.0 RP1 to SFW HA 5.1. If the cluster has VCS enterprise agents and options,
make sure to select the same enterprise agents and options while upgrading to
SFW HA 5.1. If you do not want to include the enterprise agents and options in
the upgraded cluster, uninstall the agents from the cluster before proceeding.
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Changing driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed. When installing on systems running Windows Server 2003, you
must set the Windows driver signing options to allow installation.
The following table describes the product installer behavior on local and remote
systems when installing options with unsigned drivers.
Table 4-1

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.

4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.

Upgrading the software
Use the product installer to upgrade the software.
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To upgrade the product using the installer
1

Allow the autorun feature to start the installation or double-click Setup.exe.

2

Choose the default language for your installation and click OK. The
Symantec product selection screen appears.

3

Click Storage Foundation HA 5.1 for Windows.

4

Click Complete/Custom to begin installation. The Administrative Console
link allows you to install only the Client components.

5

Review the welcome message and click Next.

6

If you agree to the terms of the license agreement, click “I accept the terms
of the license agreement”, and then click Next.

7

Enter the license key for each Symantec product option that you are
upgrading or installing in the top field.

8

To add a key, click Add.
To remove a key, click the key to select it, and click Remove.

9

Repeat step 7 and step 8 for each Symantec product and feature that you
want to install. Click a key to see its details.

10 Click Next.
11 Select the appropriate Storage Foundation HA options and click Next. If any
previous VCS agents and options are installed on the node, make sure you
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select the same agents and options while upgrading. If you do not want to
include the agents and options in the upgraded cluster, uninstall them from
the cluster before proceeding.
12 Select the domain and the computers for the upgrade and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.

Install Path

The install path cannot be changed for the upgrade.

13 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next. Note that the
Install Type for the nodes is listed as Upgrade. If an error occurs, address the
problem described in the Details box, click Validate Again, and click Next.
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14 If applicable, at the Veritas Dynamic Multi-pathing warning, do the
following for DMP DSM installations:
The time required to install the Veritas Dynamic Multi-pathing DSMs
feature depends on the number of physical paths connected during the
installation. To reduce installation time for this feature, connect only one
physical path during installation. After installation, reconnect additional
physical paths before rebooting the system.
Click OK.
15 Review the pre-upgrade summary. Click Back to make changes if necessary.
Click Install.
16 If the installation is successful on all nodes, the installer automatically
proceeds to the summary page.
Click Next after the progress indicator shows the installation is complete to
proceed to the summary report in order to review the details of the failed
installation. Note that if a security alert asks you to accept the Symantec
driver software, click Yes.
17 Review the installation report, taking action where necessary, and click
Next.
18 Reboot the remote computers. Note that you cannot reboot the local
computer now, and that failed computers are unchecked by default. Select
the upgraded remote computers and click Reboot.
Wait for the remote computer to come back online. Click Next.
19 Click Finish.
20 Click Yes to reboot the local node.

Configuring the VxSAS service (VVR only)
If you upgraded or installed the Volume Replicator (VVR) option, you can launch
the wizard for Veritas Volume Replicator Security Service (VxSAS) after the
reboot to configure security services for all nodes. This step is required for VVR
if you are upgrading from 4.3 versions.
If you are upgrading from 5.0.x versions and VxSAS was already configured for
5.0.x, you do not need to configure it again.

Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
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To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK.

5

Repeat for each computer.

Optional tasks after a VCS upgrade
The following tasks are optional depending on your cluster configuration.
■

“Reinstalling VCS Management Console 5.1” on page 125

■

“Including custom resources in the upgraded cluster” on page 126

■

“Adding a GCO resource to the ClusterService group” on page 127

■

“Establishing secure communication within the global cluster” on page 127

■

“Re-enabling VVR after the upgrade” on page 129

■

“Reconnecting DMP DSM paths after the upgrade” on page 132

■

“Bringing the print share service group online after the upgrade” on
page 132

■

“Upgrading dynamic disk groups” on page 133

Reinstalling VCS Management Console 5.1
If you uninstalled VCS Management Console earlier according to the procedures
for preparing for the upgrade, you can now reinstall it.
To re-install VCS Management Console
1

Install VCS Management Console 5.1.
Refer to the Veritas Cluster Server Management Console Implementation
Guide.

2

Restore the backed up VCS Management Console 5.1 data files.
See “Removing VCS Management Console” on page 118.

3

Start the VCS Management Console. If the management console is clustered,
bring the CMC_MS service group online.
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Including custom resources in the upgraded cluster
The VCS Configuration Wizard does not upgrade custom resources. If a service
group in the previous configuration contains custom resources, the wizard does
not include the service group in the upgraded cluster.
To include a service group with custom resources in the upgraded cluster
1

Make sure the agent binaries for the custom agent are available under
%VCS_HOME%\bin where the variable %VCS_HOME% represents the VCS
installation directory, typically C:\Program Files\Veritas\cluster
server.

2

Stop the VCS engine (HAD) on all the nodes in the cluster. From the
command prompt, type:

C:\> hastop -all -force
3

During installation of the SFW HA 5.1 software, the installer copies
previous configuration files to a backup location. Locate the backed up
types.cf and main.cf files: C:\Documents and Settings\All
Users\Application Data\Veritas\cluster server\vpibackup.

4

Copy the resource type definition for the custom resource from the backed
up types.cf and add it to the types.cf file for the VCS 5.1 cluster.

5

Copy the service group configuration containing the custom resource from
the backed up main.cf and add it to the main.cf file for the VCS 5.1 cluster.

6

If resources for a custom resource type are dependent on resources for
agents bundled with VCS 5.1, you must update the resource definition of the
VCS bundled agent to include the new attributes or remove the deprecated
attributes.
For information on new and deprecated attributes, see the Veritas Storage
Foundation and High Availability Solutions 5.1 Release Notes.
For information on the attribute values and descriptions see the Veritas
Cluster Server 5.1 Bundled Agents Reference Guide.

7

Verify the configuration. Type:
C:\> hacf -verify config_directory

The variable config_directory refers to the path of the directory
containing the main.cf and types.cf.
8

Start the VCS engine (HAD) on the node where you changed the
configuration. Type the following at the command prompt:

C:\> hastart
9

Start the VCS engine (HAD) on all the other cluster nodes.
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Adding a GCO resource to the ClusterService group
VCS 5.1 provides the Global Cluster Option to enable a collection of VCS clusters
to work together for wide-area disaster recovery. See the Veritas Cluster Server
Administrator’s Guide.

Establishing secure communication within the global cluster
A global cluster is created in non-secure mode by default. You may continue to
allow the global cluster to run in non-secure mode or choose to establish secure
communication between clusters.
The following prerequisites are required for establishing secure communication
within a global cluster:
■

The clusters within the global cluster must be running in secure mode.

■

You must have Administrator privileges for the domain.

The following information is required for adding secure communication to a
global cluster:
■

The active host name or IP address of each cluster in the global
configuration.

■

The user name and password of the administrator for each cluster in the
configuration.

■

If the local clusters do not point to the same root broker, the host name and
port address of each root broker.

Adding secure communication involves the following tasks:
■

Taking the ClusterService-Proc (wac) resource in the ClusterService group
offline on the clusters in the global environment.

■

Adding the -secure option to the StartProgram attribute on each node.

■

Establishing trust between root brokers if the local clusters do not point to
the same root broker.

■

Bringing the ClusterService-Proc (wac) resource online on the clusters in the
global cluster.

To take the ClusterService-Proc (wac) resource offline on all clusters
1

From Cluster Monitor, log on to a cluster in the global cluster.

2

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

3

Right-click the ClusterService-Proc resource, click Offline, and click the
appropriate system from the menu.
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4

Repeat step 1 to step 3 for the additional clusters in the global cluster.

To add the -secure option to the StartProgram resource
1

In the Service Groups tab of the Cluster Explorer configuration tree, rightclick the ClusterService-Proc resource under the Process type in the
ClusterService group.

2

Click View, and then Properties view.

3

Click the Edit icon to edit the StartProgram attribute.

4

In the Edit Attribute dialog box, add -secure switch to the path of the
executable Scalar Value.
For example:

“C:\Program Files\Veritas\Cluster Server\bin\wac.exe”
-secure
5

Repeat step 4 for each system in the cluster.

6

Click OK to close the Edit Attribute dialog box.

7

Click the Save and Close Configuration icon in the tool bar.

8

Repeat step 1 to step 7 for each cluster in the global cluster.

To establish trust between root brokers if there is more than one root broker
◆

Establishing trust between root brokers is only required if the local clusters
do not point to the same root broker.
Log on to the root broker for each cluster and set up trust to the other root
brokers in the global cluster. The complete syntax of the command is:
vssat setuptrust --broker <host:port> --securitylevel
<low|medium|high> [--hashfile <filename> | --hash <root
hash in hex>]
For example, to establish trust with a low security level in a global cluster
comprised of Cluster1 pointing to RB1 and Cluster2 pointing to RB2:
from RB1, type:
vssat setuptrust --broker RB2:14141 --securitylevel low
from RB2, type:
vssat setuptrust --broker RB1:14141 --securitylevel low

To bring the ClusterService-Proc (wac) resource online on all clusters
1

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

2

Right-click the ClusterService-Proc resource, click Online, and click the
appropriate system from the menu.
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3

Repeat step 1 and step 2 for the additional clusters in the global cluster.

Re-enabling VVR after the upgrade
After upgrading an environment where VVR replicates data from a primary site
to a secondary site, use the appropriate procedures to re-enable VVR replication:
■

“Re-enabling VVR after the upgrade from 4.3.x versions to 5.1”

■

“Re-enabling VVR after the upgrade from 5.0.x to 5.1” on page 130

Re-enabling VVR after the upgrade from 4.3.x versions to 5.1
Follow the procedures in the order given while re-enabling from 4.3.x versions
to 5.1.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
To enable the updated objects
1

Bring the Disk Group Resource online.
■

From the Cluster Manager (Java Console), right-click the Disk Group
Resource and click Online.

or
■

2

From the command line, type
hares -online <resource_name> -sys <system_name>

Bring the VVR IP Resource online:
■

From the Cluster Manager (Java Console), right-click the VVR IP
Resource and click Online.

or
■

3

From the command line, type
hares -online <resource_name> -sys <system_name>

Re-associate the Replicator Log volume.
■

From the VEA console: On the primary site, expand the RDS to which
you want to associate the Replicator Log volume. Right-click the
primary RVG, and click the Associate Replicator Log option. Select the
correct Replicator Log volume from the dialog box and click OK.

or
■

From the command line, type
vxrvg [-g <diskgroup_name>] aslog <rvg_name>
<volume_name>
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4

To attach the RLINK, open a command prompt and run the following
command:
vxrlink -f att RLINK

5

Repeat steps 1-3 on the secondary site.

6

On both the primary and the secondary site, bring the RVG service group
online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.

or
■

7

From the command line, type
hagrp -online <group_name> -sys <system_name>

On the primary site, bring the application service group online.
■

From the Cluster Manager (Java Console), right-click the application
service group and click Online.

or
■

8

From the command line, type
hagrp -online <group_name> -sys <system_name>

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on options in your
environment, these tasks may include mounting databases or manually
starting the application.

Re-enabling VVR after the upgrade from 5.0.x to 5.1
After upgrading the cluster nodes from 5.0.x versions to 5.1, re-enable VVR on
the upgraded site. The site is in the secondary role during the upgrade and when
re-enabling VVR.
To enable the updated objects on the secondary site
1

Bring the Disk Group Resource online on the secondary site
■

From the Cluster Manager (Java console), right-click the Disk Group
Resource and click Online.
Or

■

From the command line, type
hares -online <resource_name> -sys <system_name>
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2

Bring the RVG service group online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.
Or

■

From the command line, type
hagrp -online <group_name> -sys <system_name>

Note: For VVR environments with multiple secondary sites, any
operations that need to be performed on a secondary site should be
repeated on all secondary sites.
If you are performing this procedure on the original secondary site, go to
the procedure to prepare the primary site for upgrade.
See “Preparing the primary site for upgrade” on page 114
If you have completed the upgrades on both the primary and secondary
sites, you can now migrate the applications back to the original primary.
See the following procedure, “Migrating the applications back to the
original primary site.”

Migrating the applications back to the original primary site
Once you have upgraded both the primary and the secondary sites, you may
want to switch back the applications to the site that was primary before the
upgrade.
To migrate the applications back to the original primary
1

In the Service Groups tab of the Cluster Manager, right-click the Application
service group that is online at the current primary site.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box, click the cluster of the original
primary to switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.
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Reconnecting DMP DSM paths after the upgrade
After you complete the upgrade for an existing DMP DSM environment, or if you
have added DMP DSMs during the upgrade:
1

Physically connect any additional paths to the DMP DSM array that were
disconnected before the upgrade.

2

In the VEA, rescan the disks.

Bringing the print share service group online after the upgrade
In SFW HA 5.1, the PrintSpool agent (for VCS) has been enhanced to meet
scalability and performance requirements. The PrintSpool agent no longer
depends on the RegRep agent for operation. The dependency between the
PrintSpool and the RegRep resource in a print share service group has been
eliminated.
This affects print share service groups configured in earlier versions of VCS. If
you have configured a print share and you upgrade VCS, then the existing print
share service group will fail to come online, after the upgrade.
After the upgrade is complete, you must run the Print Share Configuration
Wizard to modify the print share service group. This will allow the wizard to
make the required changes to the service group configuration.
Note: In case of an upgrade, do not add or remove any resources, or modify any
other attributes in the print share service group for the first time you run the
Print Share Configuration Wizard to modify the service group.
Before you modify the existing print share service group:
■

Make sure that the VCS engine (HAD) is running on the cluster node.

■

Mount the drives or LUNs that contain the spooler and the registry
replication directories on the system on which you will run the wizard.

To modify the print share service group after an upgrade
1

Start the Print Share Configuration Wizard. (Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Print Share
Configuration Wizard)

2

Read the information on the Welcome panel and click Next.

3

On the Wizard Options panel, click Modify service group, select your
existing print share service group, and then click Next.
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4

On the Service Group Configuration panel, click Next.

5

On the Configure Data Path panel, complete the following and then click
Next.
Spooler Directory

Leave this field as it is. Do not make any changes to the
spooler directory path.

Replication Directory

Type the path or click ... (ellipsis button) to browse for
the directory. All changes related to the printer
registry keys will be logged at this location.
The selected directory must reside on a shared, nonsystem drive.

6

Click Next on the subsequent wizard panels and complete the wizard steps.
You can now bring the printshare service group online.

Upgrading dynamic disk groups
If your previous installation included Volume Manager 4.x, upgrade the disk
group types to make use of the current program features.
See the Veritas Storage Foundation 5.1 Administrator’s Guide.
Note: If you upgrade a disk group to SFW HA 5.1, you cannot import it to
another server that is running an earlier version of Volume Manager or Disk
Management. After upgrading a disk group, the group cannot revert to an
earlier version.
To upgrade a dynamic disk group version
1

In the tree view, right-click the disk group you want to upgrade and select
Upgrade Dynamic Disk Group Version.

2

Click Yes to upgrade the dynamic disk group.
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Chapter

Upgrading an Exchange
Server cluster
The following topics are covered in this chapter:
■

Upgrade matrix for an Exchange Server cluster

■

Overview of tasks

■

Preparing to upgrade to SFW HA 5.1

■

Upgrading to SFW HA 5.1

■

Optional tasks after an upgrade to SFW HA 5.1

5
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Upgrade matrix for an Exchange Server cluster
Table 5-1 presents possible scenarios for upgrading from SFW HA versions 4.3,
4.3 MP1, 4.3 MP2, 5.0, and 5.0 RP1 to an SFW HA 5.1 cluster with Microsoft
Exchange.
Note: If upgrading Exchange 2007 to Exchange 2007 SP1, upgrade SFW HA first
and then upgrade Exchange. For information on service pack upgrades, see
Chapter 7, “Microsoft Service Pack upgrades” on page 199.

Table 5-1

Exchange Server cluster upgrade

Upgrade from this configuration ...

To this configuration ...

SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0, or
5.0 RP1

■

SFW HA 5.1

■

Windows Server 2003 SP2

■

Windows Server 2003 SP1

■

Exchange 2003 SP2

■

Exchange 2003 SP2

■

SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0, or
5.0 RP1

■

SFW HA 5.1

■

Windows Server 2003 R2 SP2

■

Windows Server 2003 R2

■

Exchange 2003 SP2

■

Exchange 2003 SP2

■

Overview of tasks
Upgrading an Exchange configuration in a VCS cluster requires you to upgrade
the VCS Application Agent for Microsoft Exchange from version 4.3x or 5.0.x to
version 5.1. To do this, you must upgrade to SFW HA 5.1.
Upgrading Microsoft Exchange Server in a VCS cluster involves pre-upgrade,
Microsoft Exchange Server upgrade, and post-upgrade tasks.
Note: After you have upgraded Microsoft Exchange in the VCS cluster, make
sure that all failover nodes for an Exchange virtual server have the same version
of Microsoft Exchange. All failover nodes must also have the same enterprise
agent version.
To upgrade to SFW HA 5.1, the upgrading tasks are as follows:
■

Prepare to upgrade to SFW HA 5.1, including stopping VCS Services.
See “Preparing to upgrade to SFW HA 5.1” on page 137.
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■

Upgrade VCS and the VCS application agent for Exchange from version 4.x
to version 5.1 by upgrading to SFW HA 5.1.
See “Upgrading to SFW HA 5.1” on page 149.

■

Perform post-upgrade tasks as required depending on your VCS cluster
configuration
See “Optional tasks after an upgrade to SFW HA 5.1” on page 154.

Preparing to upgrade to SFW HA 5.1
Before upgrading your Exchange cluster to SFW HA 5.1, you must prepare for
the upgrade by reviewing the requirements and performing some pre-upgrade
tasks. Some of the tasks are optional, depending on your configuration. For
example, if you have installed and configured VVR or DMP, you must take
additional steps before and after the upgrade to SFW 5.1.

Checking the supported minimum product versions
To upgrade to SFW HA 5.1, your system must have version 4.3 or higher of SFW
or SFW HA already installed. The previously installed products need to meet
minimum product versions, which the product installer checks before it
upgrades.
If your current installation does not meet the minimum level required by the
installer, Symantec recommends manually applying the appropriate product
upgrades to meet the minimum product level required before proceeding with
the installer. You can get intermediate versions of the products on the Symantec
Support site. For license keys, contact Symantec Sales. You can also uninstall
the older versions of the product and install the new product.

Performing general pre-upgrade tasks
When upgrading the product, perform the following tasks:
■

Back up all your data in a safe location.

■

Back up the system state.

■

Check the hardware requirements for the software upgrade.

■

Check to see if you need to update the Microsoft Active Directory to support
the upgraded software.

■

Test the system after each upgrade, especially after applying product
upgrades to meet the minimum version required. An incremental upgrade
eases the troubleshooting process.
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Additional upgrade information for VCS customers
While upgrading a configuration, the product installer performs the following
tasks:
■

Replaces the attribute types and names in the VCS 4.x configuration with
those compatible with a SFW HA 5.1 configuration. For example, the
Exchange application agent attribute E2kService is upgraded to
ExchService.

■

Maps default attribute values in a VCS 4.x configuration to the default
attribute values in a VCS 5.1 configuration.

■

Deletes attributes that are no longer required by SFW HA 5.1. For example,
the wizard removes the AgentDebug attribute.

■

Updates user passwords. Using a different encryption mechanism, SFW HA
5.1 decrypts the passwords and re-encrypts them using the VCS 5.1
encryption mechanism.

Preparing VVR in a VCS environment for upgrading
If you use VVR in a VCS environment to replicate data from a primary site to a
secondary site, prepare for the upgrade to SFW HA 5.1 with the following
procedures:
■

“Preparing VVR for upgrade from 4.3.x versions to 5.1” on page 138

■

“Preparing VVR for upgrade from 5.0.x versions to 5.1” on page 142

Preparing VVR for upgrade from 4.3.x versions to 5.1
Follow the procedures in the given order while upgrading from 4.3.x versions to
5.1.
Warning: A full autosynchronization is required if the procedures listed below
are not performed in the given order.
To prepare the primary site
1

Take the application service group offline on the primary site.
■

From the Cluster Manager (Java Console), right-click the application
service group and select the Offline menu option.

or
■

From the command line, type
hagrp -offline <group_name> -sys <system_name>
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2

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

3

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g <diskgroup_name>]

4

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary site.
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK. This command can be run only on the primary site.
Verify that the data volumes on the secondary are consistent and up-todate with the primary before proceeding to the next step.
5

Detach the RLINK to prevent VVR from replicating data to the secondary
site.
■

From the VEA console, right-click the secondary RVG and select the
Stop Replication option to stop VVR from replicating to the secondary
site.
The Stop Replication option is available only when selecting the
secondary RVG. When this operation is performed the connection
between the primary and secondary RVG is broken.

or
■

From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>

This command detaches the RLINK from the RVG.
6

Dissociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu.

or
■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
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Warning: Use the -f option only when you are sure that the secondary is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
7

Bring the Disk Group and IP resources offline in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the menu.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
To prepare the secondary site
1

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

2

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g<diskgroup_name>])

3

If you used the VEA console to stop replication on the primary site, then you
need not perform this step on the secondary site. However, if you used the
command line to detach the RLINK while preparing the primary site, then
you must perform this action on the secondary site as well.
From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>]

This command detaches an RLINK from the secondary RVG.
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4

Dissociate the Replicator Log volume from the RVG.
From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu that appears.
This option is available for selection only if the Replicator Log is associated
with an RVG.
or
■

■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
5

Offline the Disk Group and IP resources in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the context-menu that appears.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
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Preparing VVR for upgrade from 5.0.x versions to 5.1
Since VVR 5.0.x and VVR 5.1 versions are interoperable, you can keep the
applications running on the primary site while upgrading the secondary site.
The recommended sequence is as follows:
■

Prepare VVR on the secondary (DR) site to upgrade from SFW HA 5.0.x to
5.1.
See the procedure below:
“Preparing VVR on the secondary (DR) site for upgrade.”

■

Prepare the VCS cluster on the secondary site for upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 137.

■

Upgrade the cluster nodes on the secondary site to SFW HA 5.1.
See “Upgrading to SFW HA 5.1” on page 149.

■

Re-enable VVR on the upgraded secondary site.
See “Re-enabling VVR after the upgrade” on page 162.

■

Once the secondary (DR) site has been upgraded, prepare the primary site
for upgrade. The procedure includes migrating the primary role to the DR
site.
See “Preparing the primary site for upgrade” on page 143.

■

Prepare the VCS cluster on the old primary site (now the secondary site) for
upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 137.

■

Upgrade the nodes on the old primary site to SFW HA 5.1.
See “Upgrading to SFW HA 5.1” on page 149.

■

Re-enable VVR on the upgraded site. The topic includes a procedure for
migrating the applications back to the original primary site.
See “Re-enabling VVR after the upgrade” on page 162.

Preparing VVR on the secondary (DR) site for upgrade
When preparing VVR for upgrade from SFW HA 5.0.x to 5.1, you begin by
preparing the secondary site.
To prepare the secondary (DR) site
1

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>
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2

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
3

If the existing replication settings are configured to use TCP, change the
settings to use UDP. After both the primary and DR sites are upgraded to 5.1,
you can switch the replication settings back to TCP.
After you have completed these secondary site preparation steps, continue
with the following procedures in sequence:
■

Preparing the VCS cluster on the secondary site for upgrade.

■

Upgrading the secondary site nodes to SFW HA 5.1

■

Re-enabling VVR on the secondary site

■

Preparing the primary site for upgrade

Preparing the primary site for upgrade
After upgrading the DR site to SFW HA 5.1 and re-enabling VVR on that site, you
prepare the primary site for upgrade. The procedure steps first use the remote
switch operation to migrate the applications to the current secondary site, thus
switching the roles so that the primary site becomes the secondary. You then
prepare VVR for upgrade.
To prepare the primary site
1

In the Service Groups tab of the Cluster Manager, right-click the application
service group that is online at the primary site.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box, click the cluster of the secondary
siteto switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.

5

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on the options
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available in your environment, these tasks may include mounting the
databases or manually starting the application.
Once the applications are online, the sites have now switched roles, so that
the former secondary site is now the primary site, and the old primary has
the role of the secondary.
Therefore, on the old primary (now the secondary) complete the following
steps, which are the same as when preparing the original secondary site for
the upgrade.
6

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

7

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
You can then continue with the following procedures in sequence:
■

Preparing the cluster for upgrade

■

Upgrading the cluster nodes to SFW HA 5.1

■

Re-enabling VVR

■

Migrating the applications back to the original primary site

Preparing to add DMP DSMs to the upgraded environment
If you do not have DMP DSMs in your existing environment, but plan to add this
feature while upgrading to SFW 5.1, add the host adapter hardware before
performing the upgrade.
Refer to the Hardware Compliance List on the Symantec Support web site at
http://www.symantec.com/business/support/index.jsp to determine the
approved hardware for SFW.
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For more information on the hardware and software prerequisites for DMP DSM
installation, see the following:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on page 61.

■

Veritas Storage Foundation Administrator’s Guide.

Connect no more than one path from the new host adapters to the array storage
before upgrading to SFW and installing DMP DSMs. Select the DMP DSM option
or the appropriate DMP DSMs while running the installer.

Preparing an existing DMP environment for upgrading
Previous DMP environments are either DMP DSM or DMP ASL. The
preparations for upgrade are different for each.

DMP DSM environment
If you are preparing to upgrade an existing DMP DSM environment, it is
recommended to physically disconnect all but one path of the multipath storage
to shorten upgrade time.
No other DMP preparation is required except as follows.
In upgrading from 4.3.x, in the following cases only, you must uninstall DMP
DSM before the upgrade (and reinstall it during the upgrade):
■

SFW 4.3 with DMP option installed and no SFW 4.3 DDI-x has ever been
applied

■

SFW 4.3 DMP with DDI-1, DDI-3 or DDI-4 installed

Before uninstalling DMP DSM from a node in a cluster environment, the cluster
resources should be moved to another node.
To uninstall the DMP or the DDI package
1

Make sure that only one path is attached for each array managed by DMP
DSM.

2

Open the Windows Add/Remove Programs to uninstall the DDI. Select the
Symantec support for DMP DSM entry and click Remove to begin the
uninstallation.

3

Reboot the system when the uninstall process completes.

DMP ASL environment
DMP ASLs are no longer supported on SFW 5.1. Therefore, you must uninstall
DMP ASLs before the upgrade to 5.1.
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It is important that you detach all but the primary path to the array storage
before you uninstall.
Warning: Failure to limit DMP ASLs to a single path before uninstalling can lead
to data corruption.

Warning: Always back up your data before upgrading.
To prepare an existing DMP ASL environment for upgrade
1

Physically remove all but the primary path from each multiple-path array.

2

In the VEA, exclude each multiple-path array from DMP ASLs management.
■

In the tree view under the Disks folder, select a disk from the storage
array that you are excluding.

■

In the right pane, click the Paths tab for the disk.

■

Right-click a path and select Array Settings from the path context
menu that appears.

■

In the Array Settings screen, check the Exclude check box.

■

Click OK. The array is now excluded from DMP control.

3

Select Actions > Rescan from the VEA menu bar. Veritas Storage Foundation
for Windows rescans the array and updates the display.

4

Uninstall the DMP ASLs using the Add or Remove function through the
installer.
See “Adding or removing features” on page 56.

5

After the uninstall process is complete, reboot the system.

6

If you want to install DMP DSMs during the upgrade, review the following
information for more information on prerequisites for DMP DSMs:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on
page 61.

■

Veritas Storage Foundation Administrator’s Guide.

Removing VCS Management Console
If one or more nodes in the cluster have Veritas Cluster Server Management
Console 5.1 installed, you must remove the management console before
upgrading SFW HA. You can reinstall the management console after the
upgrade.
See “Reinstalling VCS Management Console 5.1” on page 154.
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To remove VCS Management Console 5.1
1

Stop the VCS Management Console. If the management console is clustered,
take the CMC_MS service group offline.

2

Back up the console’s data directory and datadir.conf files. Typically, the
files are located at the following paths:
■

C:\Program Files\Symantec\VRTScmcm

or
■

3

C:\Program Files (x86)\Symantec\VRTScmcm

Remove VCS Management Console 5.1 from all nodes in the cluster using
Windows Add/Remove Programs.

Preparing the VCS cluster for the upgrade
Complete the following procedures to prepare the VCS cluster before the
upgrade.

Saving and closing the cluster configuration
Before starting the upgrade process, use the VCS Java Console to “save and
close” the VCS configuration. This operation involves saving the latest
configuration to disk and changing the configuration state to read-only mode.
You must also stop VCS before attempting the upgrade process. In a VVR
environment, perform these steps on both the VVR primary and secondary
clusters.
To save and close the configuration
■

From the VCS Java Console, click Save and Close Configuration on the
Cluster Explorer toolbar.
or

■

From the command prompt, type:
C:\>haconf -dump -makero

Taking the service groups offline
Take all service groups in the cluster offline before the upgrade.
To bring the service group offline
1

From the command prompt, type:
C:\> hagrp -offline group_name -sys system_name

Where group_name is the name of the service group and system_name is the
node where the group is online.
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2

Repeat this command for all service groups that are online.

Closing SFW HA clients
Exit all instances of the Veritas Enterprise Administrator (VEA), Cluster
Manager (Java Console), and Cluster Management Console (Single Cluster Mode)
before the upgrade.
■

From the VEA, click File > Exit and then click Yes on the confirmation dialog
box.

■

From the Cluster Manager (Java Console), click File > Logout on the Cluster
Explorer window and then click File > Exit on the Cluster Monitor window.

■

For CMC, click Logout on the title bar of the Cluster Management Console.

Stopping VCS services
Stop the VCS services before the upgrade.
To stop VCS services
1

Stop HAD on all the cluster nodes. Type the following on the command
prompt:

C:\>hastop -all -force
2

Stop the Veritas VCSComm Startup service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop vcscomm
3

Stop the Veritas Command Server service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop cmdserver
4

Stop GAB and LLT on all the cluster nodes. Type the following on the
command prompt:

C:\>net stop gab
C:\>net stop llt
5

Stop the Veritas Enterprise Administrator Service on all the cluster nodes.
Type the following on the command prompt:

C:\>net stop vxob
6

Stop the Windows Indexing Service:

C:\>net stop cisvc
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7

If upgrading from SFW HA 5.0.x, stop the Symantec Private Branch
Exchange service, Veritas Storage Agent, Veritas GridNode, and the Veritas
Action Agent services on all the cluster nodes. Type the following
commands on the command prompt:

C:\>net
C:\>net
C:\>net
C:\>net

stop
stop
stop
stop

VRTSpbx
vxvm
vxgn
actionagent

Backing up customized type definitions
The cluster type definitions are reset to their default values after the upgrade. If
you have modified the values of type definitions in the cluster, make a backup
copy of the types.cf file before the upgrade. The types.cf file is typically
located at %VCS_HOME%\conf\config.
The variable %VCS_HOME% is the default installation directory for VCS, typically
C:\Program Files\VERITAS\Cluster Server.
After you complete the upgrade, refer to the backup copy of the types.cf file
and use the Cluster Manager (Java Console) to change the type definition default
values with the values you had originally set in the cluster.
Note: After the upgrade, do not replace the types.cf file with the backup copy.
Use the backup copy only as a reference for the customized type definition
values in the cluster.

Upgrading to SFW HA 5.1
The installer automatically upgrades SFW 4.3, 4.3 MP1, 4.3 MP2, 5.0, or 5.0 RP1
to SFW HA 5.1. If the cluster has VCS enterprise agents and options, make sure
to select the same enterprise agents and options while upgrading to SFW HA 5.1.
If you do not want to include the enterprise agents and options in the upgraded
cluster, uninstall the agents from the cluster before proceeding.
You can upgrade SFW HA on servers in a Windows Server 2003 domain.

Changing driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed. When installing on systems running Windows Server 2003, you
must set the Windows driver signing options to allow installation.
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The following table describes the product installer behavior on local and remote
systems when installing options with unsigned drivers.
Table 5-2

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.

4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.

Upgrading the software
Use the product installer to upgrade the software.
To upgrade the product using the installer
1

Allow the autorun feature to start the installation or double-click Setup.exe.

2

Choose the default language for your installation and click OK. The
Symantec product selection screen appears.
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3

Click Storage Foundation HA 5.1 for Windows.

4

Click Complete/Custom to begin installation. The Administrative Console
link allows you to install only the Client components.

5

Review the welcome message and click Next.

6

If you agree to the terms of the license agreement, click Next.

7

Enter the license key for each Symantec product option that you are
upgrading or installing in the top field.

8

To add a key, click Add.
To remove a key, click the key to select it, and click Remove.

9

Repeat step 7 and step 8 for each Symantec product and feature that you
want to install. Click a key to see its details.

10 Click Next.
11 Select the appropriate Storage Foundation HA options and click Next. If any
previous VCS agents and options are installed on the node, make sure you
select the same agents and options while upgrading. If you do not want to
include the agents and options in the upgraded cluster, uninstall them from
the cluster before proceeding.
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12 Select the domain and the computers for the upgrade and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.

Install Path

The install path cannot be changed for the upgrade.

13 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next. Note that the
Install Type for the nodes is listed as Upgrade. If an error occurs, address the
problem described in the Details box, click Validate Again, and click Next.
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14 If applicable, at the Veritas Dynamic Multi-pathing warning, do the
following:
For DMP DSMs installations—the time required to install the Veritas
Dynamic Multi-pathing DSMs feature depends on the number of
physical paths connected during the installation. To reduce installation
time for this feature, connect only one physical path during
installation. After installation, reconnect additional physical paths
before rebooting the system.
Click OK.
■

15 Review the pre-upgrade summary. Click Back to make changes if necessary.
Click Install.
16 If the installation is successful on all nodes, the installer automatically
proceeds to the summary page.
Click Next after the progress indicator shows the installation is complete to
proceed to the summary report in order to review the details of the failed
installation. Note that if a security alert asks you to accept the Symantec
driver software, click Yes.
17 Review the installation report, taking action where necessary, and click
Next.
18 Reboot the remote computers. Note that you cannot reboot the local
computer now, and that failed computers are unchecked by default. Select
the upgraded remote computers and click Reboot.
Wait for the remote computer to come back online. Click Next.
19 Click Finish.
20 Click Yes to reboot the local node.
If you upgraded or installed the Volume Replicator (VVR) option, you can
launch the wizard for Veritas Volume Replicator Security Service (VxSAS)
after the reboot to configure security services for all nodes. This step is
required for VVR if you are upgrading from 4.3 versions. If you are
upgrading from 5.0.x and VxSAS was already configured for 5.0.x, you do
not need to configure it again.
See “Configuring the VxSAS service (VVR only)” on page 159.
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Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK.

5

Repeat for each computer.

Optional tasks after an upgrade to SFW HA 5.1
The following tasks are optional depending on your cluster configuration.
■

“Reinstalling VCS Management Console 5.1” on page 154

■

“Including custom resources in the upgraded cluster” on page 155

■

“Configuring a secure cluster” on page 156

■

“Adding a GCO resource to the ClusterService group” on page 157

■

“Establishing secure communication within the global cluster” on page 157

■

“Configuring the VxSAS service (VVR only)” on page 159

■

“Re-enabling VVR after the upgrade” on page 162

■

“Reconnecting DMP DSM paths after the upgrade” on page 165

■

“Upgrading dynamic disk groups” on page 165

In addition, you may want to update Exchange with a service pack after
upgrading SFW HA. For information on updating Exchange service packs, see
the following chapter:
■

Chapter 7, “Microsoft Service Pack upgrades” on page 199

Reinstalling VCS Management Console 5.1
If you uninstalled VCS Management Console earlier according to the procedures
for preparing for the upgrade, you can now reinstall it.
To re-install VCS Management Console
1

Install VCS Management Console 5.1.
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Refer to the Veritas Cluster Server Management Console Implementation
Guide.
2

Restore the backed up VCS Management Console 5.1 data files.
See “Removing VCS Management Console” on page 146.

3

Start the VCS Management Console. If the management console is clustered,
bring the CMC_MS service group online.

Including custom resources in the upgraded cluster
The VCS Configuration Wizard does not upgrade custom resources. If a service
group in the previous configuration contains custom resources, the wizard does
not include the service group in the upgraded cluster.
To include a service group with custom resources in the upgraded cluster
1

Make sure the agent binaries for the custom agent are available under
%VCS_HOME%\bin where the variable %VCS_HOME% represents the VCS
installation directory, typically C:\Program Files\Veritas\cluster
server.

2

Stop the VCS engine (HAD) on all the nodes in the cluster. From the
command prompt, type:
C:\> hastop -all -force

3

During installation of the SFW HA 5.1 software, the installer copies
previous configuration files to a backup location. Locate the backed up
types.cf and main.cf files: C:\Documents and Settings\All
Users\Application Data\Veritas\cluster server\vpibackup.

4

Copy the resource type definition for the custom resource from the backed
up types.cf and add it to the types.cf file for the VCS 5.1 cluster.

5

Copy the service group configuration containing the custom resource from
the backed up main.cf and add it to the main.cf file for the VCS 5.1 cluster.

6

If resources for a custom resource type are dependent on resources for
agents bundled with VCS 5.1, you must update the resource definition of the
VCS bundled agent to include the new attributes or remove the deprecated
attributes.
For information on new and deprecated attributes see the Veritas Storage
Foundation and High Availability Solutions 5.1 Release Notes.
For information on the attribute values and descriptions see the Veritas
Cluster Server 5.1 Bundled Agents Reference Guide.
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7

Verify the configuration. Type:
C:\> hacf -verify config_directory
The variable config_directory refers to the path of the directory
containing the main.cf and types.cf.

8

Start the VCS engine (HAD) on the node where you changed the
configuration. Type the following at the command prompt:

C:\> hastart
9

Start the VCS engine (HAD) on all the other cluster nodes.

Configuring a secure cluster
If you want to configure a secure cluster, you must reconfigure the cluster using
the VCS Configuration Wizard.
To configure a secure cluster
1

Click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > Cluster Configuration Wizard.

2

The VCS Configuration Wizard Welcome screen appears. Click Next.

3

The Configuration Options screen appears. Select Cluster Operations. Click
Next.

4

The Domain Selection screen appears. Enter a domain name or select one
from the list. Click Next.

5

The System Selection screen appears. Enter a system name and click Add or
select a system from the list and click the arrow button to add it to the
Selected System list. Click Next.

6

The Cluster Configurations Options screen appears. Select Edit Existing
Cluster. Click Next.

7

The Cluster Selection screen appears. Select the cluster name from the
displayed list of clusters. Click Next.

8

The Edit Cluster Options screen appears. Select Reconfigure. Click Next.

9

Enter the username and password for the cluster in the Cluster User
Information Dialog.

10 Select Configure/Change Veritas Security Services (Single Sign-On). Click
Next.
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11 Select Change Symantec Product Authentication Service Configuration
(Change Root Broker).
■

Select Specify Symantec Product Authentication Service Root broker
system and enter a system name and click Next or

■

Select Discover the Symantec Product Authentication Service Root
broker system in the domain and click Scope.
■

Select the Entire Domain or Specify Scope and select an
organizational unit.

■

If needed, select a property, such as a system name to use as a filter
in the Filter Criteria field and click OK. Click Next.

See the Veritas Cluster Server 5.1 Administrator’s Guide.

Adding a GCO resource to the ClusterService group
VCS 5.1 provides the Global Cluster Option to enable a collection of VCS clusters
to work together for wide-area disaster recovery.
See the Veritas Cluster Server Administrator’s Guide.

Establishing secure communication within the global cluster
A global cluster is created in non-secure mode by default. You may continue to
allow the global cluster to run in non-secure mode or choose to establish secure
communication between clusters.
The following prerequisites are required for establishing secure communication
within a global cluster:
■

The clusters within the global cluster must be running in secure mode.

■

You must have Administrator privileges for the domain.

The following information is required for adding secure communication to a
global cluster:
■

The active host name or IP address of each cluster in the global
configuration.

■

The user name and password of the administrator for each cluster in the
configuration.

■

If the local clusters do not point to the same root broker, the host name and
port address of each root broker.

Adding secure communication involves the following tasks:
■

Taking the ClusterService-Proc (wac) resource in the ClusterService group
offline on the clusters in the global environment.
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■

Adding the -secure option to the StartProgram attribute on each node.

■

Establishing trust between root brokers if the local clusters do not point to
the same root broker.

■

Bringing the ClusterService-Proc (wac) resource online on the clusters in the
global cluster.

To take the ClusterService-Proc (wac) resource offline on all clusters
1

From Cluster Monitor, log on to a cluster in the global cluster.

2

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

3

Right-click the ClusterService-Proc resource, click Offline, and click the
appropriate system from the menu.

4

Repeat step 1 to step 3 for the additional clusters in the global cluster.

To add the -secure option to the StartProgram resource
1

In the Service Groups tab of the Cluster Explorer configuration tree, rightclick the ClusterService-Proc resource under the Process type in the
ClusterService group.

2

Click View, and then Properties view.

3

Click the Edit icon to edit the StartProgram attribute.

4

In the Edit Attribute dialog box, add -secure switch to the path of the
executable Scalar Value.
For example:

“C:\Program Files\Veritas\Cluster Server\bin\wac.exe”
-secure
5

Repeat step 4 for each system in the cluster.

6

Click OK to close the Edit Attribute dialog box.

7

Click the Save and Close Configuration icon in the tool bar.

8

Repeat step 1 to step 7 for each cluster in the global cluster.
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To establish trust between root brokers if there is more than one root broker
◆

Establishing trust between root brokers is only required if the local clusters
do not point to the same root broker.
Log on to the root broker for each cluster and set up trust to the other root
brokers in the global cluster. The complete syntax of the command is:
vssat setuptrust --broker <host:port> --securitylevel
<low|medium|high> [--hashfile <filename> | --hash <root
hash in hex>]
For example, to establish trust with a low security level in a global cluster
comprised of Cluster1 pointing to RB1 and Cluster2 pointing to RB2:
from RB1, type:
vssat setuptrust --broker RB2:14141 --securitylevel low
from RB2, type:
vssat setuptrust --broker RB1:14141 --securitylevel low

To bring the ClusterService-Proc (wac) resource online on all clusters
1

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

2

Right-click the ClusterService-Proc resource, click Online, and click the
appropriate system from the menu.

3

Repeat step 1 and step 2 for the additional clusters in the global cluster.

Configuring the VxSAS service (VVR only)
If you upgraded or installed the Volume Replicator (VVR) option, you can launch
the wizard for Veritas Volume Replicator Security Service (VxSAS) after the
SFW HA installation to configure security services for all nodes. This step is
required for VVR if you are upgrading from 4.3 versions. If you are upgrading
from 5.0.x and VxSAS was already configured for 5.0.x, you do not need to
configure it again.
C

Complete the following procedure to configure the VxSAS service for VVR.
The procedure has these prerequisites:
■

You must be logged on with administrative privileges on the server for the
wizard to be launched.

■

The account you specify must have administrative and log-on as service
privileges on all the specified hosts.

■

Avoid specifying blank passwords. In a Windows Server environment,
accounts with blank passwords are not supported for log-on service
privileges.
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■

Make sure that the hosts on which you want to configure the VxSAS service
are accessible from the local host.

Note: The VxSAS wizard will not be launched automatically after installing SFW
or SFW HA. You must launch this wizard manually to complete the VVR security
service configuration. For details on this required service, see Veritas Storage
Foundation Veritas Volume Replicator Administrator’s Guide.
To configure the VxSAS service
1

To launch the wizard, select Start > All Programs > Symantec > Veritas
Storage Foundation > Configuration Wizards > VVR Security Service
Configuration Wizard or run vxsascfg.exe from the command prompt of
the required machine.
Read the information provided on the Welcome page and click Next.

2

Complete the Account Information panel as follows:
Account name
(domain\account)

Enter the administrative account name.

Password

Specify a password.

If you have already configured the VxSAS service for one host that is
intended to be a part of the RDS, make sure you specify the same username
and password when configuring the VxSAS service on the other hosts.
Click Next.
3

On the Domain Selection panel, select the domain to which the hosts that
you want to configure belong:
Selecting domains

The Available domains pane lists all the domains that are
present in the Windows network neighborhood.
Move the appropriate name from the Available domains list
to the Selected domains list, either by double-clicking it or
using the arrow button.

Adding a domain

Click Next.

If the domain name that you require is not displayed, click
Add domain. This displays a dialog that allows you to
specify the domain name. Click Add to add the name to the
Selected domains list.
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4

On the Host Selection panel, select the required hosts:

Selecting hosts

The Available hosts pane lists the hosts that are present in
the specified domain.
Move the appropriate host from the Available hosts list to
the Selected hosts list, either by double-clicking it or using
the arrow button. Use the Shift key with the up or down
arrow keys to select multiple hosts.

Adding a host

If the host name you require is not displayed, click Add
host. In the Add Host dialog specify the required host name
or IP in the Host Name field. Click Add to add the name to
the Selected hosts list.

After you have selected a host name, the Configure button is enabled. Click
Configure to proceed with configuring the VxSAS service.
5

After the configuration completes, the Configuration Results page displays
whether or not the operation was successful. If the operation was not
successful, the page displays the details on why the account update failed,
along with the possible reasons for failure and recommendations on getting
over the failure.
Click Back to change any information you had provided earlier.

6

Click Finish to exit the wizard.
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Re-enabling VVR after the upgrade
After upgrading an environment where VVR replicates data from a primary site
to a secondary site, use the appropriate procedures to re-enable VVR replication:
■

“Re-enabling VVR after the upgrade from 4.3.x versions to 5.1.”

■

“Re-enabling VVR after the upgrade from 5.0.x versions to 5.1” on page 163

Re-enabling VVR after the upgrade from 4.3.x versions to 5.1
Follow the procedures in the order given while re-enabling from 4.3.x versions
to 5.1.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
To enable the updated objects
1

Bring the Disk Group Resource online.
■

From the Cluster Manager (Java Console), right-click the Disk Group
Resource and click Online.

or
■

2

From the command line, type
hares -online <resource_name> -sys <system_name>

Bring the VVR IP Resource online:
■

From the Cluster Manager (Java Console), right-click the VVR IP
Resource and click Online.

or
■

3

From the command line, type
hares -online <resource_name> -sys <system_name>

Re-associate the Replicator Log volume.
■

From the VEA console: On the primary site, expand the RDS to which
you want to associate the Replicator Log volume. Right-click the
primary RVG, and click the Associate Replicator Log option. Select the
correct Replicator Log volume from the dialog box and click OK.

or
■

From the command line, type
vxrvg [-g <diskgroup_name>] aslog <rvg_name>
<volume_name>
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4

To attach the RLINK, open a command prompt and run the following
command:
vxrlink -f att RLINK

5

Repeat steps 1-3 on the secondary site.

6

On both the primary and the secondary site, bring the RVG service group
online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.

or
■

7

From the command line, type
hagrp -online <group_name> -sys <system_name>

On the primary site, bring the application service group online.
■

From the Cluster Manager (Java Console), right-click the application
service group and click Online.

or
■

8

From the command line, type
hagrp -online <group_name> -sys <system_name>

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on options in your
environment, these tasks may include mounting databases or manually
starting the application.

Re-enabling VVR after the upgrade from 5.0.x versions to 5.1
After upgrading the cluster nodes from 5.0.x versions to 5.1, re-enable VVR on
the upgraded site. The site is in the secondary role during the upgrade and when
re-enabling VVR.
To enable the updated objects on the secondary site
1

Bring the Disk Group Resource online on the secondary site
■

From the Cluster Manager (Java console), right-click the Disk Group
Resource and click Online.
Or

■

From the command line, type
hares -online <resource_name> -sys <system_name>
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2

Bring the RVG service group online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.
Or

■

From the command line, type
hagrp -online <group_name> -sys <system_name>

Note: For VVR environments with multiple secondary sites, any
operations that need to be performed on a secondary site should be
repeated on all secondary sites.
If you are performing this procedure on the original secondary site, go to
the procedure to prepare the primary site for upgrade.
See “Preparing the primary site for upgrade” on page 143
If you have completed the upgrades on both the primary and secondary
sites, you can now migrate the applications back to the original primary.
See the following procedure, “Migrating the applications back to the
original primary site.”

Migrating the applications back to the original primary site
Once you have upgraded both the primary and the secondary sites, you may
want to switch back the applications to the site that was primary before the
upgrade.
To migrate the applications back to the original primary
1

In the Service Groups tab of the Cluster Manager, right-click the Application
service group that is online at the current primary site.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box, click the cluster of the original
primary to switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.
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Reconnecting DMP DSM paths after the upgrade
After you complete the upgrade for an existing DMP DSM environment, or if you
have added DMP DSMs during the upgrade:
1

Physically connect any additional paths to the DMP DSM array that were
disconnected before the upgrade.

2

In the VEA, rescan the disks.

Upgrading dynamic disk groups
If your previous installation included Volume Manager 4.x, upgrade the disk
group types to make use of the current program features.
See the Veritas Storage Foundation 5.1 Administrator’s Guide.
Note: If you upgrade a disk group to SFW HA 5.1, you cannot import it to
another server that is running an earlier version of Volume Manager or Disk
Management. After upgrading a disk group, the group cannot revert to an
earlier version.
To upgrade a dynamic disk group version
1

In the tree view, right-click the disk group you want to upgrade and select
Upgrade Dynamic Disk Group Version.

2

Click Yes to upgrade the dynamic disk group.
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Chapter

6

Upgrading a SQL Server
cluster
This chapter describes how to upgrade SFW HA versions 4.x to SFW HA 5.1 in a
SQL Server cluster environment. The topics discussed include:
■

Upgrade matrix for a SQL Server cluster

■

Overview of tasks

■

Preparing to upgrade to SFW HA 5.1

■

Backing up customized type definitions

■

Optional tasks after an upgrade to SFW HA 5.1

■

Upgrading from Microsoft SQL Server 2000 to SQL Server 2005
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Upgrade matrix for a SQL Server cluster
Table 6-1 presents possible scenarios for upgrading from SFW HA versions 4.3,
4.3 MP1, 4.3 MP2, 5.0, and 5.0 RP1 to an SFW HA 5.1 cluster with SQL Server.
Table 6-1

Upgrade matrix for SQL Server cluster

Upgrade from this configuration ...

To this configuration ...

SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0, or 5.0
RP1

■

SFW HA 5.1

■

Windows Server 2003 SP2

■

Windows Server 2003 SP1

■

SQL Server 2005 SP2

■

SQL Server 2005

■

SFW HA 4.3 MP1, 4.3 MP2, 5.0, or 5.0 RP1

■

SFW HA 5.1

■

Windows Server 2003 R2

■

Windows Server 2003 R2 SP2

■

SQL Server 2000 SP4

■

SQL Server 2005 SP2

■

Overview of tasks
The upgrade tasks are as follows:
■

Prepare for the upgrade to SFW HA 5.1, including stopping VCS Services
before upgrading.
See “Preparing to upgrade to SFW HA 5.1” on page 169.

■

Upgrade SFW HA and the database agent for Microsoft SQL Server from
version 4.x to version 5.1.
See “Backing up customized type definitions” on page 180.

■

Review the optional tasks after upgrading SFW HA and perform those tasks
that are applicable to your environment.
See “Optional tasks after an upgrade to SFW HA 5.1” on page 185.

■

Upgrade Microsoft SQL Server, if necessary.
See “Upgrading from Microsoft SQL Server 2000 to SQL Server 2005” on
page 196.

Note: If you plan to upgrade both SQL Server and SFW HA, first upgrade SQL
Server, and then follow with the upgrade to SFW HA 5.1.
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Preparing to upgrade to SFW HA 5.1
Before upgrading your SQL Server cluster to SFW HA 5.1, you must prepare for
the upgrade by reviewing the requirements and performing some pre-upgrade
tasks. Some of the tasks are optional, depending on your configuration.

Checking the supported minimum product versions
To upgrade to SFW HA 5.1, your system must have version 4.3 or higher of SFW
or SFW HA already installed. The previously installed products need to meet
minimum product versions, which the product installer checks before it
upgrades.
If your current installation does not meet the minimum level required by the
installer, Symantec recommends manually applying the appropriate product
upgrades to meet the minimum product level required before proceeding with
the installer. You can get intermediate versions of the products on the Symantec
Support site. For license keys, contact Symantec Sales. You can also uninstall
the older versions of the product and install the new product.

Performing general pre-upgrade tasks
When upgrading the product, perform the following tasks:
■

Back up all your data in a safe location.

■

Back up the system state.

■

Check the hardware requirements for the software upgrade.

■

Check to see if you need to update the Microsoft Active Directory to support
the upgraded software.

■

Test the system after each upgrade, especially after applying product
upgrades to meet the minimum version required. An incremental upgrade
eases the troubleshooting process.

Additional upgrade information for VCS customers
While upgrading a configuration, the product installer performs the following
tasks:
■

Replaces the attribute types and names in the VCS 4.x configuration with
those compatible with a SFW HA 5.1 configuration.

■

Maps default attribute values in a VCS 4.x configuration to the default
attribute values in a VCS 5.1 configuration.
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■

Deletes attributes that are no longer required by SFW HA 5.1. For example,
the wizard removes the AgentDebug attribute.

■

Updates user passwords. Using a different encryption mechanism, SFW HA
5.1 decrypts the passwords and re-encrypts them using the VCS 5.1
encryption mechanism.

Preparing a VVR environment for upgrading
If you use VVR in a VCS environment to replicate data from a primary site to a
secondary site, follow the procedures below:
■

“Preparing VVR for upgrade from 4.3.x versions to 5.1.”

■

“Preparing VVR for upgrade from 5.0.x versions to 5.1.”

Preparing VVR for upgrade from 4.3.x versions to 5.1
Follow the procedures in the given order while upgrading from 4.3.x versions to
5.1.
Warning: A full autosynchronization is required if the procedures listed below
are not performed in the given order.
To prepare the primary site
1

Take the application service group offline on the primary site.
■

From the Cluster Manager (Java Console), right-click the application
service group and select the Offline menu option.

or
■

From the command line, type
hagrp -offline <group_name> -sys <system_name>

2

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

3

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g <diskgroup_name>]
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4

Verify that the data on the Replicator Log is written to the secondary site by
running the following command on the primary site.
vxrlink [-g <diskgroup_name>] status rlink_to_secondary

This command displays the replication status of the secondary represented
by the specified RLINK. This command can be run only on the primary site.
Verify that the data volumes on the secondary are consistent and up-todate with the primary before proceeding to the next step.
5

Detach the RLINK to prevent VVR from replicating data to the secondary
site.
■

From the VEA console, right-click the secondary RVG and select the
Stop Replication option to stop VVR from replicating to the secondary
site.
The Stop Replication option is available only when selecting the
secondary RVG. When this operation is performed the connection
between the primary and secondary RVG is broken.

or
■

From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>

This command detaches the RLINK from the RVG.
6

Dissociate the Replicator Log volume from the RVG.
■

From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu.

or
■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
7

Bring the Disk Group and IP resources offline in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the menu.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.

171

172 Upgrading a SQL Server cluster
Preparing to upgrade to SFW HA 5.1

To prepare the secondary site
1

Take the RVG resource offline.
■

From the Cluster Manager console, right-click the RVG resource and
select the Offline option.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

2

To get the list of RVG and RLINK records, type the following from the
command line:
vxprint -lVP [-g<diskgroup_name>])

3

If you used the VEA console to stop replication on the primary site, then you
need not perform this step on the secondary site. However, if you used the
command line to detach the RLINK while preparing the primary site, then
you must perform this action on the secondary site as well.
From the command line, type
vxrlink [-g <diskgroup_name>] det <rlink_name>]

This command detaches an RLINK from the secondary RVG.
4

Dissociate the Replicator Log volume from the RVG.
From the VEA console, right-click the Replicator Log volume and select
the Dissociate Replicator Log option from the menu that appears.
This option is available for selection only if the Replicator Log is associated
with an RVG.
or
■

■

From the command line, type
vxrvg [-f] [-g <diskgroup_name>] [-r <rvg_name>] dis
<volume_name>

This command dissociates the specified Replicator Log from the RVG. If the
-f option is used, it forcefully dissociates the volumes.
Warning: Use the -f option only when you are sure that the secondary site is
completely up-to-date with the primary. Otherwise this option can cause
data corruption.
5

Offline the Disk Group and IP resources in a VCS cluster setup.
■

From the Cluster Manager console, right-click the Disk Group resource
and select the Offline option from the context-menu that appears.

or
■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
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Preparing VVR for upgrade from 5.0.x versions to 5.1
Since VVR 5.0.x and VVR 5.1 versions are interoperable, you can keep the
applications running on the primary site while upgrading the secondary site.
The recommended sequence is as follows:
■

Prepare VVR on the secondary (DR) site to upgrade from SFW HA 5.0.x to
5.1.
See the procedure below:
“Preparing VVR on the secondary (DR) site for upgrade.”

■

Prepare the VCS cluster on the secondary site for upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 169.

■

Upgrade the cluster nodes on the secondary site to SFW HA 5.1.
See “Backing up customized type definitions” on page 180.

■

Re-enable VVR on the upgraded secondary site.
See “Re-enabling VVR after the upgrade” on page 192.

■

Once the secondary (DR) site has been upgraded, prepare the primary site
for upgrade. The procedure includes migrating the primary role to the DR
site.
See “Preparing the primary site for upgrade” on page 174.

■

Prepare the VCS cluster on the old primary site (now the secondary site) for
upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 169.

■

Upgrade the nodes on the old primary site to SFW HA 5.1.
See “Backing up customized type definitions” on page 180.

■

Re-enable VVR on the upgraded site. The topic includes a procedure for
migrating the applications back to the original primary site.
See “Re-enabling VVR after the upgrade” on page 192.

Preparing VVR on the secondary (DR) site for upgrade
When preparing VVR for upgrade from SFW HA 5.0.x to 5.1, you begin by
preparing the secondary site.
To prepare the secondary (DR) site
1

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>
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2

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
3

If the existing replication settings are configured to use TCP, change the
settings to use UDP. After both the primary and DR sites are upgraded to 5.1,
you can switch the replication settings back to TCP.
After you have completed these secondary site preparation steps, continue
with the following procedures in sequence:
■

Preparing the VCS cluster on the secondary site for upgrade.

■

Upgrading the secondary site nodes to SFW HA 5.1

■

Re-enabling VVR on the secondary site

■

Preparing the primary site for upgrade

Preparing the primary site for upgrade
After upgrading the DR site to SFW HA 5.1 and re-enabling VVR on that site, you
prepare the primary site for upgrade. The procedure steps first use the remote
switch operation to migrate the applications to the current secondary site, thus
switching the roles so that the primary site becomes the secondary. You then
prepare VVR for upgrade.
To prepare the primary site
1

In the Service Groups tab of the Cluster Manager, right-click the application
service group that is online at the primary site.

2

Click Switch To, and click Remote switch.

3

In the Switch global group dialog box, click the cluster of the secondary
siteto switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.

5

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on the options
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available in your environment, these tasks may include mounting the
databases or manually starting the application.
Once the applications are online, the sites have now switched roles, so that
the former secondary site is now the primary site, and the old primary has
the role of the secondary.
Therefore, on the old primary (now the secondary) complete the following
steps, which are the same as when preparing the original secondary site for
the upgrade.
6

Take the RVG resource offline
■

From the Cluster Manager console, right-click the RVG resource and
click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

7

Offline the Disk Group and IP resources
■

From the Cluster Manager console, right-click the Disk Group resource
and click Offline.
Or

■

From the command line, type
hares -offline <resource_name> -sys <system_name>

Repeat the above step to offline the IP resource.
Warning: Taking the DG (Disk Group) resource offline will pause replication,
and if applications continue to run on the primary for too long, this may
cause a possible replicator log overflow.
You can then continue with the following procedures in sequence:
■

Preparing the cluster for upgrade

■

Upgrading the cluster nodes to SFW HA 5.1

■

Re-enabling VVR

■

Migrating the applications back to the original primary site

Preparing to add DMP DSMs to the upgraded environment
If you do not have DMP DSMs in your existing environment, but plan to add this
feature while upgrading to SFW 5.1, add the host adapter hardware before
performing the upgrade.
Refer to the Hardware Compliance List on the Symantec Support web site at
http://www.symantec.com/business/support/index.jsp to determine the
approved hardware for SFW.
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For more information on the hardware and software prerequisites for DMP DSM
installation, see the following:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on page 61.

■

Veritas Storage Foundation Administrator’s Guide.

Connect no more than one path from the new host adapters to the array storage
before upgrading to SFW and installing DMP DSMs. Select the DMP DSM option
or the appropriate DMP DSMs while running the installer.

Preparing an existing DMP environment for upgrading
Previous DMP environments are either DMP DSM or DMP ASL. The
preparations for upgrade are different for each.

DMP DSM environment
If you are preparing to upgrade an existing DMP DSM environment, it is
recommended to physically disconnect all but one path of the multipath storage
to shorten upgrade time.
No other DMP preparation is required except as follows.
In upgrading from 4.3.x, in the following cases only, you must uninstall DMP
DSM before the upgrade (and reinstall it during the upgrade):
■

SFW 4.3 with DMP option installed and no SFW 4.3 DDI-x has ever been
applied

■

SFW 4.3 DMP with DDI-1, DDI-3 or DDI-4 installed

Before uninstalling DMP DSM from a node in a cluster environment, the cluster
resources should be moved to another node.
To uninstall the DMP or the DDI package
1

Make sure that only one path is attached for each array managed by DMP
DSM.

2

Open the Windows Add/Remove Programs to uninstall the DDI. Select the
Symantec support for DMP DSM entry and click Remove to begin the
uninstallation.

3

Reboot the system when the uninstall process completes.

DMP ASL environment
DMP ASLs are no longer supported on SFW 5.1. Therefore, you must uninstall
DMP ASLs before the upgrade to 5.1.
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It is important that you detach all but the primary path to the array storage
before you uninstall.
Warning: Failure to limit DMP ASLs to a single path before uninstalling can lead
to data corruption.

Warning: Always back up your data before upgrading.
To prepare an existing DMP ASL environment for upgrade
1

Physically remove all but the primary path from each multiple-path array.

2

In the VEA, exclude each multiple-path array from DMP ASLs management.
■

In the tree view under the Disks folder, select a disk from the storage
array that you are excluding.

■

In the right pane, click the Paths tab for the disk.

■

Right-click a path and select Array Settings from the path context
menu that appears.

■

In the Array Settings screen, check the Exclude check box.

■

Click OK. The array is now excluded from DMP control.

3

Select Actions > Rescan from the VEA menu bar. Veritas Storage Foundation
for Windows rescans the array and updates the display.

4

Uninstall the DMP ASLs using the Add or Remove function through the
installer.
See “Adding or removing features” on page 56.

5

After the uninstall process is complete, reboot the system.

6

If you want to install DMP DSMs during the upgrade, review the following
information for more information on prerequisites for DMP DSMs:
■

“Installing and uninstalling Veritas Dynamic Multi-pathing” on
page 61.

■

Veritas Storage Foundation Administrator’s Guide.
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Removing VCS Management Console
If one or more nodes in the cluster have Veritas Cluster Server Management
Console 5.1 installed, you must remove the management console before
upgrading SFW HA. You can reinstall the management console after the
upgrade.
See “Reinstalling VCS Management Console 5.1” on page 185.
To remove VCS Management Console 5.1
1

Stop the VCS Management Console. If the management console is clustered,
take the CMC_MS service group offline.

2

Back up the console’s data directory and datadir.conf files. Typically, the
files are located at the following paths:
■

C:\Program Files\Symantec\VRTScmcm

or
■

3

C:\Program Files (x86)\Symantec\VRTScmcm

Remove VCS Management Console 5.1 from all nodes in the cluster using
Windows Add/Remove Programs.

Preparing the VCS cluster for the upgrade
Complete the following procedures to prepare the VCS cluster before the
upgrade.

Saving and closing the cluster configuration
Before starting the upgrade process, use the VCS Java Console to “save and
close” the VCS configuration. This operation involves saving the latest
configuration to disk and changing the configuration state to read-only mode.
You must also stop VCS before attempting the upgrade process. In a VVR
environment, perform these steps on both the VVR primary and secondary
clusters.
To save and close the configuration
■

From the VCS Java Console, click Save and Close Configuration on the
Cluster Explorer toolbar.
or

■

From the command prompt, type:
C:\>haconf -dump -makero
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Taking the service groups offline
Take all service groups in the cluster offline before the upgrade.
To bring the service group offline
1

From the command prompt, type:
C:\> hagrp -offline group_name -sys system_name

Where group_name is the name of the service group and system_name is the
node where the group is online.
2

Repeat this command for all service groups that are online.

Closing SFW HA clients
Exit all instances of the Veritas Enterprise Administrator (VEA), Cluster
Manager (Java Console), and Cluster Management Console (Single Cluster Mode)
before the upgrade.
■

From the VEA, click File > Exit and then click Yes on the confirmation dialog
box.

■

From the Cluster Manager (Java Console), click File > Logout on the Cluster
Explorer window and then click File > Exit on the Cluster Monitor window.

■

For CMC, click Logout on the title bar of the Cluster Management Console.

Stopping VCS services
Stop the VCS services before the upgrade.
To stop VCS services
1

Stop HAD on all the cluster nodes. Type the following on the command
prompt:

C:\>hastop -all -force
2

Stop the Veritas VCSComm Startup service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop vcscomm
3

Stop the Veritas Command Server service on all the cluster nodes. Type the
following on the command prompt:

C:\>net stop cmdserver
4

Stop GAB and LLT on all the cluster nodes. Type the following on the
command prompt:

C:\>net stop gab
C:\>net stop llt
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5

Stop the Veritas Enterprise Administrator Service on all the cluster nodes.
Type the following on the command prompt:

C:\>net stop vxob
6

Stop the Windows Indexing Service:

C:\>net stop cisvc
7

If upgrading from SFW HA 5.0.x, stop the Symantec Private Branch
Exchange service, Veritas Storage Agent, Veritas GridNode, and the Veritas
Action Agent services on all the cluster nodes. Type the following
commands on the command prompt:

C:\>net
C:\>net
C:\>net
C:\>net

stop
stop
stop
stop

VRTSpbx
vxvm
vxgn
actionagent

Backing up customized type definitions
The cluster type definitions are reset to their default values after the upgrade. If
you have modified the values of type definitions in the cluster, make a backup
copy of the types.cf file before the upgrade. The types.cf file is typically
located at %VCS_HOME%\conf\config.
The variable %VCS_HOME% is the default installation directory for VCS, typically
C:\Program Files\VERITAS\Cluster Server.
After you complete the upgrade, refer to the backup copy of the types.cf file
and use the Cluster Manager (Java Console) to change the type definition default
values with the values you had originally set in the cluster.
Note: After the upgrade, do not replace the types.cf file with the backup copy.
Use the backup copy only as a reference for the customized type definition
values in the cluster.

Upgrading to SFW HA 5.1
The installer automatically upgrades SFW 4.3, 4.3 MP1, 4.3 MP2, 5.0, or 5.0 RP1
to SFW HA 5.1. If the cluster has VCS enterprise agents and options, make sure
to select the same enterprise agents and options while upgrading to SFW HA 5.1.
If you do not want to include the enterprise agents and options in the upgraded
cluster, uninstall the agents from the cluster before proceeding.
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Changing driver signing options
Depending on the installation options you select, some Symantec drivers may
not be signed. When installing on systems running Windows Server 2003, you
must set the Windows driver signing options to allow installation.
Table 6-2 describes the product installer behavior on local and remote systems
when installing options with unsigned drivers.
Table 6-2

Installation behavior with unsigned drivers

Driver Signing
Setting

Installation behavior on the
local system

Installation behavior on
remote systems

Ignore

Always allowed

Always allowed

Warn

Warning message, user
interaction required

Installation proceeds. The user
must log on locally to the
remote system to respond to
the dialog box to complete the
installation.

Block

Never allowed

Never allowed

On local systems set the driver signing option to either Ignore or Warn. On
remote systems set the option to Ignore in order to allow the installation to
proceed without user interaction.
To change the driver signing options on each system
1

Log on locally to the system.

2

Open the Control Panel and click System.

3

Click the Hardware tab and click Driver Signing.

4

In the Driver Signing Options dialog box, note the current setting, and select
Ignore or another option from the table that will allow installation to
proceed.

5

Click OK.

6

Repeat for each computer.
If you do not change the driver signing option, the installation may fail on
that computer during validation. After you complete the installation, reset
the driver signing option to its previous state.
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Upgrading the software
Use the product installer to upgrade the software.
To upgrade the product using the installer
1

Allow the autorun feature to start the installation or double-click Setup.exe.

2

Choose the default language for your installation and click OK. The
Symantec product selection screen appears.

3

Click Storage Foundation HA 5.1 for Windows.

4

Click Complete/Custom to begin installation. The Administrative Console
link allows you to install only the Client components.

5

Review the welcome message and click Next.

6

If you agree to the terms of the license agreement, click Next.

7

Enter the license key for each Symantec product option that you are
upgrading or installing in the top field.

8

To add a key, click Add.
To remove a key, click the key to select it, and click Remove.

9

Repeat step 7 and step 8 for each Symantec product and feature that you
want to install. Click a key to see its details.

10 Click Next.
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11 Select the appropriate Storage Foundation HA options and click Next. If any
previous VCS agents and options are installed on the node, make sure you
select the same agents and options while upgrading. If you do not want to
include the agents and options in the upgraded cluster, uninstall them from
the cluster before proceeding.
12 Select the domain and the computers for the upgrade and click Next.

Domain

Select a domain from the list.
Depending on domain and network size, speed, and
activity, the domain and computer lists can take some
time to populate.

Computer

To add a computer for installation, select it from the
Computer list or type the computer’s name in the
Computer field. Then click Add.
To remove a computer after adding it, click the name
in the Selected computers for installation field and
click Remove.
Click a computer’s name to see its description.

Install Path

The install path cannot be changed for the upgrade.

13 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next. Note that the
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Install Type for the nodes is listed as Upgrade. If an error occurs, address the
problem described in the Details box, click Validate Again, and click Next.
14 If applicable, at the Veritas Dynamic Multi-pathing warning, do the
following:
For DMP DSMs installations—the time required to install the Veritas
Dynamic Multi-pathing DSMs feature depends on the number of
physical paths connected during the installation. To reduce installation
time for this feature, connect only one physical path during
installation. After installation, reconnect additional physical paths
before rebooting the system.
Click OK.
■

15 Review the pre-upgrade summary. Click Back to make changes if necessary.
Click Install.
16 If the installation is successful on all nodes, the installer automatically
proceeds to the summary page.
Click Next after the progress indicator shows the installation is complete to
proceed to the summary report in order to review the details of the failed
installation. Note that if a security alert asks you to accept the Symantec
driver software, click Yes.
17 Review the installation report, taking action where necessary, and click
Next.
18 Reboot the remote computers. Note that you cannot reboot the local
computer now, and that failed computers are unchecked by default. Select
the upgraded remote computers and click Reboot.
Wait for the remote computer to come back online. Click Next.
19 Click Finish.
20 Click Yes to reboot the local node.

Resetting the driver signing options
After completing the installation sequence, reset the driver signing options on
each computer.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.
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4

Click OK.

5

Repeat for each computer.

Optional tasks after an upgrade to SFW HA 5.1
The following tasks are optional depending on your cluster configuration.
■

“Reinstalling VCS Management Console 5.1” on page 185

■

“Including custom resources in the upgraded cluster” on page 186

■

“Configuring a secure cluster” on page 187

■

“Adding a GCO resource to the ClusterService group” on page 188

■

“Establishing secure communication within the global cluster” on page 188

■

“Configuring the VxSAS service (VVR only)” on page 190

■

“Re-enabling VVR after the upgrade” on page 192

■

“Reconnecting DMP DSM paths after the upgrade” on page 195

■

“Upgrading dynamic disk groups” on page 195

■

“Upgrading from Microsoft SQL Server 2000 to SQL Server 2005” on
page 196

In addition, you may want to upgrade a SQL Server service pack. For
information on upgrading service packs, see the following chapter:
■

Chapter 7, “Microsoft Service Pack upgrades” on page 199

Reinstalling VCS Management Console 5.1
If you uninstalled VCS Management Console earlier according to the procedures
for preparing for the upgrade, you can now reinstall it.
To re-install VCS Management Console
1

Install VCS Management Console 5.1.
Refer to the Veritas Cluster Server Management Console Implementation
Guide.

2

Restore the backed up VCS Management Console 5.1 data files.
See “Removing VCS Management Console” on page 178.

3

Start the VCS Management Console. If the management console is clustered,
bring the CMC_MS service group online.
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Including custom resources in the upgraded cluster
The VCS Configuration Wizard does not upgrade custom resources. If a service
group in the previous configuration contains custom resources, the wizard does
not include the service group in the upgraded cluster.
To include a service group with custom resources in the upgraded cluster
1

Make sure the agent binaries for the custom agent are available under
%VCS_HOME%\bin where the variable %VCS_HOME% represents the VCS
installation directory, typically C:\Program Files\Veritas\cluster
server.

2

Stop the VCS engine (HAD) on all the nodes in the cluster. From the
command prompt, type:
C:\> hastop -all -force

3

During installation of the SFW HA 5.1 software, the installer copies
previous configuration files to a backup location. Locate the backed up
types.cf and main.cf files: C:\Documents and Settings\All
Users\Application Data\Veritas\cluster server\vpibackup.

4

Copy the resource type definition for the custom resource from the backed
up types.cf and add it to the types.cf file for the VCS 5.1 cluster.

5

Copy the service group configuration containing the custom resource from
the backed up main.cf and add it to the main.cf file for the VCS 5.1 cluster.

6

If resources for a custom resource type are dependent on resources for
agents bundled with VCS 5.1, you must update the resource definition of the
VCS bundled agent to include the new attributes or remove the deprecated
attributes.
For information on new and deprecated attributes see the Veritas Storage
Foundation and High Availability Solutions 5.1 Release Notes.
For information on the attribute values and descriptions see the Veritas
Cluster Server 5.1 Bundled Agents Reference Guide.

7

Verify the configuration. Type:
C:\> hacf -verify config_directory
The variable config_directory refers to the path of the directory
containing the main.cf and types.cf.

8

Start the VCS engine (HAD) on the node where you changed the
configuration. Type the following at the command prompt:

C:\> hastart
9

Start the VCS engine (HAD) on all the other cluster nodes.
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Configuring a secure cluster
If you want to configure a secure cluster, you must reconfigure the cluster using
the VCS Configuration Wizard.
To configure a secure cluster
1

Click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > Cluster Configuration Wizard.

2

The Welcome screen appears. Click Next.

3

The Configuration Options screen appears. Select Cluster Operations. Click
Next.

4

The Domain Selection screen appears. Enter a domain name or select one
from the list. Click Next.

5

The System Selection screen appears. Enter a system name and click Add or
select a system from the list and click the arrow button to add it to the
Selected System list. Click Next.

6

The Cluster Configurations Options screen appears. Select Edit Existing
Cluster. Click Next.

7

The Cluster Selection screen appears. Select the cluster name from the
displayed list of clusters. Click Next.

8

The Edit Cluster Options screen appears. Select Reconfigure. Click Next.

9

Enter the username and password for the cluster in the Cluster User
Information Dialog.

10 Select Configure/Change Veritas Security Services (Single Sign-On). Click
Next.
11 Select Change Symantec Product Authentication Service Configuration
(Change Root Broker).
■

Select Specify Symantec Product Authentication Service Root broker
system and enter a system name and click Next or

■

Select Discover the Symantec Product Authentication Service Root
broker system in the domain and click Scope.
■

Select the Entire Domain or Specify Scope and select an
organizational unit.

■

If needed, select a property, such as a system name to use as a filter
in the Filter Criteria field and click OK. Click Next.

See the Veritas Cluster Server 5.1 Administrator’s Guide.
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Adding a GCO resource to the ClusterService group
VCS 5.1 provides the Global Cluster Option to enable a collection of VCS clusters
to work together for wide-area disaster recovery.
See the Veritas Cluster Server 5.1 Administrator’s Guide.

Establishing secure communication within the global cluster
A global cluster is created in non-secure mode by default. If the local clusters are
running in secure mode, you may continue to allow the global cluster to run in
non-secure mode or choose to establish secure communication between clusters.
The following prerequisites are required for establishing secure communication
within a global cluster:
■

The clusters within the global cluster must be running in secure mode.

■

You must have Administrator privileges for the domain.

The following information is required for adding secure communication to a
global cluster:
■

The active host name or IP address of each cluster in the global
configuration.

■

The user name and password of the administrator for each cluster in the
configuration.

■

If the local clusters do not point to the same root broker, the host name and
port address of each root broker.

Adding secure communication involves the following tasks:
■

Taking the ClusterService-Proc (wac) resource in the ClusterService group
offline on the clusters in the global environment.

■

Adding the -secure option to the StartProgram attribute on each node.

■

Establishing trust between root brokers if the local clusters do not point to
the same root broker.

■

Bringing the ClusterService-Proc (wac) resource online on the clusters in the
global cluster.

To take the ClusterService-Proc (wac) resource offline on all clusters
1

From Cluster Monitor, log on to a cluster in the global cluster.

2

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

3

Right-click the ClusterService-Proc resource, click Offline, and click the
appropriate system from the menu.
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4

Repeat step 1 to step 3 for the additional clusters in the global cluster.

To add the -secure option to the StartProgram resource
1

In the Service Groups tab of the Cluster Explorer configuration tree, rightclick the ClusterService-Proc resource under the Process type in the
ClusterService group.

2

Click View, and then Properties view.

3

Click the Edit icon to edit the StartProgram attribute.

4

In the Edit Attribute dialog box, add -secure switch to the path of the
executable Scalar Value. For example:

C:\Program Files\Veritas\Cluster Server\bin\wac.exe secure
5

Repeat step 4 for each system in the cluster.

6

Click OK to close the Edit Attribute dialog box.

7

Click the Save and Close Configuration icon in the tool bar.

8

Repeat step 1 to step 7 for each cluster in the global cluster.

To establish trust between root brokers if there is more than one root broker
◆

Establishing trust between root brokers is only required if the local clusters
do not point to the same root broker.
Log on to the root broker for each cluster and set up trust to the other root
brokers in the global cluster. The complete syntax of the command is:
vssat setuptrust --broker <host:port> --securitylevel
<low|medium|high> [--hashfile <filename> | --hash <root
hash in hex>]
For example, to establish trust with a low security level in a global cluster
comprised of Cluster1 pointing to RB1 and Cluster2 pointing to RB2:
from RB1, type:
vssat setuptrust --broker RB2:14141 --securitylevel low
from RB2, type:
vssat setuptrust --broker RB1:14141 --securitylevel low

To bring the ClusterService-Proc (wac) resource online on all clusters
1

In the Service Groups tab of the Cluster Explorer configuration tree, expand
the ClusterService group and the Process agent.

2

Right-click the ClusterService-Proc resource, click Online, and click the
appropriate system from the menu.

3

Repeat step 1 and step 2 for the additional clusters in the global cluster.
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Configuring the VxSAS service (VVR only)
If you upgraded or installed the Volume Replicator (VVR) option, you can launch
the wizard for Veritas Volume Replicator Security Service (VxSAS) after the
SFW HA installation to configure security services for all nodes. This step is
required for VVR if you are upgrading from 4.3 versions. If you are upgrading
from 5.0.x and VxSAS was already configured for 5.0.x, you do not need to
configure it again.
Complete the following procedure to configure the VxSAS service for VVR.
The procedure has these prerequisites:
■

You must be logged on with administrative privileges on the server for the
wizard to be launched.

■

The account you specify must have administrative and log-on as service
privileges on all the specified hosts.

■

Avoid specifying blank passwords. In a Windows Server 2003 environment,
accounts with blank passwords are not supported for log-on service
privileges.

■

Make sure that the hosts on which you want to configure the VxSAS service
are accessible from the local host.

Note: The VxSAS wizard will not be launched automatically after installing SFW
or SFW HA. You must launch this wizard manually to complete the VVR security
service configuration. For details on this required service, see Veritas Storage
Foundation Veritas Volume Replicator, Administrator’s Guide.
To configure the VxSAS service
1

To launch the wizard, select Start > All Programs > Symantec > Veritas
Storage Foundation > Configuration Wizards > VVR Security Service
Configuration Wizard or run vxsascfg.exe from the command prompt of
the required machine.
The Welcome page appears. This page displays important information that
is useful as you configure the VxSAS service. Read the information provided
on the Welcome page and click Next.

2

Complete the Account Information wizard page as follows:
Account name
(domain\account)

Enter the administrative account name in the Account name
field.

Password

Specify a password in the Password field.
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If you have already configured the VxSAS service for one host that is
intended to be a part of the RDS, then make sure you specify the same
username and password when configuring the VxSAS service on the other
hosts.
After providing the required information click Next.
3

Select the required domain to which the hosts that you want to configure
belong, from the Domain Selection wizard page.
Selecting Domains

The Available Domains pane lists all the domains that are
present in the Windows network neighborhood.
Select the required domain by moving the appropriate
name from the Available Domains pane to the Selected
Domains pane, either by double-clicking it or using the
arrow button.

Adding a Domain

If the domain name that you require is not displayed, then
add it by using the Add Domain option. This displays a
dialog that allows you to specify the domain name. Click
Add to add the name to the Selected Domains list.

After specifying the domain, click Next.
4

Select the required hosts from the Host Selection page.
Selecting Hosts

The Available Hosts pane lists the hosts that are present in
the specified domain.
Select the required host by moving the appropriate name
from the Available Hosts list to the Selected Hosts list,
either by double-clicking it or using the arrow button. Use
the Shift key with the up or down arrow keys to select
multiple hosts.

Adding a Host

If the host name you require is not displayed, then add it
using the Add Host option. In the Add Host dialog specify
the required host name or IP in the Host Name field. Click
Add to add the name to the Selected Hosts list.

After you have selected a host name, the Configure button is enabled. Click
Configure to proceed with configuring the VxSAS service.
5

After the configuration completes, the Configuration Results page is
displayed. If the operation is successful then the Status column displays the
appropriate message to indicate that the operation was successful.
If the operation was not successful then the page displays the status as
failed and the corresponding details on why the account update failed. It
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also displays the possible reasons for failure and recommendations on
getting over the failure.
Click Back to change any information you had provided earlier.
6

Click Finish to exit the wizard.

Re-enabling VVR after the upgrade
After upgrading an environment where VVR replicates data from a primary site
to a secondary site, use the appropriate procedures to re-enable VVR replication:
■

“Re-enabling VVR after the upgrade from 4.3.x versions to 5.1.”

■

“Re-enabling VVR after the upgrade from 5.0.x versions to 5.1.”

Re-enabling VVR after the upgrade from 4.3.x versions to 5.1
Follow the procedures in the order given while re-enabling from 4.3.x versions
to 5.1.
Warning: A full autosynchronization will be required if the procedures listed
below are not performed in the given order.
To enable the updated objects
1

Bring the Disk Group Resource online.
■

From the Cluster Manager (Java Console), right-click the Disk Group
Resource and click Online.

or
■

2

From the command line, type
hares -online <resource_name> -sys <system_name>

Bring the VVR IP Resource online:
■

From the Cluster Manager (Java Console), right-click the VVR IP
Resource and click Online.

or
■

From the command line, type
hares -online <resource_name> -sys <system_name>
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3

Re-associate the Replicator Log volume.
■

From the VEA console: On the primary site, expand the RDS to which
you want to associate the Replicator Log volume. Right-click the
primary RVG, and click the Associate Replicator Log option. Select the
correct Replicator Log volume from the dialog box and click OK.

or
■

From the command line, type
vxrvg [-g <diskgroup_name>] aslog <rvg_name>
<volume_name>

4

To attach the RLINK, open a command prompt and run the following
command:
vxrlink -f att RLINK

5

Repeat steps 1-3 on the secondary site.

6

On both the primary and the secondary site, bring the RVG service group
online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.

or
■

7

From the command line, type
hagrp -online <group_name> -sys <system_name>

On the primary site, bring the application service group online.
■

From the Cluster Manager (Java Console), right-click the application
service group and click Online.

or
■

8

From the command line, type
hagrp -online <group_name> -sys <system_name>

If bringing the service groups online does not start the application, perform
any necessary tasks to start the application. Depending on options in your
environment, these tasks may include mounting databases or manually
starting the application.
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Re-enabling VVR after the upgrade from 5.0.x versions to 5.1
After upgrading the cluster nodes from 5.0.x to 5.1, re-enable VVR on the
upgraded site. The site is in the secondary role during the upgrade and when reenabling VVR.
To enable the updated objects on the secondary site
1

Bring the Disk Group Resource online on the secondary site
■

From the Cluster Manager (Java console), right-click the Disk Group
Resource and click Online.
Or

■

From the command line, type
hares -online <resource_name> -sys <system_name>

2

Bring the RVG service group online.
■

From the Cluster Manager (Java Console), right-click the RVG service
group and click Online.
Or

■

From the command line, type
hagrp -online <group_name> -sys <system_name>

Note: For VVR environments with multiple secondary sites, any
operations that need to be performed on a secondary site should be
repeated on all secondary sites.
If you are performing this procedure on the original secondary site, go to
the procedure to prepare the primary site for upgrade.
See “Preparing the primary site for upgrade” on page 174
If you have completed the upgrades on both the primary and secondary
sites, you can now migrate the applications back to the original primary.
See the following procedure, “Migrating the applications back to the
original primary site.”

Migrating the applications back to the original primary site
Once you have upgraded both the primary and the secondary sites, you may
want to switch back the applications to the site that was primary before the
upgrade.
To migrate the applications back to the original primary
1

In the Service Groups tab of the Cluster Manager, right-click the Application
service group that is online at the current primary site.

2

Click Switch To, and click Remote switch.
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3

In the Switch global group dialog box, click the cluster of the original
primary to switch the group.

4

Click the specific system where you want to bring the global application
service group online. Then click OK.

Reconnecting DMP DSM paths after the upgrade
After you complete the upgrade for an existing DMP DSM environment, or if you
have added DMP DSMs during the upgrade:
1

Physically connect any additional paths to the DMP DSM array that were
disconnected before the upgrade.

2

In the VEA, rescan the disks.

Upgrading dynamic disk groups
If your previous installation included Volume Manager 4.x, upgrade the disk
group types to make use of the current program features.
See the Veritas Storage Foundation 5.1 Administrator’s Guide.
Note: If you upgrade a disk group to SFW HA 5.1, you cannot import it to
another server that is running an earlier version of Volume Manager or Disk
Management. After upgrading a disk group, the group cannot revert to an
earlier version.
To upgrade a dynamic disk group version
1

In the tree view, right-click the disk group you want to upgrade and select
Upgrade Dynamic Disk Group Version.

2

Click Yes to upgrade the dynamic disk group.
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Upgrading from Microsoft SQL Server 2000 to SQL
Server 2005
If you are upgrading Microsoft SQL Server as well as upgrading SFW HA, use the
following sequence:
■

Upgrade SQL Server on the primary node

■

Upgrade SQL Server on each additional node

■

Create the SQL Server 2005 service group

■

Upgrade SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0, or 5.0 RP1 to SFW HA 5.1

Note: If the SQL 2005 services are running under an account which is not a
member of either the domain admins group, the local administrators group on
the cluster nodes, or a group with equivalent access rights on the nodes, the SQL
services will only start on the last node installed.
For a workaround, see the following:
http://seer.entsupport.symantec.com/docs/281828.htm
For instructions on setting up SQL Server 2005 for high availability in a new
deployment, see the Veritas Storage Foundation and High Availability Solutions
HA and Disaster Recovery Solutions Guide for Microsoft SQL.
To upgrade SQL Server 2000 SP4 to SQL Server 2005, complete the following
steps. Start with the primary node in the cluster; you will have to follow the
steps for each node in the cluster.
To upgrade SQL Server on the primary node
1

Bring online the SQL 2000 service group resources up to the SQL Server
2000 resource. Right-click each resource and select Online. Click Yes in the
confirmation pop-up to bring the resource online.
This action brings online the disks, volumes, and IP address associated with
SQL Server.

2

Right-click the SQL Server service group in tree view and click Freeze >
Persistent.

3

Back up the SQL Server 2000 (MSSQL) and Registry (RegRep) folders on the
shared disk by making a copy of each.

4

Start SQL Server 2000 under a local node context. Click Start > Run and type
services.msc.

5

In the Services panel, find MSSQLServer, right-click it, and select Start.

Upgrading a SQL Server cluster
Upgrading from Microsoft SQL Server 2000 to SQL Server 2005

6

Launch the Microsoft SQL Server 2005 installer and proceed through the
installation process.
Make sure that you select the option to upgrade the existing instance(s)
when prompted to do so. This action automatically places the data files in
the proper location.
Note: Depending on the circumstances, an in-place upgrade may not be
suitable for your environment. Refer to Microsoft documentation before
beginning any SQL Server upgrade.
Refer to your Microsoft SQL Server 2005 documentation for more detailed
instructions on installing Microsoft SQL Server.

7

Reboot the node if requested to do so when the installation completes.

8

Unfreeze and bring offline the service group on the primary node if you did
not reboot. (Rebooting automatically brings the service group offline.)

Once you have completed the upgrade procedure on the primary node, you must
perform the following steps on each additional node in the cluster.
To upgrade SQL Server on each additional node
1

Bring online the SQL 2000 service group resources up to the SQL Server
2000 resource, but do not online the regrep resources. Right-click each
resource and select Online. Click Yes in the confirmation pop-up to bring the
resource online.

2

Restore the copies of the SQL Server 2000 (MSSQL) and Registry (RegRep)
folders on the shared disk. Delete the original MSSQL and RegRep folders.

3

Bring online the regrep resources (right-click and select Online).

4

In the tree view, freeze the service group (right-click and select Freeze >
Persistent).

5

Start SQL Server 2000 under a local node context. Click Start > Run and type
services.msc.

6

In the Services panel, find MSSQLServer, right-click it, and select Start.

7

Launch the Microsoft SQL Server 2005 installer and proceed through the
installation process.
Make sure that you select the option to upgrade the existing instance(s)
when prompted to do so. This action automatically places the data files in
the proper location.
Refer to your Microsoft SQL Server 2005 documentation for more detailed
instructions on installing Microsoft SQL Server.

8

Reboot the node if requested to do so when the installation completes.
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9

Unfreeze and bring offline the service group on the secondary or additional
node if you did not reboot. (Rebooting automatically brings the service
group offline.)

Once you have completed upgrading all of the nodes in the SQL Server cluster,
continue with creating the service group.
To create the SQL Server 2005 service group
1

On the primary node, bring online the VMdg and MountV resources from
the SQL2000 service group. Right-click the resource, select Online, and
select the primary node.

2

Delete the existing SQL2000 service group (in tree view). Right-click the
service group and select Delete. Click Yes when asked to confirm if you want
to delete the service group.

3

Create the SQL2005 service group using the SQL Server Configuration
Wizard. Click Start > All Programs > Symantec > SQL Server Configuration
Wizard.
See the Veritas Storage Foundation and High Availability Solutions HA and
Disaster Recovery Solutions Guide for Microsoft SQL for instructions on how
to use the wizard.

4

Test switch the service group to the secondary node (or any additional node
in the cluster). Right-click the service group in tree view, select Switch To,
and select any additional node in the cluster.

Proceed with upgrading SFW HA. See “Backing up customized type definitions”
on page 180 for detailed steps on using the installer to upgrade to SFW HA 5.1.
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Microsoft Service Pack
upgrades
This chapter contains:
■

Configuring Microsoft Exchange 2003 SP2 in a VCS environment

■

Configuring Microsoft Exchange 2007 SP1 in a VCS environment

■

Configuring Microsoft SQL 2000 service pack 4 in a VCS environment

■

Configuring Microsoft SQL 2005 service pack 2 in a VCS environment

Configuring Microsoft Exchange 2003 SP2 in a VCS
environment
This section covers configuring Microsoft Exchange 2003 SP2 in a VCS
environment, if you already have Microsoft Exchange 2003 installed and you
want to apply Exchange 2003 SP2.
For information on upgrading an Exchange cluster to SFW HA 5.1 see
Chapter 5, “Upgrading an Exchange Server cluster” on page 135.
Before upgrading to Microsoft Exchange 2003 SP2, make sure to set the
"DetailMonitor" attribute of all "ExchService" type resources to zero.
Perform the following steps to upgrade an Exchange 2003 installation on a node
that is part of the Exchange service group. Make sure that all the nodes which
are part of the Exchange service group have the same version and service pack
level of Microsoft Exchange.
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To upgrade to Microsoft Exchange 2003 SP2
Make sure that you do not mount the Exchange databases on the failover nodes.
1

Bring the Exchange service group online on the node where you are
upgrading the Exchange installation.

2

Stop HAD on the node where the service group was brought online. At the
command prompt, type:

C:\> hastop -local -force
3

Install Microsoft Exchange 2003 SP2 on the node where the service group
was brought online.

4

Start HAD on the node. At the command prompt, type:

C:\> hastart
5

After the Exchange service group comes online, take the service group
offline.

6

Restart the Windows Management Instrumentation (WMI) service from the
Services snap-in.

7

Repeat step 1 through step 6 on all remaining nodes that are part of the
Exchange service group.

8

Update the ExchConfig registry information on every system where
Exchange is upgraded.
■

To update the registry on the local system, navigate to
%vcs_home%\bin\ExchSetup folder and type the following at the
command prompt:

Setup.exe /UpdateExchVersion
■

To update the registry on more than one node simultaneously, navigate
to %vcs_home%\bin\ExchSetup folder and type the following at the
command prompt:

Setup.exe /UpdateExchVersion system_name1
system_name2 ...
Here, system_name1, system_name2 are the cluster node names.
9

This completes the upgrade. You can now bring the Exchange service group
online in the cluster.
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Configuring Microsoft Exchange 2007 SP1 in a VCS
environment
This section describes how to upgrade Exchange 2007 to Exchange 2007 SP1
using the Exchange 2007 Upgrade Wizard. It is applicable only if you already
have Exchange 2007 set up in a VCS cluster environment.
For information on upgrading an Exchange cluster to SFW HA 5.1 see
Chapter 5, “Upgrading an Exchange Server cluster” on page 135.
To configure a new HA and DR environment for Exchange 2007, refer to the
Veritas Storage Foundation and High Availability Solutions HA and Disaster
Recovery Solutions Guide for Microsoft Exchange 2007.
Before you proceed with the Exchange 2007 upgrade to SP1, note the following:
■

Ensure that the Exchange 2007 service group is offline in the cluster.

■

While performing the upgrade the Exchange 2007 Upgrade Wizard renames
and then restarts the cluster node. Exit all the other programs before you
run the wizard on a cluster node.

Complete the following steps on all cluster nodes that are part of the Exchange
2007 service group, one node at a time.
To upgrade Exchange 2007 to Exchange 2007 SP1
1

On one of the cluster nodes, click Start > All Programs > Symantec > Veritas
Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard to
start the Exchange 2007 Upgrade wizard.

2

Review the information on the Welcome panel and click Next.

3

On the Exchange Virtual Server Selection panel, select the Exchange virtual
server that you wish to upgrade and then click Next.
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The Summary table provides the details of the Exchange virtual servers in
the cluster and their upgrade status on each cluster node.

4

The wizard performs the tasks required to set up the VCS environment for
the Exchange upgrade. The Tasks table displays the progress of the various
tasks. After all the tasks are completed, click Next.

5

Review the information on the Cluster Node Reboot panel and then click
Reboot. The wizard prompts you to reboot the node. Click Yes to reboot the
node.
The Exchange virtual server name is temporarily assigned to the cluster
node. On rebooting the node, the Exchange 2007 Upgrade Wizard is
launched automatically with a message that the Exchange pre-upgrade
tasks are complete. Do not click Continue at this time. Wait until after the
Exchange upgrade is complete.

6

Run the Exchange 2007 SP1 installer to upgrade Exchange 2007 on the
node. Type the following at the command prompt:

<drive letter>:\setup.com /mode:Upgrade
Here <drive letter> is the drive where the Exchange SP1 installer is
located.
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Note: You can also run Setup.exe to launch the installer GUI for upgrading
Exchange. If using the installer GUI, ensure that you do not select any other
Exchange 2007 server role. Only the Mailbox server role must be upgraded.
Verify that the upgrade has completed successfully. In case there are errors
or if the upgrade has partially succeeded or has failed, resolve the errors
and ensure that the upgrade is successful.
Refer to the Microsoft Exchange documentation for more information.
7

Return to the Exchange 2007 Upgrade Wizard and click Continue.
If the wizard is not running, click Start > All Programs > Symantec > Veritas
Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard to
start the wizard and then click Next.

8

The wizard performs the tasks required to set up the VCS environment after
the Exchange upgrade. The Tasks table displays the progress of the various
tasks. After all the tasks are completed, click Next.

9

Review the information on the completion panel and then click Finish.
The wizard displays the status of the Exchange virtual server upgrade. The
Summary table provides the details of the Exchange virtual servers in the
cluster and their upgrade status on each cluster node.

10 Repeat these steps on the remaining cluster nodes. After you have upgraded
all the cluster nodes that are configured to host the Exchange virtual server,
bring the Exchange 2007 service group online in the cluster.
Note: Do not bring the Exchange 2007 service group online until you have
completed the upgrade on all the cluster nodes that are part of the service
group.
11 For a disaster recovery environment, repeat this procedure at the secondary
(DR) site.

Upgrade considerations in case of multiple Exchange
virtual servers
Consider the scenario where there are multiple Exchange virtual server
instances in the cluster (an any-to-any configuration).
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Table 7-1 describes the configuration objects.
Table 7-1

Exchange 2007 SP1 upgrade configuration objects

Object

Description

Node1, Node2, Node3

Physical node names

EVS1, EVS2

Exchange virtual servers

The configuration is such that:
■

EVS1 can fail over on Node1 and Node2.

■

EVS2 can fail over on Node3 and Node2.

So, Node2 is the common failover node for EVS1 and EVS2.
In this case, upgrade the Exchange virtual servers as follows:
■

Upgrade EVS1 on Node1.

■

Upgrade EVS2 on Node3.

■

And then upgrade either EVS1 or EVS2 on Node2.
You must upgrade Node2 (common failover node) only once; the Exchange
virtual server (whether EVS1 or EVS2) does not matter.

In general, for multiple Exchange virtual servers, upgrade each Exchange
virtual server on one cluster node first, and then upgrade any one of the
Exchange virtual servers on the common failover nodes.

Configuring Microsoft SQL 2000 service pack 4 in a
VCS environment
This section outlines the procedure needed to install Microsoft SQL 2000 Server
Service Pack 4 on a computer running Veritas Storage Foundation HA for
Windows 5.1.
For information on upgrading a SQL Server cluster to SFW HA 5.1 see
Chapter 6, “Upgrading a SQL Server cluster” on page 167.
Consider the following points before applying Microsoft SQL 2000 Service Pack
4 to a production server:
■

Make sure that you have a recent backup of your system and user databases.

■

Server down time is required for this procedure.
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To install Microsoft SQL 2000 server service pack 4
1

From the Cluster Explorer, right-click the SQL Server service group and
select Offline on all nodes.

2

On the node where the SQL Server service group was taken offline, online
the MountV resource for the shared drive containing the SQL databases (for
example, S:\MSSQL$SQL2000).

3

On the shared disk, make a copy of your recent MSSQL data files directory
(S:\MSSQL$SQL2000) and rename it, for example to S:\MSSQL$2000.SP3A.

4

From the Cluster Explorer, right-click the SQL Server service group which is
now partially online, and select Freeze >Persistent.

5

Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL
Server service group is online), using the instructions provided by Microsoft.

6

Repeat step 5 for each additional SQL instance in this service group, if you
have more than one instance in this service group.

7

From the Cluster Explorer, right-click the SQL Server service group which is
still online and select Unfreeze.

8

From the Cluster Explorer, right-click the SQL Server service group and
select Offline on the node where it was online.

9

In a Disaster Recovery environment, switch the Replication service group to
one of the other additional or failover nodes in this cluster.

10 On the failover node, online the MountV resource for the shared drive
containing the SQL databases (for example, S:\MSSQL$SQL2000).
11 On the shared disk, rename the S:\MSSQL$SQL2000 directory to
S:\MSSQL$SQL2000.SP4. If S:\MSSQL$SQL2000.SP4 already exists on the
shared disk, then delete it before renaming the S:\MSSQL$SQL2000
directory.
12 On the shared disk, rename the S:\MSSQL$SQL2000.SP3A directory to
S:\MSSQL$SQL2000. If there are additional nodes in this cluster to be
updated, copy the S:\MSSQL$SQL2000.SP3A directory to
S:\MSSQL$SQL2000 instead of renaming the directory.
13 From the Cluster Explorer, right-click the SQL Server service group which is
now partially online and select Freeze >Persistent.
14 Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL
Server service group is online), using the instructions provided by Microsoft.
15 Repeat step 14 for each additional SQL instance in this service group, if you
have more than one instance in this service group.
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16 From the Cluster Explorer, right-click the SQL Server service group which is
still online and select Unfreeze.
17 From the Cluster Explorer, right-click the SQL Server service group and
select Offline on the node where it was online.
18 Repeat step 9 through step 17 on each additional node if more than two SQL
2000 nodes are in use.
19 For a Disaster Recovery environment, repeat this procedure at the
secondary site.
20 When Microsoft SQL 2000 Server Service Pack 4 has been completely
installed on all nodes, test user connectivity to the instances.
21 Test the SQL Server service group by bringing it online and failing it over
from node to node. When testing is complete, the upgrade is complete.
22 If more than one SQL Server service group is present, repeat this entire
procedure for each SQL Server service group.
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Configuring Microsoft SQL 2005 service pack 2 in a
VCS environment
This section outlines the procedure needed to install Microsoft SQL 2005 Server
Service Pack 2 on a computer running Veritas Storage Foundation HA for
Windows 5.1.
Consider the following points before applying Microsoft SQL 2005 Server
Service Pack 2 to a production server:
■

Make sure that you have a recent backup of your system and user databases.

■

Server down time is required for this procedure.

To install Microsoft SQL 2005 server service pack 2
1

From the Cluster Explorer, right-click the SQL Server service group and
select Offline on all nodes.

2

On the node where the SQL Server service group was taken offline, online
the SQL 2005 resource for the shared drive containing the SQL databases.

3

From the Cluster Explorer, right-click the SQL Server service group which is
now partially online, and select Freeze >Persistent.

4

If a VVR RVG service group is present, verify that it is online on the node
where Microsoft SQL 2005 Service Pack 2 is to be installed.

5

Install Microsoft SQL 2005 Service Pack 2 on the active node (where the SQL
Server service group is online), using the instructions provided by Microsoft.

6

Repeat step 5 for each additional SQL instance in this service group, if you
have more than one instance in this service group.

7

From the Cluster Explorer, right-click the SQL Server service group which is
still online and select Unfreeze.

8

From the Cluster Explorer, right-click the SQL Server service group and
select Offline on the node where it was online.

9

On the failover node, online the SQL 2005 resource for the shared drive
containing the SQL databases.

10 From the Cluster Explorer, right-click the SQL Server service group which is
now partially online and select Freeze >Persistent.
11 Install Microsoft SQL 2005 Service Pack 2 on the active node (where the SQL
Server service group is online), using the instructions provided by Microsoft
SQL Server 2005 Service Pack 2 Setup.
12 Repeat step 14 for each additional SQL instance in this service group, if you
have more than one instance in this service group.
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13 From the Cluster Explorer, right-click the SQL Server service group which is
still online and select Unfreeze.
14 From the Cluster Explorer, right-click the SQL Server service group and
select Offline on the node where it was online.
15 Optionally reboot and online each service group to verify the database
connect for each node.
16 Repeat step 9 through step 17 on each additional node if more than two SQL
2005 nodes are in use.
17 For a Disaster Recovery environment, repeat this procedure at the
secondary site.
18 When Microsoft SQL 2005 Server Service Pack 2 has been completely
installed on all nodes, test user connectivity to the instances.
19 Test the SQL Server service group by bringing it online and failing it over
from node to node. When testing is complete, the upgrade is complete.
20 If more than one SQL Server service group is present, repeat this entire
procedure for each SQL Server service group.
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Upgrading an Oracle
cluster
This chapter provides steps for upgrading from SFW 4.3.x or 5.0.x to SFW HA
5.1 with different versions of Oracle. The topics discussed include:
■

Upgrade matrix for an Oracle cluster

■

Upgrading SFW HA

■

Upgrading Oracle in a VCS cluster

Upgrade matrix for an Oracle cluster
Table 8-1 presents possible scenarios for upgrading to a SFW HA cluster with
Oracle. Depending on the scenario, the upgrade process involves one or both of
the following:
■

VCS and the VCS database agent for Oracle upgrade

■

Oracle upgrade

Table 8-1

Oracle cluster upgrade

Upgrade from this configuration ...

To this configuration ...

SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0, or
5.0 RP1

■

SFW HA 5.1

■

Windows Server 2003 SP2

■

Windows Server 2003 SP1

■

Oracle 9.2x

■

Oracle 9.0.1, 9.0.2, 9.1x

■

SFW HA 4.3, 4.3 MP1, 4.3 MP2, 5.0 or
5.0 RP1

■

SFW HA 5.1

■

Windows Server 2003 SP2

■

Windows Server 2003 SP1

■

Oracle 10.1, 10.2

■

Oracle 10.1, 10.2

■
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Upgrading SFW HA
Perform the following tasks to upgrade to SFW HA 5.1:
■

Prepare the cluster for an upgrade.
See “Preparing to upgrade to SFW HA 5.1” on page 118 in
Chapter 4, “Upgrading to SFW HA 5.1”.

■

Upgrade SFW HA and the database agent for Oracle from version 4.3.x or
5.0.x to version 5.1.
See “Upgrading to SFW HA 5.1” on page 120 in Chapter 4, “Upgrading to
SFW HA 5.1”.

Upgrading Oracle in a VCS cluster
This section describes the tasks necessary to upgrade Oracle in a VCS cluster.
Please see your Oracle documentation for information on supported Oracle
upgrade paths.

Upgrading the Oracle application
Upgrading Oracle involves the following steps:
■

Upgrading the Oracle binaries.

■

Upgrading the Oracle database. Perform the following tasks before
upgrading the Oracle database:
■

Bring the Oracle service group online.

■

Stop HAD using the hastop -local -force command.

Additional tasks after upgrading Oracle
Perform the following tasks to configure Oracle in a VCS environment.
■

Associate the updated database with the listener for Oracle 10g.
See “Associating the updated database with the listener” on page 211.

■

Configure the database and listener to use the virtual IP address.
See “Configuring the database and listener to use the virtual IP address” on
page 212.

■

Configure Oracle and listener services.
See “Configuring Oracle and listener services” on page 214.

■

Modify the ServiceName attribute for the Netlsnr resource.
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See “Modifying the ServiceName attribute for the netlsnr resource” on
page 215.

Associating the updated database with the listener
Use these instructions to associate all the databases with the listeners.

Prerequisite
Ensure that the initialization parameter file contains the following entries:
■

SERVICE_NAMES (the name of the database service)

■

INSTANCE_NAME (the name of the database instance)

These parameters are created during installation or database creation.
To associate the database with the listener
1

Use one of the following ways to configure the new attribute listener_alias:
Run the following SQL command:

SQL> ALTER SYSTEM SET LOCAL_LISTENER=’<listener_alias>’
scope=spfile;

OR
Add the following entry to the initialization parameter file (pfile/spfile):

LOCAL_LISTENER = <listener_alias>
2

Define the parameter listener_alias. If your Oracle configuration uses the
file tnsnames.ora, edit the file as instructed below. The default location of
tnsnames.ora is %ORACLE_HOME%\NETWORK\ADMIN.
Add the following to tnsnames.ora file:
<listener_alias>=
(DESCRIPTION =
(ADDRESS=(Protocol=TCP)(HOST=virtual_IP_address)(Port=1521))
)

3

Stop and restart the database.

The listener_alias parameter gets appended by the default domain name
specified in the file sqlnet.ora.
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Configuring the database and listener to use the virtual IP address
All databases and listeners configured must use the same virtual IP. Update the
Oracle files to set the virtual IP address. Setting the virtual IP address involves
the following tasks:
■

Creating a virtual IP address.

■

Verifying the initialization file settings.

■

Updating the Oracle configuration files.

Use the following steps to configure the database and listener.
To create a virtual IP address
1

Open the Network Connections (Start > Settings > Network Connections).

2

Right-click the public network connection to be used and click Properties.

3

Select Internet Protocol (TCP/IP) and click Properties.

4

Click Advanced.

5

In the IP Settings tab, click Add to add a virtual IP address and subnet mask.

To verify the initialization file settings, if a PFILE is used
1

Open the Registry Editor.
From the Start menu, choose Run. In the Open field, enter regedit and
click OK.

2

Double-click the ORA_SID_PFILE registry key at
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME_ID\.
The variable SID represents the database instance.

3

Verify that the Value data field specifies the correct path at which the
initialization file, init.ora, is located.

To verify the initialization file settings, if an SPFILE is used
1

Run sqlplus.exe.

2

Connect to the database.

3

Verify the following query returns the correct path of the SPFILE.
select value from v$parameter where name = ‘spfile’
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To update the Oracle configuration files
1

In the listener.ora and tnsnames.ora files, change the host name for all the
TCP protocol address databases to the virtual IP address that you created.
Replace
HOSTNAME=machine_name

with
HOSTNAME=virtual_IP_address

2

In the initialization file, change the dispatchers parameter.
Oracle requires an initialization file, a PFILE or an SPFILE, to start database
instances. Choose the appropriate reference depending on the initialization
file you use.
See “Setting the dispatchers parameter in PFILE” on page 213
See “Setting the dispatchers parameter in SPFILE” on page 213.

3

Restart the Oracle and listener services.

Setting the dispatchers parameter in PFILE
In the PFILE, set the host name for all TCP protocol address dispatchers to the
virtual IP address that you created.
Edit the dispatchers parameter only for the host name and leave the rest of the
configuration as it is. Set the value as:
dispatchers = ‘(ADDRESS = (Protocol=TCP)
(HOST=virtual_IP_address) (any other previously existing
entry))’

The variable virtual_IP_address represents the virtual IP address that you
created.
For example:
dispatchers = ‘(ADDRESS = (Protocol=TCP) (HOST=10.210.100.110)
(SERVICE=Data1XDB)’

Setting the dispatchers parameter in SPFILE
Use the following steps to set the dispatchers parameter in SPFILE.
To set the dispatchers parameter in SPFILE
1

Convert the SPFILE to PFILE.

2

Modify the PFILE.
See “Setting the dispatchers parameter in PFILE” on page 213.

3

Convert the PFILE to SPFILE.

4

Save the SPFILE to the original location on the shared disk.
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Refer to the Oracle documentation for specific information on converting a
PFILE or an SPFILE.

Configuring Oracle and listener services
Configuring the Oracle and Listener services involves the following tasks:
■

Making the Oracle and Netlsnr services manual.

■

Configuring log on properties for Oracle services.

Use the following steps to configure Oracle and listener services.
To make services manual
1

Open the Services applet (Start > Programs > Administrative Tools >
Services).

2

Double-click the service. In the SCM:
■

Oracle services appear as OracleServiceSID, where SID represents the
database instance.

■

Listener services appear as OracleOra_HomeTNSListenerName,
where Ora_Home represents the Oracle home directory and
ListenerName is the name of the listener set during the installation.

3

In the Properties window, click the General tab.

4

From the Startup Type drop-down list, select Manual.

5

Click OK.

To configure the log on properties for oracle services
1

Open the Services applet (Start > Programs > Administrative Tools >
Services).

2

Double-click the Oracle service. In the SCM, the names of Oracle services
appear as OracleServiceSID, where SID represents the database instance.

3

In the General tab of the Properties window, click Stop to stop the service.

4

Click the Log On tab.

5

Choose This Account.

6

Enter the credentials of the user in whose context Oracle was installed.

7

Click the General tab and click Start to start the service with the new Log On
properties. Click OK.
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Modifying the ServiceName attribute for the netlsnr resource
Perform the following steps to modify the ServiceName attribute for the Netlsnr
resource.
To modify the ServiceName attribute
1

Start HAD. Type the following on the command prompt:
C:\> hastart

2

Offline the Netlsnr resource. Type the following on the command prompt:
C:\> hares -offline resource_name -sys system_name

3

Modify the ServiceName attribute for the Netlsnr resource. Type the
following on the command prompt:
C:\> hares -modify resource_name attribute_name attribute_value

For example, to modify the ServiceName attribute of the Netlsnr resource,
Netlsnr_res, type:
C:\> hares -modify Netlsnr_res ServiceName attribute_value

where, attribute_value is the name of the listener service in Oracle 9i or
10g versions.
4

Online the Netlsnr resource. Type the following on the command prompt:
C:\> hares -online resource_name -sys system_name
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Appendix
This section includes an appendix which describes the ports used by SFW HA:
■

Appendix A, “Services and ports used by SFW HA” on page 219
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Services and ports used by
SFW HA
If you have configured the Windows firewall, ensure that the firewall settings
allow access to the services or ports used by SFW HA.
Table A-1 displays the services and ports used by SFW HA. Note that port
numbers appearing in bold are mandatory for configuring SFW HA.
Table A-1

SFW HA services and ports

Port Number Protocol

Description

2148, 3207

TCP/UDP

Veritas Enterprise Administrator (VEA) Server (vxsvc.exe)

14150

TCP

VCS Command Server (CmdServer.exe)

14141

TCP

Veritas High Availability Engine (had.exe)
Veritas Cluster Manager (Java console)
(ClusterManager.exe)
VCS Agent driver (VCSAgDriver.exe)

7419

TCP

Solutions Configuration Center (SFWConfigPanel.exe)
CCF Engine (CEngineDriver.exe)
CCF Plugin Host (PluginHost.exe)

1099

TCP/UDP

Provider Access Layer (VxPAL.exe)

1556

TCP/UDP

Private Branch Exchange (pbx_exchange.exe)

2821

TCP/UDP

Veritas Security Services (VxSS)

8181, 14145

TCP/UDP

Veritas Cluster Management Console (CMC)

14443

TCP

Veritas CMC Management Server. Used as SSL port for
VRTSWeb.
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Table A-1

SFW HA services and ports (Continued)

Port Number Protocol

Description

8199

TCP

Volume Replicator Administrative Service (VRAS.dll)

8989

TCP

VVR Resync Utility (vxrserver.exe)

4145

UDP

VCS Cluster Heartbeats
VVR Connection Server (vxio.sys)

8443

TCP

VCS Secure Web Server

14144

TCP/UDP

VCS Notification

14153,

TCP/UDP

VCS Cluster Simulator

TCP/UDP

VCS Global Cluster Option (GCO)

15550 - 15558
14155

49152 - 65535 TCP/UDP

Volume Replicator Packets

14300

VRTSWeb Admin

TCP/UDP

Index

A

G

Administrative Console 38, 122, 151, 182

Global Cluster Option
secure configuration 127, 157, 188
global clusters 32

C
command line installation 43
Complete/Custom 38, 122, 151, 182

D
disk space requirements 14
display requirements 16
DMP ASLs
uninstalling before upgrade 83, 117, 145, 176
DMP DSMs
adding to existing VCS or Microsoft cluster 66
adding to standalone server 65
adding to upgraded HA environment 144, 175
adding to upgraded SFW environment 82
installing on standalone server 63
installing with MSCS (Microsoft clustering) 64
installing with VCS 63
preparing for upgrade 82, 116, 145, 176
re-enabling after HA upgrade 132, 165, 195
re-enabling after SFW upgrade 98
uninstalling 66
driver signing options 36
changing for SFW HA 149, 181
resetting 43, 91, 104, 125, 154, 184

E
Exchange cluster see upgrading Exchange cluster

F
features
adding 56
removing 56
firewalls 18, 219

H
HA VCS environment
adding GCO resource 127, 157, 188
re-enabling DMP 132, 165, 195
re-enabling VVR 129, 162, 192
upgrading dynamic disk groups 133, 165, 195
Hardware Compatibility List 16
HCL requirements 16

I
installation
adding or removing features 56
adding or removing license keys 57
DMP DSMs 63
from command line 43
license management 22
Microsoft clustering software 49
prerequisites 13
repairing 55, 57
requirements 14
silently 43
iSCSI
configuring 51
using vxdg latestart 53

J
Java Access Bridge
and JAWS 50
installing 50
JAWS
and Java Access Bridge 50
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L
licensing 21
adding or removing 22
client only 22
generating report with Vxlicrep 23
management 22
SFW and SFW HA license packages 24

M
memory
requirements 16
Microsoft clustering
installing after SFW installation 49
Microsoft Exchange 2003
service pack 2
configuring in a VCS environment 199
Microsoft Exchange 2007
service pack 1
configuring in a VCS environment 201
monitor
requirements 16
MSCS environment
re-enabling DMP 104
upgrading in 99
upgrading prerequisites 99
upgrading SFW 101
upgrading with DMP 101

N
notification
configuring SFW HA 32

O
operating system
requirements 14
Oracle cluster upgrading 210

P
permissions requirements 18, 20
planning for installation
SFW and Microsoft cluster 33
SFW HA 30
ports used by SFW HA 219
prerequisites of installation 13
print share service group
bringing online after upgrade 132

product installer
uninstalling 58
upgrading to HA 122, 150, 182

R
registration script for Volume Manager Disk Group
resource 49
remote systems 17
repairing the installation 55, 57
requirements 14
client software 15
disk space 14
permissions 18, 20
server software 14
SFW 18
requirements for installation
display 16
driver signing 17
memory 16
monitor 16
operating systems 14
prerequisites 13
remote systems 17
single instance 17
storage compatibility 17
system processor 16
VCS Cluster Manager 17
VVR static IP address 17
requirements, additional for SFW 18
requirements, additional for SFW HA 20
requirements, network 19
requirements, system 18, 19
resetting
driver signing options 43, 91, 104, 125, 154

S
secure GCO, establishing 127, 157, 188
server
adding DMP DSMs 65
service pack upgrades
Microsoft Exchange 2003 SP2 199
Microsoft Exchange 2007 SP1 201
Microsoft SQL 2000 SP4 204
Microsoft SQL 2005 SP2 207
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setup.exe parameters
install_mode 44
installdir 45
licensekey 45
node 45, 60
options 45
Reboot 60
reboot 45
Solution 60
solution 44
SFW
additional requirements 18
disk space required 14
requirements 18
system requirements 18
SFW HA
additional requirements 20
best practices 21
configuring
notification 32
disk space required 14
network requirements 19
requirements 18
services and ports used by 219
system requirements 19
silent installation 43
SQL cluster see upgrading SQL cluster
storage compatibility requirements 17
supported software requirements 18
Symantec Product Authentication Service 31
system processor requirements 16

U
uninstalling
using command line 59
using product installer 58
upgrading dynamic disk groups 98
upgrading Exchange cluster
adding DMP 144
changing driver signing options 149
configuring secure cluster 156
overview 136
performing the SFW HA upgrade 149
preliminary steps 137
preparing DMP 145
preparing for upgrade 137
preparing VVR 138
upgrade scenarios 136
using product installer 150

upgrading in Microsoft cluster
overview 99
prerequisites 99
re-enabling DMP 104
setting up DMP 101
upgrading SFW 101
upgrading SFW
adding DMP 82
changing driver signing options 84, 91
Microsoft clustering environment 70
minimum product versions 69
overview 71
performing the upgrade 85
preparing existing DMP ASL environment 83
preparing existing DMP DSM environment 82
preparing for 70
preparing VVR 71
re-enabling DMP 98
re-enabling VVR 91
upgrading SFW HA
bring print share service group online 132
overview 107
performing the upgrade 120
preliminary steps 108
preparing 118
preparing DMP ASL environment 117
preparing DMP DSM environment 116
preparing VVR 110
using product installer 122
upgrading SQL cluster
adding DMP 175
changing driver signing options 181
configuring secure cluster 187
preliminary steps 169
preparing DMP 176
preparing for upgrade 169
preparing VVR 170
upgrade scenarios 168
using product installer 182

V
Veritas Cluster Server Management Console 31
Volume Manager Disk Group resource
registration 49
VVR
preparing for SFW HA upgrade 110
preparing for SFW upgrade 71
re-enabling after SFW upgrade 91
replication in mixed environments 33

224

vxdg latestart
command syntax 53
using 53
Vxlicrep 23

